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Relationships are born out of interactions and communications. When
you talk to a neighbour, when you forward that funny e-mail to 20 of
your friends, or send a project update to a client, your relationships are

being nurtured. Electronic communications are forming the most used path-
ways to your friends and associates, and inevitably that leaves a trail of elec-
tronic conversations. 

How would you react to software that wants to watch this conversation? It is
initially counter-intuitive, but your relationships have huge latent value to
everyone involved in them that may not be fully used. 
Social software that try to mine your relationships, and create a visible network
of your links to people around you, are all the rage. Services such as LinkedIn,
Spoke and Friendster, all offer different perspectives on the same basic theme—
you may know someone who is important to someone else, and someone you
know, could introduce you to an important person. 

But all these software fail to account for the variability in strength and quality
of the relationships. Not everyone in your address book is equally well-con-
nected to you. There may be imbalances in relationships, where you feel it is
stronger or weaker than it really is. These services try to classify relationships,
by asking you to pick from a list of predefined labels, but that can be too lim-
iting in scope.

Building and maintaining relationships is a sustained effort that requires grace
and empathy—precisely the qualities that are hard to be captured by software.
All these services are in the first generation, and bound to be simplistic; but it
is inevitable that as the power of mining these networks becomes apparent,
inferring and capturing nuances of relationships will be top priority. 

The emergence of such social software is an interesting pointer to the kind of
assistance that can be expected from computers in the near future; very differ-
ent from the direct unintelligent task-solution based approach of, say, a word-
processor. Software that intelligently sorts your e-mails, intelligently classifies
your relationships, infers what information you are looking for, and generally
observes and does what you do, are just over the horizon!

sumod_hajela@jasubhai.com

“Building and

maintaining

relationships is a

sustained effort

that requires grace

and empathy—

precisely the

quality that are

hard to be

captured by

software”

Relationship Mines

Sumod Hajela
Assistant Editor



4 JANUARY 2004

index ■
■ magazineindex ■
■ magazine

▲
▲ 5566 12 brands send in their star performers to catch

your eye

▲
▲ 3388 The consumers have spoken. The ballot

are in. You’ve chosen the most reliable
products and service providersJA

N
U

A
R

Y
 2

00
4 PULSE

Bluetooth has finally 
arrived ........................................28
Vipul Shah talks about the past, present
and future of Bluetooth

FEATURES
Robo Sapiens ..........................30
Robots aren’t ready yet to take over the
world, but they can carry your bag-
gage...

Icons of Trust ..........................38
... is what the three-month survey
threw up from the opinions of nearly
2000 consumers about their devices and
the companies that manufactured them
Read on to find out who delivered the
goods and who did not!

TEST DRIVE
Laps of Luxury ........................56
21 devices vying for your precious lap

In Suite Pursuit.......................82
Who says you have to have MS Office?

We tested five office suites to show
you some other options that don’t
cost the earth

INSIGHT
It’s Never Enough ..................99
Learn how and where to store your
data online

Beyond Wires........................102
Three wireless technologies—infra-red,
Bluetooth and WiFi—explored and
explained

Watch that Move .................108
Protect your laptop, and the data within
from unfriendly hands and eyes

The Fax of the Matter ........112
The new fax machine doesn’t need a
phone, or you to stand by. It’s your PC!

Tweaking the Kernel ..........116
Rip the heart out of your Linux box,
and then rebuild it. Learn how to chop,
change, or update your Linux Kernel

9999
Storing data on the

World Wide Web can
save you a lot of trou-

ble and hard disk
space

▲ ▲

3300
Before performing
complete surgeries,
a robot learns to
heal itself

▲▲

▲
▲110022 Welcome to the wire-free world. These 

technologies will set you free and help you
attain a wireless nirvana



JANUARY 20045

To subscribe to Digit, 
fill out the subscription
form available online at
www.thinkdigit.com/subscribe

NEWS FEED  . . . . .14

LETTERS . . . . . . . .24

DROOLMAAL  . . . .36

BAZAAR . . . . . . . .92

Q & A  . . . . . . . . . .119

TIPS & TRICKS  . . .123

OFF THE SHELF  . .136

DIGIT DIARY . . . . .137

QUBIT . . . . . . . . . .138R
E

G
U

L
A

R
S

38
The Service and
Reliability Survey
speaks

102
The ‘hows’ and
‘how it works’ of
three wireless
technologies

56
Get yourself a laptop as
the first gift of the year

108
Ways to secure your
laptop from prying
eyes...and hands

30
The evolution of the
robot

99
Use the Net to

share, store,
transport and
back up your

data

123
Brush up on your

photography skills

HARDWARE
Bazaar . . . . . . . . . . . . . . . . . . 92
■ BenQ M550G
■ Epson Stylus C63
■ Handsprint A6 pocket printer
■ HP laserjet 1015
■ Kodak LS633 digicam
■ Logitech click plus
■ Monarch MV20
■ MSI GeForce FX5600 128 MB
■ Sony-Ericsson T610
■ Techcom Keyboard

Laptops . . . . . . . . . . . . . . . . . 56
■ Acer Tablet
■ Acer TravelMate 290

■ ACi Centrino
■ ACi Emerald Pro
■ ACi Ethos
■ ACi Optima
■ ACi Tablet
■ ACi Ultima
■ BPL DeskBook
■ BPL Notebook
■ Dell Inspiron 1100
■ Fujitsu C series
■ HP Compaq nx9005
■ HP Compaq nx9000
■ IBM T40
■ Jaguar M270S
■ PnP Ultra portable
■ Toshiba Portege 3500

■ Toshiba Portege M100
■ Wipro Little Genius
■ Zenith Centrino notebook

SOFTWARE
Bazaar . . . . . . . . . . . . . . . . . . 92
■ AIST Movie DV suite 4.0
■ CompTax
■ Ulead Photo Impact XL

Office Compatibility . . . . . . . . 82
■ Ability Office
■ Corel WordPerfect 11
■ Lotus SmartSuite 9.8
■ OpenOffice.org 1.1.0
■ StarOffice 7

Reviewed this month

ts



6 JANUARY 2004

index ■
■ digit interactive

PHP 4.3.3
Develop complex Web applications easily
Dev Tools
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and make movies
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BitTorrent 3.3
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to surf the Net
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Quotes 2002 
Insert a unique quote in your mail every time
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tweaks
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Macromedia
Dreamweaver MX 2004
Dreamweaver MX is a heavy duty
HTML editor for making professional
Web sites. From leading support for
CSS-based design, to hand-coding fea-
tures, Dreamweaver provides the tools

professionals need in an integrated,
streamlined environment. This is a 30
days Trial.

Mozilla Firebird 0.7
Mozilla Firebird is based on Mozilla and
created by a section
of the Mozilla devel-
opment team. It is a
little lighter and provides fewer features.
It uses a different interface design, and
offers some handy features such as cus-
tomisable toolbars, IE Favourites import,

integrated Web search bar and tabbed
browsing. It also features source-view
with syntax highlighting, password
manager and more. Mozilla Firebird also
includes a basic download manager that
keeps track of your recent downloads,
and shows which files are currently
being downloaded

Sinbad: Legend of the
Seven Seas
Play as Sinbad the sailor, and fight off
monsters while aiming to get the Book
of Peace from Eris, the Goddess of Chaos.
Your objective will also be to save the 
life of Sinbad’s good friend—Proteus—
while fighting mystical creatures and
beasts along the way. As support, you
can get powers such as invisibility and
can even summon an army of skeletons
on your side.

Every Windows installation requires
software that help you better utilise
your resources. These software can
help view archives, electronic books,
watch rich multimedia applications,
or the latest movie trailers. 

We have put together the Essen-
tials category to help you get the
most out of your PC and the Digit
CDs. The section is constantly updat-
ed to reflect the latest out in the mar-
ket, so do keep coming back here to
ensure that your PC is well equipped.

KNOW YOUR CD

MUST TRY SOFTWARE

MINDWARE\SOFTWARE\ESSENTIALS

ON THE CD
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You get to choose what goes on Digit Interactive. 
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Subscribe now...
and get UNISTAL Antivirus
worth Rs 1,500

absolutely FREE!
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WEB SPECIAL

WEB SPECIAL

taste technology at www.thinkdigit.com

Share your
Windows
Find out how you can
share your Windows
XP system with others
and give them the
right privileges

▼▼
▼▼

To Buy, Or Not To Buy 
If only buying electronic toys was as
easy as walking into a shop and
choosing one. Even if they're available,
the prices in India are liable to give
you a cardiac infarct. Is there a way
around this?

Want to brainstorm? Start a discussion? Share an idea?
Log on to www.thinkdigit.com/forum

SUBSCRIBE

FORUM

BY DEMAND

DreamRender 219 
Size: 8.82 MB
Mindware

Deus Ex 2: Invisible War  
Size: 223 MB
Playware

Expect these on the January 2004 CDs
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CCMMEE
■■   WWhhaatt  iiss  CCMMEE??
Core Management System
(CME) is being developed
by American BIOS manufac-
turer Phoenix. It aims to
supplement their new BIOS
versions, and work hand in
hand with Windows to make
computing more secure,
using Core System Software.

■■   HHooww  ddooeess  iitt  wwoorrkk??
It works with Windows Long-
horn, which blends software
and hardware-based Digital
Rights Management via the
Next Generation Secure
Computing Base (NGSCB).
Additionally, Device-Net-
worked Architecture (d-NA)
is exposed to the developers
to better utilise the resources
of the new system.

■■  WWhhaatt  ddooeess  iitt  ddoo??
CME has a cryptographic
engine and a service provider
at the hardware level, thus
providing a tamper-proof
location for secure services
and secure applications to
function. Functions such as
seeking an authorised hard-
ware device to transfer a file
should be relatively reliable.

hypethesis

Researchers are working
to modify the Segway
Human Transporter into

a battlefield robot, which can
be used for transporting
injured soldiers to safety, or for
following soldiers while carry-
ing equipment for them. The
modified transporters will be
good alternatives to the four-
wheeled robotic vehicles cur-
rently in use, because they

have a high centre of gravity,
allowing cameras and sensors
to be placed several feet above
the ground. DARPA has invest-
ed $26 million on this project,
in the last year alone. At the
Carnegie-Mellon University,
Segway robots have been
developed that can move and
kick soccer balls. Researchers at
the University of Southern Cal-
ifornia are working on a Seg-

way Robot that can follow
humans and carry up to 50 kg
of gear for them.

When Transporters were
launched in 2001, Segway was
expecting sales in millions. So
far, however, they have only
been in the thousands. Segway
is therefore welcoming this ini-
tiative, as it would help
increase sales and lower prices.

➜

According to a recent
report by Sophos, an
anti-virus and anti-

spam company, almost 30 per
cent of spam
being circu-
lated is
relayed by
PCs infected
with Remote
Access Trojans
(RATs). A RAT
is a Trojan
horse that
gives full con-
trol of the PC to
the attacker,

allowing him or her to send e-
mails with that user’s name.
Further, the attackers remove
all traces of their activities from 

the PCs.
The main targets are

broadband users whose
PCs aren’t secured
properly. 

The report
also states that
the purpose of
making viruses
is changing from

creating chaos to
getting financial
rewards. 

A RAT in your PC

Segway to become battlefield bot

168 million PC

units expected to ship

in 2004, translating to

a 14 per cent
growth of the market 

snapshot

Source: Gartner

The paperless office may be
a long way away, but Toshi-

ba has developed an ink that
can be used with ball pens or
laser printers, and can be
erased by passing through an
erasing machine, that can erase
200 pages in two hours. The
ink is made up of three differ-
ent chemicals—two mix to
give the ink its colour, while
the third reverses the process at

the time of erasing, causing the
ink to become invisible. It
owes its name—E-blue—to its
colour. 

According to Toshiba,
paper makes up 40 per cent of
the office waste in Japan. E-blue
will help cut office waste and
recycle paper. The entire setup,
including the toner and the
erasing machine, is priced at
¥300,00 (around Rs 1,26,000).

Reprintable paper

Acompany called Element
Computers (www.ele-

mentcomputer.com) has just
launched the world's first
sub-$1000 tablet PC, named
Helium 2100. The PC runs
the Desktop/LX Tablet Edi-
tion OS from Lycoris. It has a
VIA 1GHz Antaur processor,
a 30 GB hard drive, 256 MB
of  RAM, and a 14.1-inch
XGA screen. The PC features
basic touch-screen functions,
but handwriting recognition
is still under development; it
may be released next year as
a software upgrade.

According to Element,
the low cost of this tablet PC
has been made possible
because Windows is not pre-
installed, thanks to its ‘No
Windows’ policy, and offers
laptops with the Desktop/LX
operating system for as low
as $799 (around Rs 35,955).
Element also offers pre-test-
ed hardware through its
online store.

A Linux-based
Tablet PC

■ Real sues Microsoft for using Windows monopoly to limit consumer choice in digital media ■  Fortune names iTunes as the technology product of 2003

ILLUSTRATOR: Mahesh Benkar



To counter file-sharing
pirates, record labels have

been bundling bonus DVDs
w i t h
audio

CDs. The bundled DVDs come
with documentary footage and
concert videos, and are sold as
a package at the price of the
regular CD.

All that might soon change
if OneDisc Technologies from
Dallas convinces the big names
in the music industry about

their new combination disk.
This disk plays a DVD video on
one side, and a CD audio on
the other. It’s been designed to
play on all existing players. The
first such disk, Kathleen

Edwards’ ‘Live From the
Bowery Ballroom’ is
already out in the US. 

The disc is
0.28mm thicker
than a normal DVD

disc. Using such a disc will
result in reduction of produc-
tion cost. The patent for this
technology currently belongs
to a German company named
DVD Plus International. Based
on this technology, more than
70 titles have been released
outside the US.
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IE address spoof
A vulnerability in Internet
Explorer can be exploited to 
display fake URLs in the
address and status bars. This
can be used by others to fool
a user into disclosing confi-
dential information such as
credit card numbers. Secunia
discovered this vulnerability,
and you can see a demonstra-
tion of it at http://www.secu-
nia.com/internet_explorer_addr
ess_bar_spoofing_test/. Even
though there are about 20
known vulnerabilities in its
products, Microsoft did not
release any patches in Decem-
ber—it will stick by its deci-
sion to only release monthly
patches and updates.

Unsafe Yahoo! 
Messenger 
A vulnerability in Yahoo!
Messenger allows a hacker to
launch XSS (Cross-Site
Scripting) attacks. XSS
occurs when a Web applica-
tion gathers malicious data
from users when they click
on a link in a browser or chat
window. This link contains
the malicious content, usual-
ly encoded in hexadecimal
code. The hacker executes
malicious code through a
Web page that is loaded
through a ‘ymsgr:’ Web
address. This vulnerability
has been corrected in the lat-
est version of Yahoo! Mes-
senger—5.6 build 1356.

redalert

Source: World Economic Forum

Source: Brightmail Inc
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■ Windows XP improved—Bluetooth and WiFi support, pop-up blocker, better firewall  ■ Worms target Windows-based ATM machines

The flip side DDR’s second
take

US memory firm Micron
began production of

DDR2 memory modules from
December 2003. The memory
chips on the modules are being
manufactured in densities of
256 Mbit, 512 Mbit and 1 Gbit,
and should come with capaci-
ties of 128 MB to 4 GB. Micron
will be shipping this in volume
later this year. 

Intel’s upcoming ‘Grants-
dale’ chipset will use the new
DDR2 memory—this means
DDR2 memory availability will
be crucial for its new micro-
processor and chipsets range.

Incidentally, to shore up its
bets on the availability of mem-
ory, Intel has made investments
in Micron, as well as Japanese
memory company Elpida.

The Telephone Regulatory
Authority of India (TRAI)

plans to pass an order that
forces mobile operators to pro-
vide equal rates for outgoing
calls to any network. Most
operators provide a lower out-
going call rate for the local
network. This will soon be
passé. Under the unified
license regime, all telephone
operators can choose between
three licenses: fixed, limited
and full mobility. Once a
mobility operator fixes the rate
for outgoing calls, the same
would be maintained for all
full mobility networks. The
rule will be applicable to fixed
and limited mobility operators
also. This allows you to choose
any network, irrespective 
of your existing service
provider. Such a rule is bound
to increase competition
between service providers.

Equal outgo-
ing rates

World-wide sales of

mobile phones

touched 132.8
milion, in the

third quarter of

2003

snapshot

Source: Gartner
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Microsoft has set its eyes on
the car market, and it

wants in-car electronics to run
its Windows Automotive plat-
form. With 50 million cars
rolling out of assembly lines
every year, Microsoft has sensed
a huge market for its products.
“We’d like to have one of our
operating systems in every car.
It’s a lofty goal,” says Dick Brass,
vice president of Microsoft’s
Automotive Business Unit. The
Windows Automotive platform

will have features such as hands-
free communication, support for
wireless standards such as GPRS,
CDMA, WiFi, driver distraction
control and entertainment serv-
ices.

Microsoft is encouraging
car manufactures to use Win-
dows CE to run navigation sys-
tems, entertainment systems,
etc. Not only have premier car
manufacturers—BMW, Honda
and Volvo—shown interest, but
23 car models are currently
using it. Modern cars are
increasingly relying on com-
puters to perform sophisticated
functions such as GPS naviga-
tion and entertainment func-
tions. Citroën’s C5, for exam-
ple, uses Windows- powered
software to provide turn-by-
turn navigation capabilities,
hands-free cellular phone con-
trol, wireless synchronization of
data with mobile devices, etc.
Similarly, the BMW 7 series has
a Windows-powered navigation
application as a part of the new
cabin design, iDrive.

Microsoft is not alone in

this niche market, and faces
competition from embedded
software developers—Wind Sys-
tems, QNX software and, not to
forget, embedded versions of
Linux. Some of these compa-
nies’ products are used in 
F1 cars.

■  Strong demand for electronic devices force chip manufacturers to work on holidays ■  Gartner expects Longhorn to be released between late 2006 and mid-2008

Windows-powered cars

At the end of

November
2003, India had

20.73 million
GSM and 5.87 
million CDMA
subscribers

snapshot

Source: TRAI

If people don’t come to a mobile
phone, take the mobile phone to the

people! Jaipur-based Shyam Telecom has
equipped a fleet of cycle-rickshaws with a
mobile phone each. Called the Chalta Firta
PCO, the rickshaw drivers pedal all across
Jaipur, freely choosing their beat and have
started making a decent income through
their commission on this mobile pay-
phone service. Shyam Telecom outfits
the rickshaws with handsets for
free, and derives income through
the increased traffic on their net-
work.

This is just the beginning; Shyam Telecom
plans to broaden the mobile-to-mobile pay-
phone service into mobile-a-cyber-cafe by
adding Internet-ready laptops. And finally, get

ready for this one: they’re running a pilot test
to get camels on the Net, or rather, under it.
Shyam Telecom currently has two camels
roaming the deserts with wireless computers
in tow, offering Internet connections to all!

Anything fast has to be a
Ferrari. Acer India has

launched a limited edition of
the Ferrari 3000 notebook.
With a price tag of around Rs.
1.6 lakhs, the laptop was
launched to celebrate Ferrari’s
Grand Prix
w o r l d
c h a m p i -
onship vic-
tory last
year.
I t ’ s
p o w e r e d
by an AMD Athlon
XP-M 2500+, 512 MB of DDR
SDRAM, a 60 GB hard drive, a
DVD-Writer and a 15-inch
screen backed by a 128 MB ATi
Radeon graphics card. Com-
munications is handled via an
integrated 802.11g wireless
LAN, Bluetooth, 10/100 Mbps
Ethernet, and a 56 Kbps
modem. It also has a multi-for-
mat four-in-one memory card
reader, 4 USB 2.0 ports, an IEEE
1394 port and S-video port.
Weighing 2.9 kg, it has a
mileage of 3 hours.

Pedalin’ PCO

An Ace(r)
of a Ferrari 

heroes

Parts shortage
The demand of mobile
phones world-wide has
outstripped its supply. One
reason is that there is a
shortage of colour screens
and cameras. Also, flash
memory, used in removable
storage devices such as USB
sticks, is in short supply .

Windows 98
Officially, Windows 98 died
on December 15, 2003, 
and will not be available
through Microsoft’s
channels. Distribution of 
SQL server 7 and some
Office 2000 related tools 
has also been halted.

The move is due to the
agreement between Microsoft
and Sun over the distribution
of Java virtual machine.

zeroes

Notebook sales
Laptop sales in India may final-
ly rise. Notebook manufactur-
ers are aggressively reducing
the prices to grab market
share, with almost all the 
laptop companies pegging 
the entry level price at around
Rs 55,000.

Indian R&D
India is poised to become a
global research and develop-
ment hub. Google has set 
up a Research and Develop-
ment lab at Bangalore. Intel
already has one here to devel-
op the next generation of
mobile chipsets and server
processors.

➜
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In what can only be called
true e-governance, Japan

has appointed a computer-
generated lady as its goodwill
ambassador to the ASEAN
countries. The ambassador
has been named Sakura
Sanae; Sakura means Cherry
Blossoms, and Sanae is 
an anagram for ASEAN.
Instead of creating a stereo-
typed, stern-faced ambassa-
dor, "she is 21 years old, born
in 2003 from a PC," says the
official statement on the
Japanese foreign ministry
Web site.

2003 has been designated
Japan-ASEAN exchange year.
Given the diversity of the ten
ASEAN countries, it is diffi-
cult to get a goodwill ambas-
sador who understands all
the languages, and can cope
with the diversity. Japan, to
keep up its tech-savvy image,

has created a computer gen-
erated ambassador who can
visit all ten nations at the
same time. Visit
www.mofa.go.jp/region/asia-
paci/asean/year2003/cg2.html
for images of the latest Japan-
ese ambassador.

The new face of
Japan

The ‘master/slave’ conven-
tion used by the computer

industry has come under fire
from Los Angeles county offi-
cials. Officials have asked com-
puter vendors to remove the
offensive reference. “Based on
the cultural diversity and sen-

sitivity of Los Angeles county,
this is not an acceptable iden-
tification label,” LA County’s
Division Manager Joe San-
doval said. He added that it’s
only a request. “I do under-
stand that this term has been
an industry standard for years,
and this is nothing more than
a plea to vendors to see what
they can do,” he added.

The Director of the Office
of Affirmative Action, Dennis
Tafoya, said that a search has
been launched to identifiy
and replace such offensive
labels. Sandoval rejected sug-
gestions that products using
the terms ‘master’ and ‘slave’
should be banned.

PC discrimi-
nation

■ Malaysian pirates begin selling the yet-to-be-released Windows Longhorn for $1.58 ■ The PSX entertainment system released in Japan but with scaled-down specifications

“Somebody please buy
Itanium”, Intel seems

to be saying. The company
has started a programme
named ‘Intel Itanium 2 Solu-
tion Challenge’, under which
it offers the Itanium 2 for a
trial period of 90 days. Glob-
al 500 companies using sys-
tems based on Reduced
Instruction Set Computing
(RISC) can avail of this offer.
Intel hopes this will allow
the companies to experience
its Itanium2 platform, and
realise its advantages. “We’re
bullish on the Itanium2
processor’s performance and
price advantage versus pro-
prietary offerings,” says Lisa

Graff, director of Intel’s Ita-
nium Group. Intel claims
that out of the top 25 Global
500 companies,  14 have
deployed Itanium2 servers
under this scheme. The
scheme will run until the
summer of next year, and
Intel is working with vendors
and software providers for
this program to succeed. 

Although the sales of the
Itanium are rising, they
aren’t showing the growth
Intel expected from it—Intel,
ambitiously, named circa
2003 as the year of the Itani-
um. The company aimed at
selling 100,000 Itanium
processors this year, but sales

speak otherwise. An IDC
report quotes that 4,957 sys-
tems based on the Itanium
processor were sold in the
third quarter of 2003, com-
pared to 10,746 Opteron
servers and 24,000 SUN
UltraSPARC servers sold.

Itanuim2 available as 
‘Trialware’

Anti anti-spam
virus 
A virus is using a new trick to

launch DDoS attacks against

anti-spam Web sites. Called

MiMail.L, it spreads through

e-mail as a compressed

attachment that dodges

anti-virus software. It then

sends itself to all addresses

on the infected computers,

and uses these systems to

send meaningless traffic to

Web sites of anti-spam

groups, including Spamhaus,

SPEWS and Spamcop that

maintain a list of spam-

servers, thus helping users to

identify spam.

In April 2003, Yahoo! formed
an anti-spam alliance with
America Online and
Microsoft. Now, it’s working
on DomainKeys—a code
that uses public key cryptog-
raphy to digitally sign the
outgoing messages. It will
be compatible with two
most popular e-mail pro-
grams—Sendmail and qmail.
According to Yahoo!, most
e-mail users are loosing trust
in e-mail because of spam,
and almost half of the mes-
sages that it handles are
spam. Using sender autheti-
cation, Yahoo! expects to
regain its credibility, eventu-
ally opening paths to more
intelligent spam blocking
technologies.

Spam
Yahoo! v/s Spam

➜

Toshiba manufac-

tures world’s small-

est hard disk that is

22 mm in diame-

ter  and has a capaci-

ty of 2 to 3 GB

snapshot

Source: Asia Times
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Everyone’s going to
be talking about the
digital divide, and
how massive it is. Is
the digital divide as
big as we think? The
answer is, ‘No!’
Michael Minges, co-author 
of the annual study by 
the International
Telecommunication Union 

US society is not
being re-skilled 
and re-tooled to 
stay on the top 
of the emerging 
environment 
Wipro Chairman, Azim
Premji, on why IT firms find
India attractive

They are winning by
a considerable mar-
gin. Very few have
been identified,
prosecuted or pun-
ished
David Finn, Director of digi-
tal integrity, Microsoft,
commenting about pirates
in South-east Asia who
seem to be winning the war
on piracy

It’s a dirty secret.
Floating-point arith-
metic is wrong. It
only takes two oper-
ations to see that
computers make
mistakes with frac-
tions.
John Gustafson, an 
investigator with Sun
Microsystems, Santa Clara,
California, on bad mathe-
matical calculations being
the reason behind system
crashes. He reckons
Microsoft need not always
be the culprit

quoteworthy

Two recent technological
advances will allow

shrinking of chips to contin-
ue for some time. NEC
announced it has developed
the world’s smallest transis-
tor that is 1/18th the size of
existing transistors. Using
the new technology, a a chip
measuring 1 sq. cm will be
able to hold 40 billion tran-
sistors—about 150 times
more than the current densi-
ty. Such transistors can be
used to build a supercomput-
er that churns out 600 billion
operations  a second, while

being the size of an ordinary
desktop.

The company expects to
start production by 2020.

In a separate develop-
ment, IBM announced it uses
molecular self assembly to
build smaller chips. Organic
polymer molecules assemble
themselves into hexagonal
patterns that are denser and
more precise than those
obtained using lithography.
The process can be imple-
mented using existing man-
ufacturing tools, making it
inexpensive.

Chip off its size!

Aiming at weeding out the
weakest link in the chain

of encryption, a company
called MagiQ Technologies
Inc., claims to have developed
an unbreakable and unbreach-
able encryption system,
named Navajo. The Navajo
black box system costs about
$100,000 (Rs 4,55,100), and
can span 70 miles, after which
additional relay boxes are
needed. The system comprises
19-inch boxes which commu-
nicate with each other over
optical lines. 

Navajo is secure because it
uses Quantum encryption.
The keys are transmitted using
photons, which are discrete
particles of energy, and they
change 10 times a second. This
means if a person gets hold of
the key, it will be rendered use-
less almost immediately. Also,
based on Heisenberg’s Uncer-
tainty Principle, the extremely
sensitive photons change their
behaviour if somebody tries to
spy on the communication
during the transfer. 

Up until now, people have
only been using bigger and
bigger encryption keys gener-
ated by more and more com-
plex algorithms, which means
that breaking them was just a
question of ‘when’. Quantum
cryptography changes all that.

MagiQal
Encryption

In Baramati, Maharashtra,
the life of dairy-farmers has

changed in recent times. Ear-
lier, cow owners had to milk
cows and rush to the local
market to sell the milk before
it got sour. At times, almost 50

per cent would be left unsold.
However, with the efforts of
Dynamix Technologies,
which sells milk to Nestlé and
Britannia, things have
changed. It has set up com-
puterised and refrigerated
milk collection centres, local-
ly known as bulk coolers.

Cows are milked by a
machine, and the milk is
taken to the bulk coolers. The
fat content of the milk is
checked by a computer, and
the price accordingly deter-
mined. The dairy farmer is

paid immediately, and
the milk is taken to
the bulk cooler.

Later, it is transported to the
Dynamix factory.

Computers are also used
to maintain a database of the
complete history of health,
nutrition, disease, pregnancy
etc of a cow. This helps dairy
farmers develop better breeds
that produce more milk.

Analysing milk, PC-style!

■ Sharp to release the first notebook with Transmeta Efficeon CPU  ■ Intel to debut 90 nanometer Prescott microprocessor as part of the Pentium4 series 

Largest prime num-

ber with

63,20,430 deci-

mals calculated using

2,00,000 com-

puters

snapshot

Source: Great Internet Mersenne 
Prime Search

tomorrow’s technology
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Your vote counts
This month’s question:
Which is the means of communication you use the most?

! Telephone ! Cell Phone
! E-mail/ Instant Messenger   ! Indian Postal Service

Log on to www.thinkdigit.com and vote

Of laptops and time travelI have a few things to point out: When you test a
product, please specify three to five vendors that sell
it; this will save us from visiting several vendors just
to see whether they have that particular model. I
would also like to see a test on laptops, as laptop
prices are falling.

Now for a few goof ups: The quiz on page 184
states that the answers are on page 71, but they
aren't. On page 50: CPUs 2003 Digit winner:
Pentium 4 3.2 GHz, Previous winner 2001: Intel
Pentium 4.2 GHz. Intel achieved a speed of 4.2 GHz
in 2001. I didn't know that!
Sridhar
Via e-mail

I had renewed my Digit subscription last month (for June 2004-
May 2005), but I want to cancel it. This is mainly because I feel
cheated by your subscription offer.

The encyclopaedia CD was the sole reason I subscribed in
advance, but to my utter dismay I found it free with my
December issue. I feel cheated by Digit.

Joydeep Chakraborty

Via e-mail

Whoopee! Who said you can’t have everything? Four CDs of super-
good software + an Encyclopedia CD + one hell of a movie + one
hell of a special issue for just Rs 100 extra!! You guys should be
guest lecturers at management institutes on “The Perfect Offer”.
Congrats!

V.Dev Kanchen

Via e-mail

The December 2003 issue of Digit with the VCD is S-U-P-E-R-B.
My Entire family enjoyed watching Ice Age. Do keep sending
more and more VCDs with each Digit issue.

B. Lalith Kataria

Via e-mail

I have just received my subscription copy of Digit Dec 2003. Dissa-
pointingly, all the four CDs labelled ‘Softwarez@Max’ are the exact
copy of the CDs provided in the 10-CD Pack. Even the Tips & Tricks
Section in the Encyclopedia CD was previously provided as a sepa-
rate CD  So the only thing worth giving is ICE AGE and the Ency-
clopedia which does not contain even a single audio or video clip.
I'd feel totally cheated if I bought this issue at a cost of Rs 200.
Sumeet Malhotra

Via e-mail

Secrets revealed!
I am a regular Digit reader,

and greatly appreciate the

magazine, but this time, I'm

really angry! Your December

2003 issue revealed some

registry secrets, which I had

mastered after a lot of hard

work and man-hours.

Thanks to you, everyone can

master these secrets. I don't feel spe-

cial anymore, and for this, I can't for-

give you. Keep up the good work! 

Amit
Via e-mail

Dear Sridhar
Let’s all join hands and concentrate… Poof! There you go.
The issue you have in your hands now contains a rather
large test on laptops. Magical, aren't we?

Thank you for pointing out the goof ups. In prepara-
tion for the December 2003 issue, we were all involved in
advanced mind-games that required mnemonic and spa-
tial skills… As a result, we inadvertently caused an anom-
aly in the space-time continuum, which created a big time
portal. The gravity of all the goodies packed into the
December issue yanked the 4.2 GHz CPU out of the
future, and onto page 50. Of course, in keeping with the
First Law of Thermo-dynamics that states that the ener-
gy of the universe is constant, we had to send Qubit
answers through the time portal to close it. Honest!

If you still haven’t solved Qubit, look for the  answers
on the Digit forum.

Registry hacks are truly an art form. Their knowledge is well
sought after, and their execution requires guts of steel—don't for-
get to backup your registry—which is why we feel your pain. In the
near future, we will reveal '15 Secrets to Life', and hope that the
saints and sadhus won't mind too much. Stay tuned!

ILLUSTRATOR: Mahesh Benkar

Q. Do you buy second-hand hardware? 

Never considered 
buying second-hand
hardware 

Own a second-
hand computer

52.5%

Don't trust second-
hand hardware 

reliability

Own some
second-hand
components

Responses: 1,677

Our aim was to delight newsstand buyers with a package worth much more than the

cover price of Rs 200, but their enthusiasm seems to have a counterpoint in the protests

of some of our new subscribers.

While the response to our Software-for-a-Lifetime offer drew a tremendous response, the

number is, but a small fraction of our readership. We offered our periodic readers only a small

sample of the massive CD-Pack that was free with the subscriptions. Four CDs do not compare

to a 10-CD pack, one that contains not only 7 CDs worth of applications and games, but also

the only free 3-CD distribution of Red Hat Linux.

Similarly, while the Encyclopaedia was bundled with the December issue, we offered our

subscribers who signed up for the free Encyclopaedia offer, an extension to their subscription

to compensate for the lost exclusivity.

If you signed up for these two subscription schemes, and feel you did not get a fair deal,

please do not hesitate in asking for an immediate full refund of the subscription order.

December dilemma

9.7% 11.4%

26.4%
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E-mail: readersletters@jasubhai.com
Send your letters marked ‘Readers Letters’ to the Digit office: 

D-222/2, Om Sagar Building, MIDC, TTC Industrial Estate,  Nerul, Navi Mumbai 400 706 
Phone: 022-2762 9191/9200  Fax: 022-2762 9224

" E.S.Chandrasekaran of
BSNL has pointed out
some factual errors in
Insight on Virtual Private
Networking: BSNL offers
two types of VPN services
for data communica-
tion—MPLS-VPN  and IP-
VPN. It  also offers IP-VPN
services through BSNL's
Internet nodes located
throughout the country.
" The price of the Sony
SDM N80 18-inch LCD is
1,27,000, and not 1,29,00.
Whew, arent you glad

Notice any goof-ups? 
Write to goof@jasubhai.com

Goof Ups
lost_in_the_d
iscussions

Analogue
Novice

Digitized! 

Joined: 
10 Dec 2003

Posts: 8

super_ferrari
Resident Techie
Joined: 
05 Dec 2003
Posts: 89

At first sight, there was one thing that irritated me in the December issue of
Digit—the ads. Since I am doing my Business Management course, let me tell
you something from the Business point of view. Digit is a business establish-
ment which exists to make money. And when you talk about the business
model of any media, be it newspapers, be it magazines or even television pro-
grams, they survive and run because of advertisements. 

From the Forum (www.thinkdigit.com/forum)

Posted: Wed Dec 10, 2003 2:39 pm Post subject: Ads, ads and ads!!

Yeah ads are necessary for a business organization’s existence....even our super
rich master blaster Sachin does so many ads...does he need dem!?!... But using
models on da cover page of Digit makes it look like some Bollywood mag
rather dan technology mag. Overall I am satisfied with DIGIT...a really inform-
ative mag.

Setting trends, Digit style
Needless to say, Digit has always been a trendsetter. Dishing out a free VCD with the

December 2003 issue irrevocably supports that envious fact. The Digit Encyclopedia, the

VCD and the four software CDs in one issue—it seemed as if I had hit the jackpot! Kudos to

the entire Digit team for such a creative effort! However, I do wish to address a few issues:

Firstly, Digit being a technological magazine, an old sci-fi flick such as Blade Runner would

have been more appreciated than Ice Age. Secondly, keeping aside the VCD and the

Encyclopedia, the other four CDs could have easily been squeezed onto a DVD with the

price tag for two CDs, and the one DVD could have been set at Rs 100. I found the price

too expensive. I hope to see sci-fi movie VCDs in the future from the Digit think-tank!

Arindam Sarkar, IIT, Kharagpur

Via e-mail

A bundle of joy

It was the sixth of December, and I was impatient for my

subscription copy of Digit. Come noon, the door bell rang

and voila! One cool-looking

guy with my subscription

issue, I was very happy. I

came to my room and

opened the cover. To my

astonishment, I found six

CDs in it! Wow, you pro-

vide your magazine with a

lot of punch. For a moment, I thought the Ice

Age VCD was a promotional CD, with trailers

or advertisements, sponsored by Twentieth

Century Fox. I bravely put the CD in my VCD player, and to

my excitement, it was Ice Age, the entire movie! Fantabulous!

My four-year old son and I thoroughly enjoyed the movie that

day. Congratulations! Keep it up. This idea of yours is really

innovative. All the Best.

Neha Prabhu

Via e-mail

Thanks for writing to us
Arindam,
Firstly, DVD-drives are still a rarity in
India, as attested by the reader
feedback we got from the August
2003 Linux special. We wanted all
our readers to enjoy the Decem-
ber package, hence the choice of
CDs.
We briefly considered a science
fiction movie, but decided on a
broader interest movie, Ice Age,
that everyone can enjoy, as attest-
ed by fellow reader Neha Prabhu.

The ratingsgame
In the November 2003issue of Digit, although theZenith PC was graded 'B-',it still won as the best per-former. Why was this so?Jishnu R

Via e-mail

The Zenith PC won
because it was the best per-
former. It beat just about every-
thing else, in almost every test.
However, our ratings (A,A-, B+,
B, B-, etc.) also take into con-
sideration the Value For Money
(VFM) scores. We calculate this
score by adding its perform-
ance and features scores, and
dividing the sum by it’s price.
This decimal value is then fed
into a calculator that deter-
mines a product’s VFM.

Complicated? Sure, but
this is the best way to make an
accurate judgment. The Zenith
PC beat all the others, but cost
a whole lot more too. Was this
increase in cost justified by a
significant increase in perform-
ance? We rate products, and
have two categories—Value
Winners and Performance Win-
ners—so that you can make an
informed decision to buy the
products that best suit your
needs, as well as your pockets.

If you see other technology magazines, all they have on their cover page is
some boring graphics, or at most, some computer component. I think these
cover models give Digit a different look. And don't tell me that you don't like
nice girls!!

lost_in_the_dis-
cussions
Analogue Novice
Joined: 
10 Dec 2003
Posts: 8
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BBlluueettooootthh  hhaass  ffiinnaallllyy  aarrrriivveedd……

Already,
100 million
Bluetooth
devices have
been shipped”
“
VIPUL SHAH 

Vipul Shah is a chartered accountant who writes and consults on Internet, e-commerce, banking and finance tech-
nologies. He can be reached at digit@vipulshah.com

Bluetooth, a short-range wireless
technology was unveiled in 1998. It
was named after the Danish king Har-

ald Bluetooth, who is reported to have unit-
ed Denmark and Norway. He was also sup-
posed to unite the world of consumer elec-
tronics and computers, and make all the
devices in the living room, as well as the
office, talk to each other. Bluetooth is wide-
ly promoted as a ‘cable replacement’ solu-
tion which works within 10m to 100m at
720 Kbps. But we didn’t see much happen-
ing in 2001 and 2002 in this direction. The
reasons are various: from Microsoft not
including Bluetooth in Windows XP and its
SP1, to companies trying to push cus-
tomised Bluetooth devices which won’t see
and communicate with Bluetooth devices
made by other companies. Also, a lot of
other technologies such as cordless phones,
Wi-Fi and microwave ovens share the same
2.4 GHz band, and hamper the performance
of Bluetooth devices that are in their vicin-
ity. Meanwhile, a lot of marketing muscle
was deployed to the competing Wi-Fi stan-
dard. During this period, Ericsson—the
inventor of Bluetooth—kept releasing Blue-
tooth-capable mobile phones under its new
corporate brand Sony Ericsson. We also saw
the occasional release of a Bluetooth-capa-
ble PDA from Palm, the Clie from Sony and
the iPAQ from HP. But all these catered to
the high-end segments, and were not really
meant for the budget-conscious employee
or home user. 

All of this changed slowly this year. We
saw a flurry of Bluetooth products
announced in the last 4 months by HP,
Lexus, Nextlink, Plantronics, Jabra, Sony-
Ericsson, Siemens, Nokia, Palm, Microsoft,
Logitech and Sony. Lexus announced a
Bluetooth-integrated car which will pair
with four different Bluetooth mobiles, and
let you use all the mobile functionality from
the dashboard and steering wheel, while
your phone sits in your bag. It will allow
you to dial only selected numbers from the
address book while car is in motion, and all
the numbers when the car is stationary.
Nokia announced a Bluetooth car kit for
those of us who can’t buy a Lexus. 

Microsoft and Logitech have a keyboard
and optical mouse that will use a Bluetooth

USB dongle on the back of a PC. HP now
uses Bluetooth as a standard on most of its
Windows Mobile 2003-run iPAQ PDAs,
but Wi-Fi is offered only on its top-of-the-
line 5500 series. Tapwave released the Zodi-
ac gaming device based on PalmOS, which
uses Bluetooth. Philips introduced the
world’s cheapest Bluetooth-enabled GPRS
colour phone—the Fisio 826—at Rs 7,500 in
India last month, and it was sold out in
matter of days.  

My Bluetooth phone synchronizes the
address book, calendar, etc, with my PC,
which is in the next room. The best part is
that Bluetooth is driver independent—
I don’t need drivers for every Bluetooth
device talking to my Windows XP PC.
So, when I recently bought a Siemens S55
phone, I didn’t need to install a CD
containing the drivers and software, as my
Bluetooth-enabled PC was more than
ready to talk and synchronize with any
Bluetooth phone.

Since October 2003, more than 1
million Bluetooth devices are being shipped
every week, all around the world.
Already, 100 million Bluetooth devices have
been shipped. 

Bluetooth 1.2 is expected to resolve a lot
of issues with the present Bluetooth 1.1 stan-
dard. It will use a frequency hopping algo-
rithm, so that communication will not be
disrupted by other devices using the same
frequency. You’ll also see improvement in
sound and data transmission capability once
Bluetooth 1.2 devices hit the stores. All these
devices will be backward compatible with
existing Bluetooth 1.1 devices.

Using Bluetooth to make a PC, mobile
and PDA talk to each other was the most
obvious use, but now we’re going to see
many innovative applications such as read-
ing the temperature, opening garage doors,
printing TV listings via a neighbouring
printer, or a refrigerator alerting us of a
power failure. It could also make for Blue-
tooth-enabled credit card terminals to be
used by hawkers that will be connected to a
mobile phone.

Bluetooth is going to make its mark in
Asia more than anywhere else in world, due
to smaller homes where every device is
within ten metres of anything else. 



The new wave of reconfigurable robots will learn, change themselves, and evolve
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Do a Google search on ‘robots
will’, and you see: ‘Robots will
steal your job…’, ‘Robots will

kill…’, ‘Robots will change us…’,
‘Robots will make good friends…’,
‘Robots will manage your network…’,
etc. Clearly, people have a lot of beliefs
about what robots will do, and this is
justified because robots, or bots, already
do so many amazing things. They give
back massages, vacuum entire rooms
and play soccer with each other. Not
many people are aware that we are on
the cusp of a new wave of artificial intel-
ligence, which promises robots that will
learn about their environment, change
as the environment demands, improve
themselves and, possibly, reproduce.
Whatever else robots may or may not

do, we’re sure of a couple of things—
they will learn; they will change them-
selves; they will evolve by themselves.

Roach bots
Robotics is rapidly embracing ideas from
other disciplines, leading to new tech-
niques and sub-technologies. Honda has
its Asimo humanoid, and Sony has its
robotic Aibo dog, both of which are
impressive. However, the Asimo and the
Aibo are ‘static’ bots in the sense that
they do not dynamically adapt to their
environment; what they learn is only
facts that are added to their knowledge
base. These facts do help them function
better, but cannot help them evolve in
any way. Asimo and Aibo-style research
will not drive the future; it’s evolutionary

and animal-mimicking techniques that
will dominate. Animal-inspired robotics
aims at emulating certain animals, espe-
cially insects and the like. Biologists and
engineers have worked together at pro-
ducing bot versions of popular insects
such as flies and cockroaches. If you’re
afraid of cockroaches, then the three bots
at Case Western Reserve University,
Ohio, United States, are your worst
nightmare: they’re huge, they look like
cockroaches and they do the things that
cockroaches do—jump, fly, and so on.
The goal of this experiment was to build
machines that could go where humans
won’t—inside nuclear reactors, or into a
fire. The inspiration from biology is driv-
en by laziness: why engineer a creature
when nature has already done it for us?

features ■
■ technology next
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The biologists’ payoff is that they
get to learn how cockroaches function.
For instance, Joseph Ayers, a neuro-
physiologist at Northeastern University
in Boston, is now working on a robot
lobster. He says, “The experiments you
do on the robots tell you what you
ought to be looking for within the ani-
mal.” Some labs have reported that
studying how insect bots fly led them
to a conclusive explanation of how real
insects fly—which, incidentally, is
through complex and unconventional
aerodynamics.

The Case Western experiment is a
typical example of the intermeshing of
disciplines that’s happening in robotics.
The program started with Randall Beer,
a computer scientist, who was frustrat-
ed by the slow progress of AI. He sought
guidance in the nervous systems of sim-
ple insects. However, animal bots are
the tip of the iceberg when it comes to
the New Wave. They may teach, but
they don’t learn.

Artificial life
It’s only natural that a field called arti-
ficial life should have come up, since all
scientists at some level want to play
God. Artificial life comes from the idea
that complex systems such as life, arise
from simple interactions between enti-

ties in suitable environments. The field
attempts to model as well as understand
life using simulations that involve com-
plex algorithms. For example, the Arti-
ficial Life Group at MIT discusses ‘all
things pertaining to the modelling and
synthesis of biological systems.’

An ambitious artificial life project in
2002 gives a flavour of the kind of
research that goes on: A team at the
University of Zurich, Switzerland, creat-
ed computer simulations with muscles,
senses and nervous systems. These sim-
ulations were ‘grown’ from artificial
embryos. The genome, or life code, for
each of these was a string of random
numbers. The creatures were real to the
extent that their cells contained simu-
lated, reactive chemicals. Josh Bongard,
the head of the team, was hopeful that
the creatures might develop brain-like
regions when assigned tasks.

Appropriately, many of the algo-
rithms used in such studies are genetic
algorithms, which are a subset of what
are known as ‘evolutionary algorithms’.
The concept of genetic algorithms
comes from the evolution of life itself—
survival of the fittest. People in artificial
life labs often work with living tissue;
but what about working with hardware?
Hardware that knows itself, and can
self-modify? Hardware that lives? That’s

where evolvable hardware and evolu-
tionary robotics come in—the marriage
of robotics with artificial life.

Actually, there’s a whole slew of tech-
nologies and disciplines that will make
the smart bots of the future possible: tra-
ditional robotics, neural networks, evo-
lutionary algorithms, programmable
hardware, evolvable hardware, and many
others. Every smart bot that’s rolled out
of a lab was born with the help of one or
more of these techniques.

Robots that learn
Before the concepts of self-modifying
machines, there was the idea that a
robot could learn things—learn, adapt
and improve. An example is Adam, a
learning robot developed at Monash
University, Australia. A niche environ-
ment called Eden was developed for
Adam, with the expectation that he
would learn and evolve there. Adam
learnt to navigate within his environ-
ment; for example, how to avoid bump-
ing into walls. That’s already a major
leap ahead from ‘static’ robots such as
Aibo and Asimo, which learn only facts.
As in artificial life, learning robots often
use evolvable algorithms to drive their
learning machinery, which, in hard-
ware, is often a neural network of some
sort (See Box ‘Training and Evolving Neur-
al Networks’, page 27).

A bot-eat-bot world
If Adam doesn’t sound interesting
enough, here’s something way out: in
March 2002, at the Magna Science
Adventure Centre in Rotherham, Eng-
land, robots were divided into predators
and prey, in a specially constructed
environment. The aim of the experi-
ment was to see if and how the com-
munity of bots would evolve an
ecosystem. Wired magazine called it ‘an
experiment that sounds like a science-
fiction film plot, but is actually as close
to real life as artificial intelligence can
get.’ The people at Magna billed it as
‘the largest experiment ever in artificial
intelligence.’

It’s not science fiction, but there’s
very little about the experiment—which
ended in August 2003—to make it
sound like science fact. The prey robots
would have to feed by charging their
solar batteries by sitting under artificial
trees made of light. The predators would
feed on the prey by hunting them
down, immobilizing them, and insert-

Genetic algorithms are able to find optimal
solutions to problems using the basic prin-
ciples of Darwinian evolution—mutation,
crossover, selection and so on. In many
instances, they can find optimal solutions
much faster than other algorithms.

Genetic algorithms work in the follow-
ing manner: a chromosome in biology is a
collection of genes. When working with
genetic algorithms, think of a gene as a bit,
and of a chromosome as a string of bits.

Each initial chromosome, in a genetic
algorithm simulation, is taken to be a possi-
ble candidate solution. In this way, the
‘solution’, which is not actually a solution
yet, is encoded as a string of bits. The chro-
mosome, or string, may be made up of
random genes—it can be a random string
of bits. Now, with the initial collection of
chromosomes at hand, each chromosome
is tested for 'fitness', i.e., how good a solu-
tion it is. The ones that are better are more
likely to reproduce.

Given the chromosomes that will repro-
duce, the crossover step comes in: two such
chromosomes (remember that these chro-
mosomes are strings of bits) are chosen,
linked together, and at a particular point,
are cut and joined each half to the other.

Mutation comes in at this point. After
crossover, some bits (not too many) may
be randomly changed, in order to intro-
duce some variety. This is done once every
few generations. The crossover and muta-
tion steps are repeated as many times as
required to produce the same number of
chromosomes that were there in the initial
population.

The new collection of chromosomes is
again tested for fitness, just as with the ini-
tial population, and the cycle continues.
So far, one ‘generation’ of the algorithm
has been completed. The entire process is
repeated until the collection of chromo-
somes obtained is a ‘good enough’ solu-
tion to the original problem.

Genetic Algorithms



ing an ‘energy-sucking fang’ into a spe-
cific spot on them to transfer battery
power to themselves. This may sound a
little grey, but it’s as simple as that. At
Rotherham, predator and prey robots
struggled for survival, feeding and hunt-
ing, with their creators hoping they
would succeed in building a civilisation.
How would they evolve? Quite simply,
by the Darwinian principle: each bot
would upload its genes, when they
changed, to a central server. And in the
next generation, only those bots that
lived long enough would have their
genes added to the gene pool. 

But there’s more. In June 2002, one
of the bots went missing. It had escaped.
It had left the arena for a small repair to
its body work after a day of particularly
hard battling. It forced its way through
a small gap in the barriers, went down
the access slope to
the workshop and
out into the car park.
It somehow made its
way to the entrance
gates, only to be
found by an unas-
suming visitor who
nearly ran over it in
his car.

Noel Sharkey,
the brain behind the
Magna experiment,
said he was thrilled
that the robots have
become so intelligent. He said it was fan-
tastic and, “there’s no need to worry, as
although they can escape, they are per-
fectly harmless and won’t be taking over
just yet!”

However, in a cyberchat with the
BBC, when asked whether there would
be a time when we wouldn’t be able to
distinguish a human from a bot, Profes-
sor Sharkey said “It’s unlikely that any-
thing we think of as a robot now will be
indistinguishable from a human. I
believe that metal will never be mental.”

Self-modifying software and
hardware
News about robots that can play with
your dog, or set up a LAN, is boring.
We’ve come to expect robots to be able to
do stuff like this. And after experiments
like the one at Magna, we expect them to
be even smarter. In the fundamental shift
that will take place, robots will be able to
know about themselves, and make
changes to their software and hardware.

Jürgen Schmidhuber, a major con-
tributor to the field of learning robots,
talks about Gödel machines—how a
machine will modify its software. A
robot powered by a Gödel machine will
be able to modify its code, as soon as it
proves that its performance will improve
with the modified code. As an example
application of Gödel machines, Schmid-
huber mentions a robot that interacts
with a partially unknown environment,
trying to find hidden gasoline depots to
occasionally refuel its tank. Such a
robot, if it had a Gödel machine for a
controller, would be able to optimise
itself so that it lives the longest it can, by
refuelling itself optimally.

Self-modifying software is one
thing, and self-modifying hardware is
quite another. This is generally called
‘evolvable hardware’, and there are

several research groups working
towards the fabled robot that opens up
a body part and repairs it when some-
thing goes wrong.

Artificial evolution was previously
relegated to software simulations,
carried out on neural network
configurations, and that was considered
enough. But as Adrian Thompson
of the University of Sussex—a pioneer
in the field of Evolutionary Robotics
(ER)—points out, “There are three
reasons why we would want hardware
to modify itself. First, hardware
evolution can deal with real-world
physics, which is difficult to analyse
or model in simulations. Second, when
it comes to interacting entities, it is
difficult to precisely model size,
location, shape and so on, in simula-
tions. And third, the characteristics and
interactions of the evolving entities do
not remain the same with time—
physical evolution will be able to get
round this problem.”

Bots changing themselves
So what exactly does evolving hardware
look like? Not like a humanoid wielding
a screwdriver—at least not yet. The
Khepera robot (http://www.k-team.com/
robots/khepera/) has been modified to
have two layers of FPGAs (See box
‘FPGAs’ above) on top, which allow evo-
lution of the robot’s control system.
FPGAs are hardware that actually
changes as the robot evolves.

Evolution can be used to find novel
circuit designs by searching a larger
‘design space’ than is accessible to
humans. The evolution of circuits 
has led researchers to conclude that 
they could learn from it—they could 
discover design principles from
evolved hardware.

An adaptive hardware system that
learned the behaviour of an expert robot
controller, using a genetic algorithm,
has been developed. This controller
could be used if the primary controller
failed. Think of this as a robot develop-
ing a spare brain for itself after
inspecting its original brain. Parts of
robot controllers have also been
evolved, which interact with the envi-
ronment dynamically, in a manner that
would not have emerged if traditional
design had been used.

Robots have evolved to visually dis-
criminate between objects of different
sizes. They have evolved over a period
of time to integrate sensory and motor
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FPGAs, or Field Programmable Gate
Arrays, are programmable digital logic
chips. No soldering, or any such manu-
al work is required to change their
function. All that is needed is for the
FPGA’s program, or desired behaviour,
to be downloaded onto the chip.
The program for the FPGA, or the func-
tion that it will perform, needs to be
first designed on a computer, and then
translated into a form understandable
by the FPGA—that is, it needs to be
compiled. The compiled program is
downloaded onto the FPGA, and it
then behaves according to the design.
For example, you can program an
FPGA to perform a basic logic opera-
tion, such as ‘And’. Of course, they can
be programmed to perform much
more complex operations.

FPGAs

The name of the
game is to develop
extremely simple
mechanisms that,
when placed in the
world, exhibit complex
behaviour.

Noel Sharkey
Interdisciplinary
researcher
University of
Sheffield, England

““

➜
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information with their inbuilt knowl-
edge, so as to use the information later
to better respond to their environment.

The Evolutionary Robotics Group at
the University of Sussex evolved—not
trained—a robot to identify a triangle in
a room. The robot was not programmed
with any knowledge of geometric
shapes; it was evolved over several gen-
erations, and the evolution was stopped
when it had learned to identify a trian-
gle. And yes, robots have even evolved
a language to communicate with their
foster parents, the researchers in the labs
they were born in.

Evolvable hardware
Hugo de Garis, one of the pioneers in
the field of evolvable hardware (E-Hard),
has a useful definition of the term.
According to him, E-Hard is the mar-
riage of reconfigurable hardware and
evolutionary algorithms, often genetic
algorithms (See box ‘Genetic Algorithms’,
page 25). Think of the hardware as living
tissue. It needs to be programmable;
that is, its behaviour—like that of living
tissue—can be dictated by software of
some sort. That’s where FPGAs come in.

Living tissues have chromosomes
that direct how the tissue will behave.
Chromosomes come in strings of basic
units, and their message is encoded in
the way the basic units are strung
together. In the case of E-Hard, the chro-
mosomes used are genetic algorithms,
encoded into bits. These cause the hard-
ware to behave in a certain way. The
codes that make the hardware perform
better are allowed to have more off-
spring—the number of pieces of hard-
ware they command—in the next
generation of the algorithm. Evolution
occurs by randomly mutating the chro-
mosomes that define the hardware’s
behaviour, as it happens in nature.

Think of a robot that has two
motors. If one of the motors fails, the

robot will malfunction. In anthropo-
morphic terms, the robot wouldn’t
know what to do. However, if the hard-
ware were evolvable, the robot would
eventually repair the faulty motor, and
begin to move properly.

Evolving robots: the Implications
Consider, from a designer’s perspective,
what evolving robots would mean.
Instead of having to technically detail
how a bot would go about exhibiting
each bit of its desired behaviour, he
would simply specify what he wanted
from the bot.

Engineers would have an easier time
because, with regular robots, the overall
behaviour needs to be divided into mod-
ules, and each of these has to be described
precisely. If the robot could evolve, a
generic design combined with the design-
er’s specifications would do, and the
required ‘global’ behaviour might emerge.
Robots could be mass produced and
allowed to do their duties in special envi-
ronments. The good ones would be used,
and the bad ones simply thrown away!

How? Recall the Gödel machine. A
robot equipped with a Gödel machine
for a controller can modify its software;
and with modifiable hardware, it can
change its physical circuitry. Now con-
sider such a robot that is given a goal. It
would do some part of its job, inspect
what went wrong and what went right,

check its own code and hardware, and
modify itself suitably… on and on, until
it became perfect, or until it was
destroyed—if it took too long.

Evolving robots know what they are.
They know what they’re supposed to 
do. They can change themselves.
They’re alive!

The bots have arrived
Sun Microsystems co-founder Bill Joy’s
now well-known article in Wired, titled
‘Why the future doesn’t need us’, began
with the subheading: “Our most power-
ful 21st-century technologies—robotics,
genetic engineering, and nanotech—are
threatening to make humans an endan-
gered species.” Joy went on to express his
fears about the new technologies, saying,
for example, that robots might be dan-
gerous because they might replicate; that
we may not survive our encounter with
the new species, and so on.

Everyone has a point of view, and
something to say about this—some say
Joy is exaggerating, some share his con-
cerns. But there’s no doubting the fact
that robotics has come of age; it’s only
a matter of time before we relegate more
and more of our duties to the machines.

The ‘new species’—humanoid, bot,
part-human-part-bot, whatever—has
already been born.

RAM MOHAN RAO

ram_mohan@thinkdigit.com

Neural networks consist of layers of pro-
cessing units connected to each other.
These connections have weights; think of
the weight as the ‘importance’ of the
connection, or how much of a role it
plays in the entire network.

Inputs come in at the lowest layer,
and the output is from the output layer.
This is how neural nets learn, or are
trained: the inputs are given, and an out-
put is obtained. The output depends on
the input, the connection weights, and
on the topology of the network—that is,
how many nodes and layers it has.

If the topology has already been
decided upon, it is the connection
weights that are changed according to
the output. The output is checked, and
its deviation from the ideal output dic-
tates how the weights will be changed.
After the weights have been changed,

the output will be different the next time
round. This new output is then used to
change the weights again, and so on.
The process is repeated until the output
reaches an optimum.

The neural net can evolve in one of
many ways, including using a genetic
algorithm. Notice the similarity between
the training of a neural net and the
evolving of a genetic algorithm. It is easy
to see how a genetic algorithm's evolu-
tion can be applied to a neural net. Each
generation of a genetic algorithm pro-
duces new collections of strings. The
neural net can change its topology and
connection weights, based on the con-
tents of the collection of strings. For
example, the bits in the strings that the
genetic algorithm has produced may
translate directly into connection
weights.

Training and Evolving Neural Networks

Jürgen Schmidhuber’s homepage:
www.idsia.ch/~juergen/

The Evolutionary Robotics Homepage:
gral.ip.rm.cnr.it/evorobot/
Evolutionary and Adaptive Systems at
the University of Sussex:
www.cogs.susx.ac.uk/easy/index.html
Bill Joy’s article in Wired Magazine:
www.wired.com/news/giz-
mos/0,1452,50247,00.html
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Presenting cameras that obviate the need for
saying cheese—they entice you with their
features, and of course, their good looks

Magnificence

▲
▲

Logitech QuickCam Orbit
Eye follow you

With automatic face tracking, this camera adjusts
itself to always face the user. The ball shaped
camera sits on a stand, and can be tilted 180
degrees horizontally and 90 degrees vertically. You
can set it up to automatically update images on

your Web page. It can record videos at a resolution
of 640 x 480, and photos at 1.3 megapixels.
Price: USD 129

iSight 
Beautiful eye 

Encased in an aluminium-alloy body, Apple's iSight Web
camera has an on-board processor that automatically

adjusts such parameters as sharpness and white balance.
The dual microphones use an algorithm to eliminate back-

ground noise, and reproduce only essential sounds.
Price: USD 149

Linksys Wireless-B Internet Video Camera
Eye stand alone

Using the 802.11b wireless network or an Ethernet cable, this video
camera can send live video to a Web browser, using the

inbuilt Web server. It connects directly to a network to
send a 320 x 240 video stream compressed using the

MPEG-4 standard. It’s wall mountable, and can also be
programmed to send an e-mail with a short video

attachment, whenever it detects motion.
Price: USD 250

Ocular

▲▲

▲ ▲



Sony Cyber-shot U 
Tear proof eye

Put it up to 5 feet under water, and you have a
camera that still works in top gear. You can operate
it with one hand, because of its vertical design. It

has a 2.0 megapixel effective resolution, 1x Optical
Zoom and a 1.0 Hybrid LCD Monitor.

Price: USD 249
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Pentax DigiBino DB100  
Powerful eyes

This camera-cum-binoculars set has a
magnification factor of 7x. It can record both

still images and videos, which it stores on its 16
MB memory card.  

Price: USD 242 

Logitech QuickCam Cordless
Single-horned eye
The cordless camera from Logitech gives you 22
metres of freedom. It also allows you to send live
video to mobile phones using the Logitech

Mobile Video service. 
Price: USD 179

▲ ▲

▲
▲

▲▲
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The
much-

ICONS
TRUST

Technology has never
been more answerable
to its users. Over a
period of two-months,
2,000 consumers voted
for their most reliable
device, their most
trusted brand and the
manufacturer they
wouldn't touch with a
10-feet poles

of

IMAGING: Atul Deshmukh, PHOTOGRAPH: Jiten Gandhi
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Total Cost of Ownership, TCO, you
must have surely run into this TLA
(Three Letter Acronym) on the Byzan-

tine streets of technology and consumerism.
It must have peddled its salient features to
you, likely that it pleaded with you to con-
sider it closely before buying a printer. Good
advice, listen to TCO before making that
decision. We would like to point out how-
ever, that the concept extends to more than
a printer, its cartridge and the number of
pages that it prints per minute.

Every time you struggle with your sound
card driver, or with your digital camera soft-
ware, you are wasting your time, wasting
your money. Consider the case of Vivek
Pannu, a computer engineer from Hissar in
Harayana, and his LG CD-Writer. Vivek, and

the drive in question, have a difference of
opinion—while Vivek wants the drive to
perform its civic duties, the recalcitrant
Writer disagrees. Thus he has to take his
drive to the nearest LG service centre, back
and forth, wasting both precious time and
money. “I was really humiliated by the serv-
ice centre,” he bemoans, “I burnt petrol
worth my CD-Writer.” TCO at its worst, he
had to pay an additional amount of money
just to get a piece of hardware working.

This is where the concept of Service and
Reliability steps in. How frequently does a
product break down? Does a company offer
good after-sales service? Where are its serv-
ice centres present? Does it have any call
centres? How helpful are its technical staff?
Did they solve your problem?… questions

to that effect need to be asked. These factors
determine the true worth of your purchase.
Is your MP3 player a good buy in the long
run, or is it a money drain forcing you to
spend hundreds on its battery every month? 

How do you measure something like
this? We decided to ask you, for surely there
can be no better public to ask than one that
buys and deals with technology on a daily
basis. The exercise was performed as a sur-
vey—asking the right questions and logging
the answers, the results were then fed into the
Digit Supercomputer (a bunch of diligent
geeks that live on numbers), and analysed for
ease of digestion. We present the results of
the survey: everything from cell phones to
desktop computers, how reliable is that prod-
uct you are planning to buy? Find out.

We first prepared a list of questions to help
crystallize reader experience with a particular
product. For example, queries to the nature of
“When did your product first break down?”,

along with “How many times did your prod-
uct need servicing or repair within a 2-year
period?”, helped us get a handle on the relia-
bility of a particular product; similarly ques-
tions were formed to gauge the quality of
after-sales support that a company offered.
The questionnaire was posted on our Web
site: www.thinkdigit.com. Readers were invited
to offer their feedback through two means: by
replying to an insert in Digit magazine, or as
an e-mail request to take the survey. Both the
methods were tagged with a unique numeri-
cal identifier. A respondent would log onto
the survey page using this number and once
logged off, the identifier would expire. This
ensured that there was no duplication in
responses.

The response sample was
2012, based on which a sta-
tistical analysis was done to
determine, amongst other things,
the Reliability and Service Index. To under-
stand the importance given to each question,
please see the accompanying pie-charts.

From the Reliability Index (RI) and the
Service Index (SI), an Overall Satisfaction
Grade (OSG) was generated for the categories
involved. The grade was meant to indicate
how a particular company fared overall: tak-
ing both reliability and service into considera-
tion, within a sub-category. To do so, the
indices in question were averaged with a
weightage in mind: both RI and SI were
awarded a 50-50 split up; there were a few
exceptions to this rule, which are duly noted
in the accompanying table. As an example
the hard disks were given a 70 per cent
importance on the matter of reliability (RI),
and a 30 per cent importance was given to

their Service
Index (SI) A com-
pany that scored
the highest OSG
was awarded 
the Digit Icon 
of Trust.

Finally, we
determined a
Mode for the
entire industry—
covering all cate-
gories—from cell phones to desktop comput-
ers. This mode figured as 4.5 for the
Reliability Index and 3.0 for the Service
Index. To put things into perspective, when
a sub-category earns an average mark of 4.0
on the Reliability Index, it would translate
into the fact that the particular sub-category
is well below the industry standard, as far as
reliability is concerned. As an example, the
digital camera sub-category (consisting of
companies ranging from Sony to Creative),
scored an overall Reliability Index of 4.54,
just above the industry (consisting of all sur-
veyed sub-categories from digital cameras to
notebook computers) standard of 4.5.

In each sub-category only those that
received over 5 per cent of the votes or 10
votes (whichever was higher), were considered
qualified for analysis. This cut-off was essential
to remove any generated bias due to a low
number of vote-count in that sub-category.

A certified survey
The research process was verified and certified by The
Research Pacific Group, which is headquartered in
Singapore and has presence all across the Asia-Pacific
region. The Research Pacific Group is a full service mar-
keting research provider, which has conducted research
throughout Asia for over 12 years; its core competency
is providing ‘Best In Class’ customised Marketing
Research solutions throughout Asia.

The Method behind the Numbers
Product RI SI
CD Writers 50 50
Cell Phones 60 40
Desktop 50 50
Digicam 50 50
Display 50 50
HDD 70 30
Laptop 60 40
MP3 Player 50 50
Printer 50 50
Scanner 50 50
Sound Card 50 50

Overall Satisfaction
Grade (OSG)
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Afew months ago, we discontinued
testing CD-ROM-only drives,
deciding to instead test CD-Writ-

ers and other so-called combo-drives.
With a CD-Writer priced at almost the
same price as a solitary read-only drive,
we reasoned that consumers would stop
purchasing the latter, and opt for combo-
drives and CD-Writers instead. Results of
the survey back that reasoning, as a
healthy 940 votes rang for CD-Writers.

Of the number, Samsung took the
biggest piece of the pie with a count of
404, while LG came in second with 233;
it was a race similar to the one fought on
the computer display front. Here, howev-
er, the base number of more than 900
ensured that Sony, HP, ASUS and BenQ
got more than five per cent of share.

ASUS came across as the most reliable
drive, and was top dog on the Reliability
Index, followed some distance away by
LG. Consumer satisfaction with technical
personnel in service centres, and with
repair or replacement of defective prod-

ucts earned LG the top-
spot. Samsung earned the
second rank in terms of
service, underscoring the
importance of good after-
sales support and service
centre coverage.

The most common
cause of customer woe was
mechanical problem with
the tray of a drive. Manu
Sekhri, a student from
Mumbai, pointed out,
“Acer should make the
product more reliable. The
Writer I have is two and
half years old, and although
it writes fine, the tray is not
working. I have to manual-

ly open and close the tray.” Similar
responses of “excellent writing quality but
poor build quality”, “I got tray problems”,
and “disk gets stuck while inserting” echo
for ASUS and Samsung as well. The lens is
also a problem area. While some brave
souls clean the lens by removing the cover
of their drive (and instantly voiding their
warranty in the process), others are forced
to replace their drives since a lens costs half
the price of the drive.

Sony came under fire from more than
one reader for its lacklustre after-sales sup-
port. Ravi Pherwani opined, “Sony is one
of the most trusted names in this indus-
try today, but it needs more efficient serv-
ice management”. Vidhu Bhushan, a pro-
fessor from Mumbai, complained, “The
distributors of Sony products show a lot of
indifference in dealing with the cus-
tomer.” Harsha, himself a technical sup-
port personnel says, “Sony India products
are sub-standard. Their imported products
are far better than the ones manufactured
here. It will be better if Sony can improve
the quality of products manufactured and
sold here.”

On the software front, there were
minor niggles concerning drivers and
some complaints on the choice of soft-
ware provided with the drives, with one
reader stating that he prefers Nero Burn-
ing ROM to the software supplied.

A very sensitive CD-drive! The tray is a
nightmare for everyone... gets misaligned...

“
“ Ashish, on his Samsung CD-Writer

New Delhi

Performance of

Acer/BenQ CD-Writer

drives was the Worst
in terms of consumer

Satisfaction

CD-Writers

MOST RELIABLE CD-WRITER: ASUS RUNNER-UP: LG Electronics
MOST SATISFACTORY SERVICE: LG Electronics RUNNER-UP: Samsung

Winner for CD-Writers is LG



41

features ■
■ service and reliability survey

JANUARY 2004

Cell phones have arrived. As a
reminder, an especially irritating
ring tone is probably calling to

attention all living beings even as you
read this; failing which, you are sure to
run into someone with a hands-free kit,
screaming right next to you in a crowd-
ed bus or train. Irritants at times, cell
phones can hardly be ignored as great
communication devices. With plum-
meting prices of both handsets and serv-
ices, these amazing pocket-monsters will
only proliferate.

Nokia’s stranglehold in this particular
segment is strong, and not entirely with-
out merit. Of the 920 responses generat-
ed, an amazing 520 went Nokia’s way. The
closest competitor, Samsung, got a paltry
134 mentions, while Sony Ericsson and
Motorola gathered 90 and 56 votes
respectively. Not a fair fight by any
means, and one that demanded that
Siemens, Panasonic and LG pack up and

look elsewhere for the five per cent cut-off
needed to be considered for the survey
analysis.

Nokia phones were owned the
longest, with Samsung a close second.
Samsung beat Nokia on reliability, by sta-
tistically scoring better on number of

repairs in a two-year period, and a
lower failure rate after purchase.
This pushed Nokia to second place,
followed by Motorola and Sony.

Nokia scored on service—
problems were resolved the quick-
est; the satisfaction level with its
technical personnel was the high-
est, as was the satisfaction with a
repaired or a replaced unit. Inter-
estingly, Sony Ericsson scored the
lowest in satisfaction with repair,
even though the company offers a
stand-by unit to a customer to tide
through the delay; something that
Nokia does not.

One reader, who wishes to be
unnamed, was not too happy with
Nokia’s services said, “It is very
expensive, they charge labour for
each component they replace…”,
while Sanmeet S Sahani was so put-
off by Nokia’s service that he went as

far as to say, “I have been a Nokia fan for
a long time, but after the service, I felt
that Nokia has gone to the dogs...”
Vidhu Bhushan, an associate professor,
shed further light on the source of dis-
satisfaction by claiming, “The technical
support staff lacks knowledge. It seems

as if they are equipped to
provide only superficial
answers, and not solve the
problem in anyway. Also,
these people do not know
the salient features of var-
ious models and try to
push either a very expen-
sive or an inexpensive
model towards the cus-
tomers.” Samsung was
also chided for its service
with this comment, “Sam-
sung’s service for comput-

ers is good, but for mobiles is very bad”,
while others pointed out that Samsung
phones lack features. One reader said
that the tie-up between Samsung and
Reliance (the former provides sets for the
latter’s CDMA service) isn’t making
things easier for getting the handset
repaired. Even Sony Ericsson took a
thrashing on its service front: Jatinder
Singh, a computer operator, thinks the
company “still lacks the professional
touch in India, especially in customer
relationship. It will cost them dear if the
situation is not addressed fast.”

The phone hung just like Windows; I had to
search for the three magic buttons, [Ctrl], [Alt]
and [Del]

““
Suneel Mohan, on his Sony Ericsson T105 phone

Karnod, Andhra Pradesh

Nokia earning the highest

on its Service Index can 

be traced to the fact that

consumers were especially

happy with the swift
manner in which it solved

problems

Cell Phones

MOST RELIABLE CELL PHONE: Samsung RUNNER-UP: Nokia
MOST SATISFACTORY SERVICE: Nokia RUNNER-UP: Samsung

Winner for cell phones is NOKIA
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Assembled or branded? The
supreme decision faced by anyone
while purchasing a personal com-

puter. It is as if the rest of our techno-
logical existence hinges on that one
choice, and perhaps it does. For, the right
path leads to product satisfaction, while
the other is a rocky trail to electronic
tribulation and support headache. Or is
it? Our consumer survey certainly helped
burst an old bubble that branded PCs are
the way to go if you require technical
support and after-sales product satisfac-
tion. Surprisingly, the popular assembled
PCs came up on top on both Reliability
and Service Indices.

The desktop PCs category attracted

812 votes, a majority of which (237)
went HP’s way, closely followed by
assembled computers tallying 194
mentions. Even if India has tradi-
tionally been a assembled-PC mar-
ket, branded PCs have made signif-
icant inroads. HCL came in at no. 3
with 117, and Zenith was fourth
with 75 votes. It must have been no
mean task going against the peer-to-
peer network that is the assembled
market in India. The initial surprise
of assembled units scoring on after-
sales satisfaction can also be attrib-
uted to this peer-to-peer network of
a friend, a colleague or a friend’s col-
league or a colleague’s friend, who
probably assembled your PC. 

Indeed, the community of assem-
blers has roots in both grey markets,
where they can source cheap parts (and
offer a warranty to boot), and an engi-
neering pool comprising recent gradu-
ates or diploma holders. The technical
and the spares support is thus very much
present. Add to this the fact that help is
just a phone call away, plus the knowl-
edge that the person on the other line
will be receptive (you, or someone you
know, probably knows the person), and
you have all the makings of an excellent
support group. Like Gaurav Lakshkar

points out, “Whenever I
take my problem to the
vendor he always wel-
comes me even after the
warranty period has
expired. He always helps
me in troubleshooting
the problem.”

Then there are the
traditional reasons for
opting for assembled
computers: Be it flexibil-

ity, “Assembled PCs are flexible, and I
can upgrade them easily;  affordability,
“I prefer assembled machines for their
affordability; the customisable configu-
ration and the “I would rather assemble
my PC myself” bragging rights. Some
respondents like Siddharth Deb Varman
from Bangalore cautioned against using
assembled systems. A student of man-
agement, Siddharth owns an assembled
PC. He says, “Though assembled systems
are cheaper and can be more person-
alised, the fly-by-night operators have
become the real bad apples in the cart,
and need to be rooted out.” He is refer-
ring, of course, to assemblers who are
here today and gone tomorrow. It is thus
essential to do business with known 
persons, who have a certain amount of
positive history and come with rec-
comendations.

As for branded systems, HP is doing
pretty good for itself. Its customers are
satisfied by both its service: “It’s a great

I would rather assemble my PC myself

“

“ V Vineeth Kumar, on assembled computers 

Maharashtra

Zenith was the quickest

in providing solu-
tions to their problems;

respondents were also the

most satisfied with tech-
nical personnel of

assembled computers

Desktop PCs

MOST RELIABLE DESKTOP COMPUTER: Assembled PCs RUNNER-UP: HP
MOST SATISFACTORY SERVICE: Tie between assembled and HCL PCs

RUNNER-UP: Tie between HCL and Zenith

Winners for desktop PCs are HP and ASSEMBLED  PCs
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Digital cameras are widely regarded
as one of the most reliable con-
sumer electronics products. When

the user interface consists mainly of point-
ing and shooting, and the mechanics
involve no moving parts, it is easy to
believe that notion. Furthermore, the
belief finds support from our survey.

To begin with, the space of digital cam-
eras saw the largest representation in the
form of companies—Sony, Kodak, Nikon,
Olympus and Creative were just a few of
the vendors represented here. This show-
cases an interesting point—that as far as
digital cameras are concerned, no single
company has an unshaken hold over the

market. Not surprisingly,
Sony garnered the most
votes, whereas Creative
ended up with the least
count—a reflection on
how photographers, both
professional and amateurs,
think in terms of brands.

But brand-strength
does not necessarily reflect
upon reliability or con-
sumer satisfaction. This
fact was showcased by the
fact that Nikon scored the
highest on both the Relia-

bility and Service Indices,
beating Sony by a whisker.
Never mind the fact that
98 per cent of Sony users
said that they will buy 
the product again as
opposed to 87 per cent of
Nikon users, who had a
similar view.

In terms of hardware, a

common problem plagued users across
brands—battery. This was either in terms
of a faulty battery, or a bemoaning a low
battery-life. The latter case being even
more prominent with users of cameras
with LCD screens. Some low-end solutions
from Logitech were censured for the slow
refresh rates of their CMOS lenses. On the
software front, drivers and companion
software were the cause of problems, “My
Logitech camera is nice, but I experience
problems with the software that they have
provided”, Sudhir, a student, pointed out.

After Nikon,

Logitech consumers

were the most satisfied

with their cameras;

customers of Creative
complained about lack of

after-sales support.

Olympus users

were the least satisfied

with their cameras

PC; they are really good at service”, and
with its network of service centres: “HP
has got best networks, as its quality of
service.” Does the higher cost of an HP
computer scare away customers? Not if
Qasim Zaidi, a software engineer from
New Delhi, has a say in it: “HP products

may be a bit expensive, but the after-
sales service more than makes up for it.”
HP computers also scored high on
reliability, beaten only by assembled
computers. They did take a beating on
the Service Index, mainly due to the fact
that customers were not very satisfied

by the technical aptitude of service
personnel—“the HP dealers should have
well qualified engineers”, pointed out
one respondent. HCL scored well in this
particular field, and shared the highest
Service Index along with assembled
computers.

Superb product, but eats a lot of battery
when the LCD is used

“

“
Priyanka Mukherjee, on her Olympus camera

Calcutta, West Bengal

MOST RELIABLE DIGITAL CAMERA: Nikon RUNNER-UP: Sony
MOST SATISFACTORY SERVICE: Nikon RUNNER-UP: Logitech

Digital Cameras Winner for digital cameras is NIKON
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As a window to everyday technol-
ogy, the display of a computer is
the most important aspect of user

comfort and satisfaction. Before making
the all-important choice on size and
technology, it would seem natural to
choose between the seven major manu-
facturers of computer displays in India.
However, our survey indicates that this
segment of the consumer IT market is
skewed heavily in favour of Samsung
and LG Electronics. Indeed, of the 800-
odd responses on displays, close to 500
were cast for Samsung, and more than
200 for LG. With such command over
the segment, other manufacturers—big
names at that—were pushed out of the
survey altogether, since each one failed

to capture more than 5 per cent of the
tally of 800.

Not too surprisingly, a monitor or an
LCD display comes across as one of the
more reliable devices in our survey. Bar-
ring catastrophic events, these sculp-
tures of molten glass and moulded plas-
tic have few inherent and potential nig-
gles. As one reader puts it, “Eight
months after from buying a Samsung
CRT, on the day of the Gujarat earth-
quake, my monitor fell from my desk,
and a large crack appeared on its picture
tube.” This is where service comes to the
fore—either as a saviour or as a wedge
between a customer and a company.
Fortunately for those involved, this par-
ticular case was handled with grace:
“Samsung replaced the picture tube
within two weeks. The monitor is now
working well.” Another satisfied cus-
tomer of Samsung had this to say about
the hassles of maintenance and service
of his monitor: “No problem, like in that
Suzuki Samurai ad!”

LG also earns equal praises for its
“good servicing network”. So are things
all OK as far as displays are concerned?
You’d think so, but not quite. “Samsung
monitors are good in general, and deliv-
er excellent value for money. Service is
prompt, but not always satisfactory,”
opines Ankit Agarwal, an engineer by

profession. To learn why
certain customers are dis-
satisfied with Samsung’s
service, take the case of
one N.P. Singh, also an
engineer. “I have a 
Samsung Syncmaster
750DF that flickers con-
tinuously. After trying 
to reach their support
engineer several times, 
he came one evening. He
saw the monitor and
without any test, he said

that the frequency of electric current is
low, which is why the device is flicker-
ing… and left! My monitor still flickers!”
A flickering display, or washed out
colours are two of the more frequent
complains that we registered through
our survey for displays. While these
problems can be traced back to a faulty
power line or an ageing display card, the
essence of service is satisfaction, and our
readers feel that a company should sat-
isfactorily handle a complaint; even if
the solution entails asking the customer
to repair the power line or replace the
video card.

Another frequent complaint is that
of the geographical distribution of serv-
ice centres. Most service centres, as one
can imagine, are located in the major
metro cities and surrounding satellite
towns. A customer not within the
blessed area has to haul him or herself
considerable distances, faulty equip-
ment in tow. One of our readers in
Gujarat had “to travel 50 km to the near-
est service centre to repair my 19-inch
monitor. It took a greater part of three
hours, having suffered travelling with
poultry.” Needless to say, such cases

Samsung’s service 

personnel were the

quickest of the lot to

resolve problems, and gar-

nered the highest
score on technical sup-

port satisfaction

Displays Winner for computer displays is SAMSUNG

All I can say is ‘no problem’, like in that
Suzuki Samurai ad

“

“ Garavjeet Dhillon, on his Samsung monitor

Chandigarh, Punjab
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leave a bad impression on customers.
Additional fallout of the distance prob-
lem is that of finding good service per-
sonnel in remote locations. Sometimes,
the hired engineers are not experienced
enough to handle problems, “For LG
monitors, we had a service centre at
Guntur, Andhra Pradesh, but they do
not service well. They take a month’s

time to service a monitor,” complains
Philip George, a computer programmer.
He goes on to plead: “Please provide the
service centres with personnel who
know their job well.”

Apart from these niggles, there are

requests for better software drivers—be
it for alternative operating systems
(especially Linux), or for avenues of
entertainment and education (“display
drivers should be advanced for gamers
and Internet browsers”).

The mirror-smooth, dust-free
disc travels at a speed of
around 272 Kph. Not far, at a

distance of 0.3 micronmeter—a
typical human hair is 57 times as
thick—flies an aluminium arm,
moving from the centre of the
glass-like surface to its hub up to
50 times per second. Want an anal-
ogy? Imagine a Boeing 747 airplane six
inches above the ground. Behold the
hard disk, a marvel of small-scale
mechanics, nestling within your com-
puter, laptop or MP3 player. 

For us consumers, such numbers
mean little. The marvel is lost with a
crash or a bad sector; all that data gone!
Not surprisingly, our reader feedback per-
taining to this particular category evoked
a lot of frustration, obviously... Data loss
is never appreciated. Within this seg-
ment, two players emerged leaders—

Samsung and Seagate. Of the total 1,202
votes on hard disks, Samsung bagged 508
and Seagate 631, leaving others with less
than five per cent of votes and forcing
us to nudge them out of the survey
analysis. Of the two, Samsung emerged
the better choice, earning higher num-
bers for both customer satisfaction with
its service, and for the reliability of its
hard disk. 

One of the most
important factors in Sam-
sung’s favour is the war-
ranty period it offers on its
hard disks: all three years
worth of it, as opposed to
Seagate’s one-year period.
Time and again, readers
pointed this out as a
favourable number, secure
in the fact that their data is
as safe as it can be for at

Hard Disks

Hard disks are extremely sensitive to
shock (approximately 30 per cent of hard
disk failure is shock-induced). Hard disks
without a home (a PC, for example), are
very vulnerable as they are exposed to
external shocks—as many as several hun-
dred G-force per millisecond—incurred
by mishandling, installation, etc. As the
storage capacity of a hard disk’s platters
increases, so does the likelihood of colli-
sion between the disk and head, since
they come closer with an increase in
capacity. Even the slightest of shock is
capable of damaging a hard disk: small
shocks may travel to the core and cause 
a head slap (where the head of a hard
disk, physically hits the platter’s surface).
When this collision occurs, particles form
on the disc’s surface and accumulate with
time, creating friction with the head, thus
increasing the temperature of the disc.
This increased heat causes read and 
write errors, formation of bad sectors
and data loss.

Cause of Bad Sectors

Seagate’s after-sales service is very bad.
Also it [hard disk] gives lots of problems

“

“
Deepak, on Seagate hard disks

Ambala, Haryana

MOST RELIABLE DISPLAYS: Samsung RUNNER-UP: LG Electronics 
MOST SATISFACTORY SERVICE: Samsung RUNNER-UP: LG Electronics

Winner for hard disks is SAMSUNG
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least three years. As Hitesh Gupta, a stu-
dent using both Samsung and Seagate
hard disks pointed out, “There seems to
be a generic problem with the Samsung
hard disk developing bad sectors. How-
ever, the three-year warranty provides a

good platform.” Seagate was held back
on this front with complaints of “One-
year warranty not a sufficient time peri-
od”, or “product is good, but not enough
warranty”. As one Devinder Singh
echoes, “A three-year warranty given by
a company assures reliability of its prod-
uct. A consumer then looks for a quali-
ty product instead of seeking after-pur-
chase services from the company.”

Our readers also expressed dissatis-
faction with the after-sales service offered
by Seagate, once the warranty expires. As
Prakash Dugar, a chartered accountant,

claims, “Beyond the warranty period of
one year, Seagate provides no service sup-
port, one has to simply throw away the
product and buy a new one.” A charge
supported by Pratima Sawe a computer
consultant: “When the hard disk stops
working after the warranty period
expires, Seagate refuses to give repair sup-
port. The company should undertake
repairs and charge for it.” Samsung is not
without sin in this regard as one particu-
lar reader pointed out that “Whenever I
call a service centre, they tell me to call
after 10 to 15 days”.

A Seagate hard disk

was owned longer than a

Samsung, and needed a

greater amount of servicing

in a two-year period

The woe of most desktop comput-
ers users is the fact that the tool
of their trade and enetertainment

is no symbol of reliability. Its portable
counter-part—the laptop—can be safely
considered a bonsai version of the desk-
top behemoths. Logically thus, one
could surmise that laptops would also
suffer the family curse of mal-reliance
and instability. However, we learned,
with humility, that one can only stretch
logic this far, before it comes snapping

back, reality in tow. 
Based on our consumer survey,

we found that laptops did pretty well
indeed, both in terms of reliability
and overall service. A part of this
could be because only 170 responses
were logged for this section; only
MP3 players had smaller representa-
tion. Nevertheless, everyone respond-
ing was pretty happy with their pur-
chases—solutions from HP, Dell, IBM
and Toshiba—in terms of perform-

ance of their machines, their reliability
and the after-sales support provided by
their manufacturers. 

Arvind Krishnan, who would only
identify himself as an administrator, was
particularly upbeat about his Dell lap-
top, pointing out that they offer, “very
good after-sales service. A faulty part was
replaced within 24 hours, even though
the part had to come over from Banga-
lore.” Jyoti Chakravartty supports his
case and Dell’s by saying, “The service
was prompt and the person from Dell
was really friendly.” With similar
responses across the board, it came as lit-

tle surprise when the manuacturer Dell
scored the highest on our Service Index
for laptops.

A surprise was, however, sprung by
Toshiba: this particular company seems
to enjoy a good rapport with its laptop
users. One particular IT professional was

Dell’s technical staff
came up on top,
whereas HP’s did 
the worst.Respondents
were most satisfied
with IBM when it came
to repair or replace-
ment of their unit

Laptops

MOST RELIABLE HARD DISKS: Samsung RUNNER-UP: Seagate
MOST SATISFACTORY SERVICE: Samsung RUNNER-UP: Seagate

Winner for laptops is TOSHIBA

What I am really impressed by is the speed
at which these buggers work

“

“
Hiten Sampat, on his IBM laptop

Mumbai, Maharashtra
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so impressed with his
Toshiba laptop that he
helped procure four more
machines within a span
of three months for his
company. 

The much applauded
Toshiba was not without
its share of problems—
Alec Pinto, who works as
a technical support per-
son says, “The screen of
my laptop stopped

responding. I believe this is a standard
problem with the Satellite Pro 6100
model. Toshiba repaired it on an inter-
national warranty.” 

Toshiba however topped the charts
with the highest score on laptop relia-
bility, IBM coming in at a close second.
HP disappointed its customers on both
counts, the reliability of its laptops and
the customer satisfaction of its particu-
lar products; scoring the lowest on both
counts and bringing up the rear in this
4-player race.

‘It’s a Sony’. As a systems engineer
pointed out, “the name says it all”,
a fact borne out by the results of

our survey for the category of MP3 play-
ers. While the segment saw votes for
Sony, Creative, Samsung, Philips and Mer-
cury, among others; the percentage of

votes gathered by Sony, Samsung and
Philips pushed everyone else out of the
ring and out of the reckoning. 

At a count of 142, the total votes
filed for MP3 players were lower than

that of any segment. Of which, Sony
picked up a healthy 31, while both Sam-
sung and Philips took 20 apiece.

That the name Sony com-
mands respect in the market of
consumer electronics was
highlighted by feedback such

as “Sony is the
best, always”,
“…good per-
formance” and
even “I trust
Sony, though
their support is
awful.” Indeed it
was pointed out

that Sony India is offering a less
than stellar service to its consumers
and that it mend its ways. Perhaps this
is why Sony scored the lowest when it
came to quick problem solving. Philips

beat Sony as its technical
team was perceived to be
better. Hence, there was
greater satisfaction with
Philips' repaired or
replaced products. Philips
took away the crown as

According to our survey, a

Philips MP3 player

required the least amount of

servicing in a two-year
period, followed by

Samsung, which was

also owned the longest

The best piece that one can own.
Superb performance, no maintenance and 
good service

““
Pratik Dutt, on his Philips MP3 player

Vapi, Gujarat

MOST RELIABLE LAPTOP: Toshiba RUNNER-UP:IBM
MOST SATISFACTORY SERVICE: Dell RUNNER-UP: IBM

MP3 Players Winner for MP3 players is PHILIPS
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far as product satisfaction was con-
cerned. Sony scraped the bottom of the
barrel, but it scored the highest per-
centile points, with 94 per cent of
respondents saying that they will buy a
Sony product again. Apart from mind-

share the company also
earned top marks in the
Reliability Index beating
out Samsung and Philips
by a decent margin (the
latter two had a close
fight, with Samsung edg-

ing out Philips. 
Samsung was criticised for its low-

quality solutions by more than one

reader saying,“audio output quality not
so good” and “the product is not up to
the claim of the manufacturer, the serv-
ice is absolutely nil.” Suneel Mohan, a
Yepp player user, claimed that “Yepp
jumps audio tracks sometimes… when I
asked the service station personnel they
said that it's a common problem and
that a replacement would take at least
three months.”

The sheer number of HP service cen-
tre is legion. Theoretically, their
reach should address even the most

remote Indian. Unfortunately, given the
size and the diversity of the Indian market,
it is not uncommon to run across cases like
that of Suvidha Agarwal who says,“HP
offers good reliable products, but it should
open service centres in places like Kashipur
in Uttaranchal.” Suvidha further states that

she has to go to local vendors to get her
problems solved.

While HP certainly commands a huge
market share of printers and scanners, it
loses out to Canon in both these seg-
ments on the basis of both product relia-
bility and service. Printers got a whooping
1006 votes in our survey, and HP bit off
638 of that number. Canon came in a dis-

tant third with 80; far behind Epson with
187, but nevertheless impressed users so
much that it walked away the winner. The
results and setup were similarly reflected
in the scanner category.

One reason for the positive feedback
for Canon can be traced to its warranty
service. It is the only company, along-
side Lexmark, which offers an on-site
printer replacement. Customers
really appreciate not having
to lug their printers all
the way to a central
service station in
case some-
thing goes
wrong; an
appreciation that
shines through in our
survey. “The service was
superb,” says Priyankar Mukherjee,
an IT professional, “I called for service and
they came within two hours.” Ameya, a
student changed brands and is happy

with his decision, “I used Epson prior to
Canon, and was disappointed! No service
at all.” Another satisfied customer,
Sethukumar S, a government employee,
said that he “never faced any problem.
The Canon printer is doing well.”

A common grouse of consumers was
the high cost associated with new car-
tridges, many a respondent suggested

lowering their prices, as an HP user, Vid-
hyadhish Desai, a hardware technician
from Mumbai, put it, “Great printers!
Only the prices for cartridges should be
lowered.” The cost of cartridges sees con-
sumers go in for refilling, something that
Kreisler Drego advises against: “HP print-

Printers

Respondents owned

Epson printers for 

the longest time and

required the least amount 

of servicing in a two-
year period

MOST RELIABLE MP3 PLAYER: Sony RUNNER-UP: Samsung
MOST SATISFACTORY SERVICE: Philips RUNNER-UP: Samsung

Winner for printers is CANON

Great company, great product

“

“ Siddharth Shah, on his Canon printer

Valsad, Gujarat
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ers work well as long as
the print cartridge used is
genuine, and not refilled.
When the cartridge is
refilled, the printer goes
kaput!” He goes on to
point that “HP very clear-
ly states that refills are not
tolerated by their print-
er—using genuine car-
tridges, my printer is now
in its seventh year.” One

particular user of an Epson printer,
Sameer Bhargava from New Delhi,
opines that “it is good that third-party
ink cartridges are available which lowers
the running cost.” Alongside cost of car-
tridges, drying up of ink is also a source
of worry for most users. As Jayesh
Mehta, a businessman from Mumbai
points out, using his Canon printer as
an example, “There is a major problem
of cartridges drying up, if the printer is
not in continuous use.”

Not so long ago, a printer and a
scanner were considered expen-
sive accessories to a computer.

Over time, however, reduction in prices
have brought them within the easy reach
of one-and-all, and both these devices
find greater usage in homes and offices.

So much so that, one can now opt for an
all-in-one device at the same price a
printer or a scanner would have com-
manded a few months back.

The devices are so interlinked that
their manufacturers make appearances
under both the categories, you will find
that HP is as synonymous to scanning or
printing as Xerox is to copiers. HP com-
mands the largest chunk of votes under

this category, followed by UMAX and
Canon. With their large number of serv-
ice centres strewn all over India, “Service
most widely and promptly available”, is
a common chant amongst users of HP.
HP customers, therefore, are generally
happy with their products. 

However, HP’s technical support is
not as good as Canon’s : with feed-
back such as “Very little help from the
technical persons”, Canon steals the car-
pet from under HP when it comes to
service. Indeed, praise for Canon is ubiq-
uitous with hardly a negative comment
in its name. From “Very handy and good
scanner”, “very good for home usage”,
“best scanner”, “Canon has kept its
mark”, to “best company for scanners”,
Canon seems to have captured the hearts
of its customers. 

One of the reasons for such a stellar
showing could be alluded to the fact that

Canon has an on-site replacement war-
ranty—you do not have to leave your
home or office in case something goes
wrong with your scanner. Canon does
equally well as a reliable scanner. It wins
the highest score for both the Reliability
and the Service Indices.

Umax scanners got quite a beating—
everything from bad-quality scans to bad
service to faulty lamps were placed on

this company’s doorstep. Anish Gangar,
an online content writer complained
that “My UMAX 3400U scanner started
giving problems within a year, and is still
lying dead on my computer table. UMAX
is the worst company, and I do not rec-
ommend my friends or colleagues to go
in for UMAX products.” 

Jaideep Khanduja an IT professional
claims that his UMAX 2000 scans even a
white page with a green background.
Pratima Sawe, a computer consultant
from Mumbai, was asked to replace

Scanners

Customers of Canon
recorded the most satisfac-

tion with repaired or

replaced scanner, were

most happy with the techni-

cal support offered and their

problems were solved
the quickest

A product worth the money

“

“ Nikhil Kumar Desai,  on his Canon scanner

Hyderabad, Andhra Pradesh

MOST RELIABLE PRINTER: Canon RUNNER-UP: HP
MOST SATISFACTORY SERVICE: Canon RUNNER-UP: HP

Winner for scanners is CANON
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rather than repair her
UMAX scanner, she says,
“Its light needed to be
changed and the service
centre said it would be
less expensive to give it up
and buy a newer USB
scanner.” Nikhil Joshi a
multimedia co-ordinator,
says, “No and never to
UMAX even if it is offered
free. Worst company,
worst product and horri-
ble service support.”

Small surprise that UMAX scored the
lowest on the Reliability Index in our
consumer survey.

The quality of glass used in BenQ
scanners was a source of complaint.
Kreisler Drego mentioned that, “the
glass used in the BenQ scanners are of a
very poor quality making it difficult for
the cathode lamp to shed light on the
image being scanned. Each service was
worse than the previous, especially as far
as replacement of the glass was con-
cerned.” BenQ scored the lowest on the
Service Index.

As a company, Creative equals sound
cards. Its products have engineered
sound on the PC right from the

days of the mono-coloured DOS prompt,
up to the kaleidoscopic million-coloured
screens of today. And in keeping up with
the big-bang in colours, the company has
enabled an explosion in sound from the
mono-channels of bygone to the 7-chan-
nel band that plays on a PC near you.
Remember however, a shadier aspect of
those days— the hunt for the right driver,
the tweaking with the DMAs and the
IRQs, the fiddling with those tiny jumpers
to get the little buggers to sing a song of
16-bit. A walk through this section should

bring those memories rushing back.
Things are not the same of course, but
users are humming a familiar tune of soft-
ware woes, driver problems and hardware
conflicts…

To begin with, the survey confirmed
the absolute dominance of Creative
products in the field of soundcards. Of a
healthy 296 that responded under this
category, an overwhelming 225 had Cre-
ative solutions nestled within their sys-
tems. Yamaha came a distant second
with 40, while Intel huffed and puffed
with only 19 entries. Yamaha cards were,
not surprisingly, the oldest of the bunch,
followed by Creative. Note that Intel
here represents the onboard solution

found on motherboards, not a stand-
alone card. With that in mind, it comes
as no surprise to find Intel solutions
requiring the least service within a two-
year period. Yamaha cards did not fare
too well in this aspect, coming in at the
third place by quite a margin.

Creative scored highly on the Relia-
bility Index, a fact corroborated by read-
ers such as long-time user Prosenjit Sarkar
from Kolkatta, “My old PC has a Creative
Sound Blaster Live, and it has been run-
ning for over seven years now. I have a
very high opinion of Creative products

when it comes to sound cards...” Creative
won as far as reliability of products was
concerned, but niggling hardware prob-
lems experience by a percentage of
respondents, along with the fact that the
problem was seldom unsolved, meant
that the company scored the lowest in
service. So Yamaha came in second and
Intel stole the top.

Hardware compatibility problems,
ranging from “compatibility issues with
my new MSI KT6 Delta motherboard and
Pinnacle Studio 8 software”, to, “it inter-
feres with the TV reception if I have a TV-
tuner card on the motherboard”, coupled
with driver woes “they should get some
real coders to make their drivers, their

Bhagwan in the field

“

“ Rahul Mundra, on Creative sound cards

Gujarat

Sound Cards

Intel solutions were not

only reliable, problems

related to them were also

solved the most quickly

MOST RELIABLE SCANNER: Canon RUNNER-UP: HP
MOST SATISFACTORY SERVICE: Canon RUNNER-UP: HP 

Winner for sound cards is INTEL
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drivers are a frigging
joke”; led some people to
declare rather unflattering
things about Creative’s
offerings. One Dinesh
Goyal, a businessman is
especially vitriolic, “I feel
like a fool having spent so
much money for a piece of
s***!” Meanwhile, a reader
in Chennai, Prakash

Dugar, a chartered accountant, wonders
if he will ever get support for Creative’s
products in his state. While Yamaha
comes across as a more stable solution
(keeping in mind its share of votes), it
too faces driver problems, especially
under newer operating systems: “per-
formance is satisfactory, but the Web site
does not have drivers for all products
under Windows XP,” complains
Abhishek Malhotra, from New Delhi.

The survey threw up some interesting
numbers. Take desktop computers: the

segment charted a Reliability Index of 3.63,
the lowest across all categories, as opposed
to the industry standard of 4.50. It repeat-
ed the offence under the Service Index as
well, which transforms this product cate-
gory into the most-troublesome device in
the industry. This is quite a disappointing
showing, considering that a PC is the pri-
mary means of work, communication and
is an industry driver. Little wonder that cor-
porations spend more on servicing and
maintenance of their systems than on pro-
curement of the same. Initiatives such as
the grid-enabled Autonomic Computing—
wherein the mantra of self-healing, self-
aware, self-protecting, self-configuring and
self-optimising computers is repeatedly
chanted with the hope of attaining com-
puting nirvana—promise hope but only
time will tell if they will deliver. 

Another point to note is that products
which did not score well on the Reliabili-

ty and Service Index had
very positive perceptions in
the minds of consumers.
This dichotomy between
fact and perception can be
traced to the strength of the
particular brand. Sony, for
example, seems to be espe-
cially blessed in this regard.
With comments such as
“The name says it all,” Sony
is sitting pretty in the mind-
space of consumers. For dig-
ital cameras, 98 per cent of
respondents claimed that
they would buy a Sony
again, note however that in that category,
Nikon did the best in both the Reliability
and the Service Index (87 per cent of the
169 respondents would buy a Nikon
again). Is a Nikon owner wondering
whether a different company would offer
him or her, a better product or a better
service? A case of the grass is greener on

the other side or of branding, or both?
Support and service, both technical

and personal, are important facets of a pur-
chase. We hope this survey has served its
purpose of throwing light on the after-sale
corner of technology. 

AHMED SHAIKH

ahmed_shaikh@thinkdigit.com

Final Thoughts

MOST TROU-
BLESOME

DEVICE :
Desktop

computer 
MOST TROU-

BLE-FREE

DEVICE:
Sound
Card

MOST RELIABLE SOUND CARD: Creative RUNNER-UP: Yamaha
MOST RELIABLE SERVICE: Intel RUNNER-UP Yamaha
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At your service

The following images present a behind-the-scenes look at the workings of a call centre. 
Images are courtesy of Lexmark International (India) Ltd

A caller (a) was put on hold for 42 seconds (b), after which
he or she abandoned the call

A caller (c) was put on hold for 38 seconds, after which the
call was taken by the service centre personnel (d)

There were a total of six calls in this time interval (a), which
were handled by three technical personnel (b), while three more

were available to take additional calls (c). The average time a
customer had to hold the line was 10 seconds (d), while a call

was cleared in a little over 3 minutes on average (e). All calls
were answered, translating into a Service Level of 100 per cent.

Customer information (a), the problem itself (b) and the
warranty detail is some of the information LexExpress tracks
to help connect a customer's query to service personnel. A
service centre (in each of the cities covered) can log on to
such a Web site to take up and solve customer complaints

c

a b

d

a

a

b

bd e c

We chatted with ASUS, Lexmark, Epson and
Philips to find out what they’re offering in
terms of after-sales service and assistance.

What initiatives have you taken in the
service space?
ASUS: Currently, our distributors provide
services. As vendors we support our distribu-
tors in terms of providing spares, training
and education, equipments facilities and reg-
ular monitoring by our HQ - Taiwan team
LEXMARK: We have LexExpress, a door-to-
door replacement service. Across major
cities, Lexmark’s service engineers personally
visit a client and try and solve the problem. If
the problem is not resolved in that one visit,
a replacement unit is provided. LexExpress is
a free service under the warranty period.
EPSON: We have increased the frequency of
refresher trainings, and increased the num-
ber of warehouses to reduce the transporta-
tion TAT (turn-around-time).

PHILIPS: We are the first company to intro-
duce a swap warranty for monitors, which
effectively means almost zero downtime.
Moreover, we have a commitment to repair
or replace a monitor within 24 hrs. Further,
we are in the process of setting up exclusive
IT service personnel in all major cities. 

Do your service centres cover all the
major regions in India?
ASUS: Yes, more than 30 cities are covered
through our distributor network
LEXMARK: Yes, we have 55 service centres
in 51 cities
EPSON: Yes, presently we have 151 service
centres, spread across 75 Cities
PHILIPS: Yes, we have 196 Authorised Ser-
vice Providers (ASPs) and 18 branches

What are the technical qualifications of
the personnel that work in your service
centres?

ASUS: The company headquarters at Taiwan
conducts training sessions, and provides sup-
port in terms of equipments and spares.
ASUS engineers from Taiwan also visit fre-
quently to monitor the progress.
LEXMARK: Diploma Engineers or ITI (Indian
Technical Institute) qualified
EPSON: Diploma Engineers or ITIs
PHILIPS: All service engineers are
Graduates engineers and have assistants
under them

On an average, how quickly is a techni-
cal/support query resolved by your call
centre personnel?
LEXMARK: Statistics show that 40 per cent
of the complaints are resolved over phone.
EPSON: Within 5 Minutes, and in case it
cannot be resolved, it is forwarded to the
technical support group
PHILIPS: Over the phone, else on the visit
within 24 hrs

RBrand

Sony
Nikon
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To ensure that our readers have all the infor-
mation they need to make an informed buy-
ing decision, reviewers at the Digit Test Cen-

tre conduct comprehensive tests to evaluate the lat-
est hardware, software and technology services in
accordance with international standard evaluation
processes and methodologies. 

Our test results may be presented either as
Comparison Tests, or as individual reviews in the
Bazaar section. The representation of the results is
different for each in the interests of clarity, but the
test process for both is identical in all respects. 

Of all the products we test, only the best make
it to the A-List.

Comparison Tests
In the comparison tests, we compare the perform-
ance of products within a particular category. Each
product is evaluated under different parameters
such as performance, value for money, features,
ergonomics, etc. 

Weightages are then applied to the various test
parameters according to their importance for that
particular category of products. These weightages
are then used to arrive at scores for features,
ergonomics and performance for each individual
product. A detailed test process is included with
each comparison test, and explains the parameters
that were taken into consideration, along with
weightage allocation and reasons for the same.

In Bazaar
The evaluation of products in Bazaar also covers the
same parameters such as performance, ease of use,
value for money, build quality and features of the
product. 

Here, each of these parameters is rated on a
scale of 5, which is represented by arrows (->). 

The greater the number of arrows, the better
the product. This simple five-point rating system is
designed to give you an easy-to-interpret assess-
ment of a product. For example, a product that

receives a value for money score of five arrows 
signifies an outstanding buy. 

The Awards
Digit awards outstanding products by selecting 
a Best Performance and Best Value winner in 
each comparison test. The winner of the Best 
Performance Award will be the product that scored
the highest in the performance segment combined
with rest of the package including features,
ergonomics, bundled accessories etc. This award
represents the best performing product in our tests
in terms of the complete package that is offered to
a customer. The winner of the Best Value Award will
be the product that scores the highest in our value
for money parameter which is derived taking into
account the ratio of a product's ergonomics, per-
formance and features to its price. The product
winning this award offers a good combination of
performance and features at a great price. Since
value for money takes into account all scores for all
parameters including the price, this score will be
used to arrive at a grade (e.g. A+) for each product.

How we Test
It looks good and the technology is glitzy, but does it do the job?

Excellent: A brilliant combination of price, performance and features—far beyond 
expectations
Good: A good buy, better than most products in its category
Average: Reasonably competent but nothing spectacular about the product
Mediocre: Does not live up to expectations, needs improvement in many areas
Poor: has serious drawbacks and needs improvement before it can be used for its target
application

The 5-point Rating System used in Bazaar
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21 laptops vie for for space on your lap, to make sure

you know exactly what to buy, depending on your

budget and your needs. Read on to find that perfect

mobile mate
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Laptops were assessed on four main parameters—features, per-
formance, usability and package content. Their weightages varied
from one category to another. The features weightage remained
constant at 35 per cent across all categories, but as each category
has different requirements, each individual feature had varied
weightage across categories.

We used Windows XP as the standard operating system. Each
laptop was formatted, and a fresh copy of Windows XP profession-
al was installed. After the installation, all the latest drivers were
loaded, without any manufacturer provided tools or customised
software. All Tablet PCs were tested on Windows XP Tablet edition.
For the temperature test, we used a thermistor-based thermometer
to note the temperatures. The ambient temperature was kept con-
stant at 26 degrees Celsius, before commencing the test. The lap-
tops were weighed on an electronic scale for accurate weight
measurement.

Features
Features are of key importance to laptops, as they act as the sole
differentiators between models. Physical features were not consid-
ered under this parameter, but were assessed under usability. We
noted various features such as the type of RAM, hard disk capacity
and speed, type of optical drive provided, types of ports, connec-
tivity options, etc. Each of these was then scored according to the
importance they played in the category the laptop was placed in.
Processor speeds and amount of memory were not given any
weightage as the extra speeds should be reflected in the perform-
ance tests. 

Usability
A laptop’s usability is evaluated on the basis of how simple or diffi-
cult it is to handle in day to day life—whether it has shortcut keys,
its weight, etc. We also subjectively weighed the build-quality—
three different people were asked to rate the build quality on a
scale of five, and the average was calculated. A similar exercise was
used to rate the overall ergonomics of the laptop.

To assess the speaker quality, we played music files that encom-
passed the complete audio frequency range. Based on the per-
ceived output, we rated them on a scale of one to five. Since lap-
tops are mobile work companions, it is essential to log the maxi-
mum heat dissipated by them. We ran a movie for 20 minutes to

simulate the high activity scenario, and noted the temperature on
the under belly of the laptop. 

Package contents
We noted whether the vendor provided the operating system with
the laptop; whether they bundle a recovery CD, users manual and
driver CDs. We also noted the extra software provided, and the
accessories—power adapter, carry case, etc.—bundled along.  

Performance
To gauge the performance of each laptop, we ran a battery of tests
to evaluate each individual sub-system. The following benchmark-
ing suites were used to test the laptops:
Si Soft Sandra 2003 professional: This benchmarking suite was
used to evaluate CPU, memory and hard disk performances. The
CPU benchmark gives us the arithmetic and multimedia scores for
a particular CPU. The hard disk benchmark yields sequential read,
sequential write, random read and random write speeds of a hard
disk, as well as an estimated access time. 
Ziff Davis Business Winstone 2002: ZD bench’s Business Winstone
offers an excellent way of evaluating the complete system perform-
ance, and returns a unified score that is an aggregate of the indi-
vidual tests—the higher the score, the better the system perform-
ance. This benchmark suits the purpose because it tests a system
using applications that are used on a daily basis; it simulates real
world usage to arrive at the final score, which reflects how the sys-
tem will fare under real life loads.
Video Encoding: We encoded a 50 MB video file using Virtual Dub
to convert an MPEG file to DIVX. The codec used for compression
was DIVX 4. The time taken to compress the file was noted—the
faster the CPU and memory subsystem, the faster the encoding of
the file.
Quake III: Arena and 3D Mark 2001 SE: As most of these systems
come with low-end graphics adapters, using heavy graphic bench-
marking tools doesn’t make much sense. We relied on Quake III:
Arena to test the graphics performance, and logged the frame
rates at different settings. We also used 3Dmark 2001 SE to further
assess the graphics capabilities.
MobileMark 2002: We used MobileMark to evaluate the battery
life, which simulates real world usage. It drains the battery from
100 per cent until the system cannot handle the load anymore,

How We Tested

R
ecently, an organisation was in the news for offering
notebooks to a majority of their employees. While to
most people, this may seem like another example of
corporate indulgence, there is infact, calculated eco-
nomics behind the move. A normal office PC costs

anywhere around Rs 35,000, whereas an entry-level laptop costs
at least twice as much. By giving the employee, the employer
is assured of work being done anywhere—be it in transit or at
home—beyond the normal working hours. The place simply
doesn’t matter. As long as the employee has the device with
him or her, he or she will work. On the other hand, deploy-
ment costs in terms of networking are reduced, and less desk
space is used. Recently, many Indian business schools made it
mandatory for their students to have a laptop before they enrol
themselves for the course.

The world is going mobile in the true sense. Despite the

availability of laptops, the acceptance rate in India is far less as
compared to the West or, for that matter, our neighbouring
Eastern countries. The recent move by many established inter-
national vendors such as IBM, Acer and HP to provide entry-
level laptops below Rs 50,000 will further increase the growth
in this segment.

Coming back to our comparison tests, we did our best to
cover as many products from different vendors. Reputed inter-
national brands such as IBM, HP Compaq, Toshiba, Fujitsu and
Acer took part in the comparison. We also included many Indi-
an-based manufactures such as ACi, Micro-D, BP—with its dis-
tinct looking models—and the newly launched PnP. We
managed to get one laptop from Wipro’s peripheral division,
and of course, Zenith. Dell only managed to send in one lap-
top, the Inspiron 1100. We did not include Sony’s VAIO range
since it did not have any authorised Indian vendor.
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The ACi Ethos4 is targeted
solely at those in need of a
decent performing laptop

at an affordable price. It has a
Pentium4 M 1.8 GHz, 256 MB of
DDR RAM, a 40 GB hard drive, a
CD-ROM drive, a 14-inch LCD
display and a SiS 650 graphics
chipset. Also provided are two
USB ports, a parallel port and
one Firewire port. 

Excessive use of dull plas-
tic elements coupled with a
dated design gives it a boring
character. The keyboard layout is cramped, but the keys provide
good tactile feedback. The touchpad is sensitive and accurate, but
the entrenched buttons should have been raised a little. The
speakers are placed near the palm rest, thus affecting the sound
quality. The top lid is locked at both ends, and needs a single slid-
er to open.

Ethos4 had the lowest performance scores in this category.
The memory scores were below par, indicating the bottleneck in
the memory subsection. The hard disk also returned below aver-
age scores. As a result, its overall system performance plummet-
ed—it returned just 19 units in the Business Winstone test. This
means that opening multiple Excel sheets, Word documents
and Outlook simultaneously will stress the system. Ethos4
logged an average temperature of about 38 degrees, doing bet-
ter than its other ACi counterpart.

Ethos4 is a good option for those on a shoestring budget.
If you can spend Rs 15,000 rupees more, then the nx9005 is a
better choice with its elegant business look and decent per-
formance.

ACi Ethos4
Run of the mill

Despite a Centrino plat-
form, the ACi Optima
landed with the main-

stream laptops due to its weight
and dimensions. 

The Optima comes with
the Pentium M 1.7 GHz, 512
MB of DDR RAM, a 15-inch
LCD screen and a 60 GB hard
disk. It was the only laptop
that had a DVD-RW. It has
three USB ports and one
Firewire port; wireless
capability is offered via an Intel wireless card. All this brings its
weight to 3.1 Kgs, and makes it a few centimetres broader than a
normal laptop.

The dull silver-grey finish makes it look cheap, and it is not
as ergonomic as the Ultima; it lacks finesse and attention to
detail. Placed on either side of the keyboard, the speakers sound
too tinny. The touchpad is large and comfortable, and the but-
tons are raised for comfortable use. 

The Business Winstone saw it return a terrific 29 units, just 10
less than the Ethos4. The memory scores were third best in the cat-
egory. We tried in vain to test the hard disk as SiSoft Sandra kept
hanging the machine. This is more likely to be a problem specif-
ic to the laptop we recieved. The batteries lasted for 3 hours, 16
minutes, which is quite normal for a Centrino laptop. Interest-
ingly, its temperature never exceded 37 degrees.

The Optima offers the latest hardware at an unbelievable
Rs 90,000. Other laptops such as the Wipro Little Genius that are
in the same price range, offer good performance but not the same
configuration. Opt for it if you want a spruced up Centrino with
cutting edge technology.

Price: Rs 54,990
+ Good hardware configuration for
the price  
– Dated design

Price: Rs 89,990
+ Terrific performance, great features  
– Low aesthetic appeal

ACi Optima 
Optimum configuration

ACi Ethos4

Performance
Features
Usability
Value for money

BB ACi Optima 

Performance
Features
Usability
Value for money

CC

Mainstream category laptops are budget laptops that
offer you mobility and decent performance while
working with MS Office, Internet, etc. However, they

are no firecrackers when it comes to setting speed records.
Though similar to the thin and light notebooks, they differ in
the sense that they are heavier, and do not offer great features
and a long battery life. These mainstream notebooks weigh
around 3 to 3.5 Kgs and are 28 to 30 mm thick. Consider your-
self lucky if you get a combo-drive with these models, since CD-
ROMs or DVD-ROMs usually accompany them. Similarly, a 20
to 40 GB hard drive is the normal storage capacity. Though 14-

inch TFT LCDs are a standard, certain high-end laptops might
offer a 15-inch LCD. 

Legacy ports such as parallel and serial may be present.
High-end models offer at least two USB ports along with
Firewire ports. Most of the mainstream laptops have spruced
up configurations, and 256 MB of RAM is a standard fitment.
Hence, using Windows XP is not much of a problem. Keep your
minimum requirements in mind while buying a mainstream
laptop. Pick a model that offers the maximum number of fea-
tures at a decent price. Do remember to check its weight, as
that’s what you’re going to have to carry.
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This metallic blue and silver-grey
finished laptop from Dell comes
second in the looks department,

only because it was outdone by the
beautiful looking HP laptops. Though
the rounded contours spell panache, the
design looks boxy. The build-quality is
excellent, and it doesn’t squeak when
you press hard on it. 

The Inspiron has a comfortable
keyboard with a lot of space to rest
your palms. The touchpad is small,
but sensitive, and the large buttons
are a boon, but lack tactile feedback.

Connectors that you’ll use pretty often are placed at the back,
and could cause some irritation as you’d have to change the lap-
top’s, or your own position everytime you want to connect a USB
device. The integrated speakers are simply useless.

In terms of features, this laptop was quite disappointing, and
lacked serial and parallel connectors—the fact that it only provides
two USB ports doesn’t make up for it.  It lost miserably to the HP
Compaq models in this respect.

When it comes to performance, the Inspiron is no couch-pota-
to. Its desktop processor has enough fire power to run most office
applications smoothly. A point to remember is that the Inspiron
1100 base-model ships with 128 MB of RAM, but you can specifi-
cally ask for 256 MB, for an additional price; that’s what we did.  If
you’re going to buy this laptop, we strongly suggest the RAM
upgrade for acceptable  performance with Windows XP. The ther-
modynamics of this laptop are superb—even after running con-
tinuously for a day, the external surface was as cool as a cucumber. 

Priced at Rs 79,969, the Inspiron 1100 is a good deal, but not
if you’re on the lookout for a fea-
ture rich laptop.

unknowingly move over the touchpad. 
Weighing 3.1 Kgs, the nx9000 comes with a Pentium4 M 2.2

GHz processor, 256 MB of DDR RAM, a 15-inch crisp TFT display,
a 40 GB hard disk, and was the only laptop with a combo-drive.
Windows XP, Norton Anti-virus and a handsome carry case are the
freebies. Apart from an Ethernet and modem connector, it also
offers wireless connectivity via an 802.11b wireless card. 

It finished second after the ACi Optima in the performance cat-
egory. In the CPU test, the processor performed well and returned
good results. Its memory sub-system lost meekly; while the disk
sub-system is the best. The battery lasted for around 3 hours on a
normal load—quite good considering the nx9000’s power-hungry
components.

Priced at Rs 1,00,000, it’s certainly expensive, but offers great
build-quality, superb features and balanced performance. This lap-
top won the top honours for its
good performance and

unmatched feature list.

The nx9005 was the only laptop
in this comparison to ship with
an AMD mobile processor. 

The keyboard and the touchpad
along with the activating and deacti-
vating button, are similar to its Pen-
tium sibling. The touchpad gels with
the flat surface to give a neat and
clean look. It has the same rugged,
solid feel and dimensions as the
nx9000. 

Configuration-wise, it packs
in an AMD Athlon M 2200+ with
256 MB of RAM. A 20 GB hard
drive, a CD-ROM drive and the 14-inch display make the laptop
more affordable. However, we strongly feel that a 40 GB hard disk
should have been provided.

With the exception of the multimedia test, the AMD-powered
laptop beat its Pentium counterpart in most of the CPU tests. One
area where the nx9005 fared badly was the hard disk subsystem—
it just could not keep up with the demand. The high access time
and low scores was a clear sign of dated hard disk technology.
Knowing that AMD processors are power hungry, the batteries sur-
prised us by supplying power for nearly 3 hours. The laptop also
did not show signs of heating up.

Considering its configuration, it is certainly expensive at
Rs 70,000, but its sturdy build, good ergonomics and decent per-
formance make up for that.

HP Compaq nx9000

Performance
Features
Usability
Value for money

C-C-

HP Compaq nx9005

Performance
Features
Usability
Value for money

B+B+

Price: Rs 1,10,000
+ Superb looks, good performance 
– Expensive

Dell Inspiron 1100

Performance
Features
Usability
Value for money

CC

Price: Rs 79,769
+ Great build quality and looks  
– Low on features

Price: Rs 70,000
+ Business looks, decent performance
– Lacks features

Dell Inspiron 1100
Inspired blue box 

HP Compaq nx9005
Bridging the divide

The HP Compaq nx9000 has a metallic jet-black
body, with attractive blue
neon lights working as system

status indicators. The keyboard is
well spaced, with keys providing the
right amount of tactile feel. It has a
digital scroll that lets you go through
a document simply by moving your
finger over the area. Placed just above
the touchpad, is the toggle switch
that activates or de-activates it. This
feature is very helpful since the cur-
sor often gets displaced from its
position when your fingers

HP Compaq nx9000
A workhorse

➜
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1970s: Alan Kay, of the Xerox Palo Alto Research Center, Califor-
nia, builds the Dynabook that can handle most computing
needs, and has wireless network capabilities. 
1979: William Moggridge designs the Grid Compass. It has a
340 KB bubble memory, a die-cast magnesium case and a fold-
ing electro-luminescent graphics display.
1981: A book publisher, Adam Osborne, comes up with the
Osborne 1. With a 5-inch screen, modem port, two 5.25-inch
drives, a battalion software and a battery pack. It weighs almost
11 Kgs and costs $1795 (about Rs 86,000). The Epson HX-20—a
battery-powered portable computer, with a 20-character by 4-
line LCD display and built-in printer—is also released.
1983: Gavilian Computer—it has 64 KB RAM, a Gavilan operat-
ing system (also runs MS-DOS), an 8088 microprocessor, touch-
pad mouse, portable printer and weighs 4 Kgs—6.4 Kgs with
the printer. Radio Shack also releases the TRS-80 Model 100.
Microsoft wrote its ROM programs—Bill Gates wrote a few him-
self! It uses standard AA batteries.
1984: IBM announces the IBM 5155 Portable Personal Comput-
er—equipped with 640K RAM, two double-sided 5.25-inch
drives, and an amber monochrome monitor. Apple also launch-
es the Apple IIc model—a notebook-sized computer that had a
65C02 microprocessor, 128 kilobytes of memory, an internal
5.25-inch floppy drive, two serial ports, a mouse port, modem
card, external power supply, and a folding handle.
1986: IBM introduces its IBM PC Convertible. It uses an 8088
microprocessor, has 256 kilobytes of memory, two 3.5-inch flop-
py drives, an LCD, parallel and serial printer ports and a space
for an internal modem. It came with its own applications soft-
ware, weighed 5.4 Kg and sold for $3,500 (about Rs 1,68,000).

History of Laptops

Conclusion
The mainstream category was completely dominated by models
from two vendors, namely HP Compaq and ACi, with each of
them sending in two models. Despite their relative similarity in
terms of hardware configuration, the HP Compaq models were
distinctively different from the rest of the crowd; in fact they
were the best looking laptops in the comparison with unmatched
aesthetic appeal.

The ACi Ethos4 is targeted at the low-end market and pro-
vides reasonably good hardware, but lacks style and scores low
on the appeal. The Jaguar is a complete copy of the Ethos4, with
just different colour and body panels. Both these laptops are a
complete no-no if you like some flair. The ACi Optima is based
on the Centrino platform and offers better features, but like its
low-end sibling, lacks sophistication when it comes to looks. The
Dell Inspiron 1100 looked great, and performed even better.

In terms of features, the HP Compaq nx9000 beat most of the
laptops hands down, its aggressive yet sophisticated styling helped
it take the top honours for this category. We had no doubt about
it being the winner—It had the right mix of the required ingredi-
ents.

While the Dell Inspiron and ACi Optima did exceptionally
better than the HP Compaq in pure performance, they lost to the
nx9000 on all the remaining factors. The HP Compaq nx9005
claimed the value for money title with its good looks, decent
performance and pricing. Overall, HP Compaq swept clean all
the titles in this category.

The Jaguar M270S clones
the ACi Ethos4 in all
aspects. The only distin-

guishing factor between the two
is the colour of the plastic used.

It offers only a Pentium 4 M
1.7 GHz, 256 MB of RAM, a CD-
ROM drive and 20 GB hard disk.
The SiS 650 chipset provides an
onboard graphics adapter. The
small 13.3-inch TFT LCD was
crisp and clear.

Looks-wise, the M270S
is no different from the
Ethos4, but the use of the colour brown, imparts some appeal.
The keyboard layout is quite cramped, but the keys provide pos-
itive tactile feedback. The touchpad is sensitive and accurate, but
the entrenched buttons are a pain to use.

Owing to a slow processor, it finished last in the CPU tests.
However, the memory sub-system is quite brilliant, and man-
aged to beat the ACi Optima by a small margin. The hard disk
subsystem is a complete mess and its scores are the lowest. It
yielded a pathetic frame rate while playing Quake III Arena and
could hardly be used for graphics-intensive tasks.

If you are looking for a laptop to make presentations and work
with Word processors and Excel sheets, the M270S is a good buy
at just Rs 55,000—the second cheapest in our comparison.

Jaguar M270S

Performance
Features
Usability
Value for money

C+C+

Price: Rs 55,000
+ Decent looks 
– Low features and performance

Jaguar M270S
Mobility for a pittance
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AACCii
Ethos

Pentium4 M 1.8 GHz
256 MB

14
40 GB / 4,200

SiS650 S3 graphics
CD-ROM

RealTek AC97
2 USB/✖ /✔ /✔

✔ /✖ /✔ /✔
Monitor D-SUB and S-Video

✔ / 2 
✖

✖

1
✖

300 x 245 x 40
3.1
✖

3
3

3.5
3
3

29
38

✖

✖

✖

✖

Carry case and Power 
adapter

✔

19.3
148

4,784
1,034
7,160
9,411

1,037
1,039

11,482
16
4
16
4
11

56.9
42.7
26.8
1,055
2.5

2 Hrs 18 Min

22.76
15.70
8.70
1.50

48.66

3.5

54,990

AACCii
Optima

Pentium M 1.7 GHz
512 MB

15 
60 GB / 4,200

Intel 855 
DVD-RW

RealTek AC97
3 USB/✖ /✖ /✔

✖ /✔ /✔ /✔
Monitor D-SUB and S-Video

✔ / 2 
✖

✖

1
✖

350 x 260 x 35
3.1

2 scroll buttons
3
3

3.5
3

2.5

26
37

✖

✖

Easy CDcreator, Inter DVD

✖

Carry case, Power adapter 
and external FDD

✔

29.4
76

5,713
2,293
9,717
11,293

1,652
1,652

Failed
Failed
Failed
Failed
Failed
Failed

124.1
65
35

1,898
3

3 Hrs 16 Min

33.42
19.70
8.70
1.50

63.32

2.8

89,990

DDeellll
Inspiron 1100

Pentium 4  2.6 GHz
256 MB

14
30 GB / 4,200

Intel Extreme graphics
Combo
AC97

2 USB/✖ /✖ /✖
✖ /✖ /✔ /✔

D-Sub and S-video
✔ / 2 buttons

1 button
✖

1
✖

320 x 270 x 42
3.3
✖

4
3.5
3.5
3.5
2.5

26
33

Windows XP Home
Corel Word perfect

Encarta 2004, WinDVD,
Money 2004 & sonic Record

✔

Power Adapter and case

✔

23.2
114

6,156
1,370
9,491

12,054

1,703
1,706

13,001
19
4
17
5
12

91
52
29

1401
4

3 Hrs 6 Min

32.68
13.10
9.00
3.80

58.58

2.9

79,769

JJaagguuaarr
M270S

Pentium4 M 1.7 GHz
256 MB

13.3
20 GB / 4,200

SiS 650 S3 Graphics
CD-ROM

Avanche AC97
2 USB/✖ /✔ /✔

✔ /✖ /✔ /✔
Monitor D-SUB and S-video

✔ / 2 button
3 buttons

✖

1
✖

300 x 245 x 40
3.1
✖

3.5
3

3.5
3

2.5

26
38

✖

✖

✖

✖

Carrycase and 
power adapter

✔

19.3
151

4,662
976

6,766
8,617

1,667
1,669

10,911
15
4
14
4
11

65
47
30

1,006
2.5

3 Hrs 3 Min

28.64
16.90
7.40
1.50

54.44

3.1

55,000

HHPP--CCoommppaaqq
nx9000

Pentium 4 M 2.2 GHz
256 MB

15
40 GB / 4,200

Radeon IGP
Combo
AC97

2 USB/✔ /✔ /✔
✔ /✔ /✔ /✔

Monitor D-Sub and S-video
✔ / 2 buttons

5 buttons
✖

2
Touchpad On/Off switch

327 x 272 x 38
3.2

Touch scroll
4

3.5
4
4
3

26
33

Windows XP professional
✖

Norton antivirus, 
roxio and win DVD

✔

Carrycase and 
power adapter

✔

18
147

5,624
1,267
8,752
11,161

1,157
1,161

14,899
21
4

20
8
12

82
55
35

1,619
3.5

3 Hrs 5 Min

31.06
26.60
11.30
3.40
72.36

2.6
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Brand
Model

Processor  (Type and speed)
Memory (Amount) 
TFT Display Screen size (Inches)
Hard disk (Capacity, speed in rpm)
Graphics adapter
Optical drive 
Sound card
Ports (USB/Serial/parallel/Firewire)
Connectivity (IrDA,WiFi etc,LAN,Modem)
Audio-Video OUT options
Mouse Touch pad and No of buttons
Shortcut keys on keyboard (nos)
Extra Batteries provided
Compact Flash slots (nos)
Miscellaneous
UUssaabbiilliittyy  ((1155%%))
Dimensions (L x W x H) (mm) 
Weight (Kg)
Extra Input Devices (pointing stick, scroll pad)
Build Quality (SO5)
Keyboard Touch and Feel (SO5)
Mouse Touchpad sensitivity (SO5)
Overall Ergonomics (SO5)
Built-in speaker Quality test (SO5)

TTeemmppeerraattuurree  ((DDeegg  CClleessiiuuss))
Ambient Temp
Laptop under surface

Operating System bundled 
Office application suite
Other software & applications provided

Recovery CDs (Y/N)
Accessories (carry case,docking station,etc)

User guide
OOvveerraallll  SSyysstteemm  bbeenncchhmmaarrkk
ZD-Bench Business winstone  2002 (Units)
Video Encoding Test (Sec)

SSii  ssoofftt  SSaannddrraa  ((CCPPUU  tteesstt))
CPU Dryhstone
CPU Whetstone
Multimedia - CPU  Integer
Multimedia - FPU SSE

MMeemmoorryy  tteesstt
ALU / RAM (Int)
FPU / RAM (Flt)

FFiillee  ssyysstteemm  tteesstt

Drive Index MBps
Sequential Read MBps
Random Read MBps
Sequential Write MBps
Random Write MBps
Average access time (ms)

QQuuaakkee  IIIIII  AArreennaa  ((ffppss))
Normal (640 x 480 x 16) 
High (800 x 600 x 32)
Max (1024 x 768 x 32)
33DD  MMaarrkk22000011  SSEE
Displaymate assorted test (SO5)
MobileMark 2002 Battery Test

Performance (45%)
Features (35%)
Usability (15%)
Package content (5%)
Overall

Value for money (scale of 5)
Grade
Price (Rs)

HHPP--CCoommppaaqq
nx9005

AMD Athlon 2200+ XP -M
256 MB

14
20 GB / 4,200

Radeon IGP
CD-ROM

AC97
2 USB/✔ /✔ /✔

✖ /✖ /✔ /✔
D-Sub and S-video

✔ / 2 buttons
5 buttons

✖

2
Touchpad On/Off switch

327 x 272 x 38
3

Touch Scroll
4

3.5
4
4
3

26
35

Windows XP pro
✖

Norton antivirus, 
roxio and win DVD

✔

Carrycase and 
power adapter

✔

18
136

6,449
2,726
9,967
10,633

1,224
1,174

10,538
17
4
5

3.5
14

82
45
25

1,559
3.5

3 Hrs

29.47
20.10
10.60
3.40
63.57

3.6

70,000
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The ACi Centrino is a
stern looking laptop with
a leather upholstery fin-

ish on the top panel. At 32 mm,
it was the thickest model, but
weighed less than the Acer and
BPL laptops, tipping the scales
at 2.5 Kgs.

The ACi Centrino packs in
an Intel Pentium M 1.7 GHz
processor, 512 MB of DDR
RAM, a 40 GB hard drive
and a 14-inch TFT LCD.
The integrated Web cam is
useful for video-conferencing. However, the video looks quite
dark and image quality is strictly okay. 

Ergonomically, the keyboard can do with slightly bigger
keys. The small touch pad is highly accurate in pinpointing.
Though the two scroll buttons serve their purpose, a scroll pad
would have been of great help. 

It performed better than the rest, due to its higher clocked
processor and 512 MB of RAM. The Business Winstone tests
saw it finish ahead of the IBM T40 and the Acer TravelMate
290 by 3 units. Strangely, SiSoft Sandra continuously failed to
show the Dhrystone value properly, and returned a very low
score. The accolades for the marvellous Whetstone values
should be given to its processor. Overall, the system performed
perfectly as a whole. It’s onboard Intel graphics adapter lost
out to the IBM T40’s Radeon 7500. By the time we concluded
the test, its bottom was a whooping 43 degree Celsius hot! 

Given its configuration, the ACi Centrino is perfectly
priced at Rs 89,990. Opt for it if you need a simple and elegant
laptop and can put up with some heat!

Already lacking in aesthet-
ic appeal, the plastic grey
body and huge dimen-

sions of the Acer TravelMate 290
make it look even worse. The
black keyboard inscribed with
bold characters and the silver-
lined touchpad breaks the other-
wise bland grey plastic. A bigger
keyboard would have suited
the laptop rather than the
small keyboard that leaves
vast empty plastic panels for
palm rest. The laptop is
solidly put together and feels rugged.

Configuration-wise, it comprises an Intel Pentium M 1.4
GHz CPU, 256 MB DDR RAM, a 40 GB hard drive and a crisp 15-
inch TFT LCD screen. The combo-drive is placed in front and is
prone to popping when your fingers touch the eject button acci-
dentally. There are no extra frills, say, Audio DJ, flash memory
card readers, etc, to spoil you.   

The Travelmate 290 performed well across the board. It was
on par with most of the other notebooks in the CPU test. In the
system-benchmarking test that used Business Winstone, it was
only three units behind ACi Centrino and just 0.3 units behind
the IBM T40. In Quake III Arena, it was on par with other sys-
tems, delivering a jerk-free frame rate even at the highest set-
tings. The Intel onboard graphics controller definitely has
enough power to run graphically demanding applications to
certain extent. The batteries lasted for a little over 4 hours on
par with the Wipro Little Genius.    

For a product that has nearly everything you can expect
from it, Rs 79,990 isn’t too much to pay.

ACi Centrino
Too hot to handle

Acer TravelMate 290 
Beast outside, beauty inside

ACi Centrino

Performance
Features
Usability
Value for money

C+C+

Price: Rs 89,990
+ Sober looks, the latest hardware
– Gets heated up

Acer TravelMate 290  

Performance
Features
Build quality
Value for money

B+B+

Price: Rs 79,790
+ Good overall performance
– Bulky design

Thin and light, as the name suggests, is the category host-
ing laptops that have struck a fine balance between com-
puting power and usability, while keeping in mind

mobility. The critical parameters that include any notebook
into this category are thickness and the weight. Since Intel’s
Centrino platform promises these parameters, apart from a bet-
ter battery life, most Centrino-based notebooks fall into this
category. Their thickness ranges from 2.5 cm to 3 cm, and the
weight ranges from 2 Kg to 3 Kg.  

These laptops pack good performance, and if supplement-

ed by 512 MB of RAM (not that 256 MB won’t work), return
great results even under intensive and graphically heavy appli-
cations such as games. All the contenders, except the BPL Note-
book, had DVD-CDRW combo drives, and nearly all of them
came with a healthy reserve of 40 GB of hard drive space. Wire-
less connectivity is another boon of the Centrino platform,
and it makes for one more option in addition to the normal
Ethernet and modem.  
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The BPL Notebook has an
Intel Pentium M running at
1.3 GHz and a measly 

128 MB of DDR RAM. Using Win-
dows XP on this laptop is an ago-
nising experience, which was clear-
ly reflected in the scores. Though
the Zenith laptop also had the same
CPU, it zoomed ahead of the BPL
in the ZDbench Business Win-
stone system benchmark test
owing to its 256 MB of RAM.

The 40 GB hard drive is a
welcome move, but a combo-
drive would be better than the DVD-ROM it has. Although based
on a Centrino platform, the laptop offers optional wireless con-
nectivity. It’s silvery body and oddly coloured blue translucent keys
aren’t impressive either. At 2.7 Kg, it’s heavy but not too bulky.  

Ergonomically, the keyboard and touchpad are comfortable.
The layout of the keys is spacious. The optical drive is placed on
the bevelled edge in the front, but the eject button does not pro-
trude making access to the drive all the more difficult; the scroll
pad lacks tactile feel. The control keys for the Audio DJ function
are located near the bottom of the screen. Hence, you need to flip
open the top every time you want to skip a song. Ideally, these
controls should have been placed at the edges. Other nifty fea-
tures include flash memory readers for SD and MMC cards. 

The BPL notebook pitched in an average performance. Com-
pared to other laptops, it had fairly good scores in the CPU bench-
marks, but the Business Winstone scores were pathetic.

It finished second in the battery-life test—the battery lasted for
almost 5 hours. It’s quite expensive at Rs 85,000, so we don’t rec-
ommend it taking into account its ergonomic issues and the below
par configuration.

with the eject button on the lower step to avoid accidental popping.
Ergonomically, the T40 has hardly a flaw, except for the missing
Windows key—but you can configure [Ctrl] or [Alt] to act as one.
It has a touchpad with two small buttons and a pointing stick. 

It has innovative features such as a night lamp incorporated
above the screen. No recovery CDs are provided, but its factory
defaults are present on the hard drive. Access these by pressing the
blue IBM Access button during bootup. These allow you to re-par-
tition, format, install the OS and other software. Use IBM's Rapid
Restore software to backup data and retrieve it from the special
menu itself. 

The IBM T40 topped most of the tests. The Business Winstone
saw it return 27.7 units, making it ideal for business applications
such as MS-Office etc. In Quake III Arena, the ATi Radeon 7500 yield
extremely good results, posting 229 fps in normal mode—the best
in the entire category. 

It topped the list when all other criteria such as usability, pack-
age content, etc., were considered, and thus bagged the title. 

The fully charged batteries last for nearly 3 and a half hours.
Rs 1,70,000 makes it expensive, but you get more than what you’re
paying for. We have no qualms in
offering it the crown that it
deserves.

The IBM T40 we received
comprised a Pentium M 1.5
GHz with 256 MB of DDR

RAM and a 40 GB hard drive. It
weighs only 2.2 Kg. The design
makes good use of space , and the
attention to detail is exemplary. 

A thumb slider on the right of
the lid actuates the two latches,
and a grip on the left side lets
you hold it firmly. The combo-
drive is housed in a slot on the
right and has a step design

Price: Rs 85,000
+ Slim design 
– Full of ergonomic flaws

BPL Notebook 

Performance
Features
Usability
Value for money

BB

Price: Rs 1,69,900
+ Great design, superb performance 
– Expensive

IBM T40 

Performance
Features
Usability
Value for money

C-C-

IBM T40 
The FORTeeeee

BPL Notebook 
Full of ergonomic glitches
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Through Thick and Thin
We categorised the laptops that came in for the test based on
their thickness and weight.
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The Wipro Little Genius has a great grey silver body; subtle
use of chrome for the Scroll button and the lid lining add
a touch of style. The translucent buttons are etched with

white inscriptions that are easy to read in poor light. All the keys
fall within easy reach. The touchpad is placed towards the left
and is difficult to reach at times, especially if you use the keys at
the extreme right. The battery and the swappable optical drive
can be easily removed. Overall, the build-quality is top notch, but
the attention to detail is nowhere near the IBM laptop. 

Equipped with a 1.4 GHz Pen-
tium M processor and 256 MB of DDR
RAM, the 20 GB hard disk is too less
and one should consider the optional
40 GB hard drive. Windows XP Home
Edition and Norton AntiVirus are
bundled along. The DVD-ROM is a
standard accessory, while the combo
drive is optional. The infra-red port is
placed at an uncomfortable extreme
right side corner. All other connec-
tors—USB ports, LAN, etc—are con-
veniently placed for uninterrupted
use. The neon blue LEDs for system
status indicators give the laptop a

pleasing appeal. The Audio DJ lets you use the optical drive as a CD
player without switching on the entire system. Memory card read-
ers allow SD and MMC cards to be read directly. Unfortunately, the
Little Genius heats up to a sweaty 42 degrees. 

It displayed good performance and came in very close to the
IBM T40 in most of the tests. The overall system benchmark that
used ZDbench Business Winstone just saw a marginal difference
between the two. The T40’s graphics card vanquished the humble
Intel 855 onboard display on the Wipro laptop. However, it beat
the IBM in the battery life test, lasting over 4 hours—the highest
in the comparison. Its carry case was the best amongst the lot,
with a lot of storage space.

At Rs 80,000, this laptop packs
a punch; buy it if you can’t
afford the IBM T40.

The Zenith ONE-UP notebook comes with a Pentium M
1.3 GHz, 256 MB of DDR RAM, a 30 GB hard disk and a
combo-drive. For the first time ever, Zenith adopted a

sober, subtle styling, resulting in a good-looking notebook with
silver shades amidst a black background. The keyboard is
another touch of style with grey keys looking fantastic on the

Wipro Little Genius

Performance
Features
Build quality
Value for money

BB

outlined silver-black body. The layout of the keys, though well-
spanned, leaves enough space for your palm to rest. The opti-
cal drive and two USB ports are placed on the right side for
easy access, whereas a Type-II Compact Flash slot and
connectors for an external monitor, LAN and modem
are placed to the left. It has 4 USB
ports and a single PS/2 port. No
serial or parallel port is provided.
The only flaw was its thermody-
namics. Its temperature soared to
42 degrees Celsius even before the
test could conclude. 

Though equipped with just a
low-powered 1.3 GHz processor,
the laptop turned in a decent per-
formance, with scores pretty
much in the same league as that
of the IBM T40 and Acer Trav-
elMate 290. 

The bottleneck was the
hard disk, which was quite evident from the SiSoft Sandra’s
hard disk scores that were the lowest amongst its brethren. The
batteries went dead after 3 hours of continuous usage. Zenith
does not bundle any OS with the laptop and leaves it as a cus-
tomisable option.  

Priced at Rs 70,000, the Zenith ONE-UP Notebook (Wi-Fi
4X) a must buy for those on a shoestring budget. Be prepared
for a hot lap though!

Zenith ONE-UP
Notebook (WiFi 4x)

Performance
Features
Build quality
Value for money

A-A-

Price: Rs 91,990
+ Elegant design
– Low on features

Price: Rs 70,000
+ Great value for money
– Heats up

Wipro Little Genius
The crown prince

Zenith ONE-UP Notebook
(Wi-Fi 4X)
Centrino for masses
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Conclusion
The thin and light category saw the largest concentration of
products with six laptops, ranging from the modest ACi to the
renowned IBM. Similarly, the hardware used also varied wide-
ly with the ACi laptop packed to the hilt with the latest and
best processor available, while the others relied upon a rea-
sonably fast 1.4 GHz processor. 

In the performance aspect, no laptop could come close to
the ACi Centrino as far as business applications are concerned.
However, the ACi laptop could not repeat the same perform-
ance in the rest of the tests. This set the stage for the IBM T40.
This participant gave a balanced performance across the entire
battery of tests. The Wipro Little Genius and Acer TravelMate
290 made a valiant effort to beat the IBM, but fell short of a
few points—0.2 and 0.9, respectively. The contenders from
Zenith, BPL and ACi formed a triad that were on par with each
other in most of the tests.

Performance apart, no other laptop could match the IBM
T40 in terms of usability, features and package bundling. These
were the factors that let this contender from IBM sprint ahead
of its competitors, and rule this category.

Zenith does not bundle an OS along with its laptop. This
certainly helps both Zenith and the consumer, since they can
pay for the OS of their choice. The Zenith ONE-UP Notebook
(WiFi 4X) priced at Rs 70,000, offers the best bargain deal, thus
scoring very high on our value for money scale. As for the
Wipro and Acer laptops, they lost to a better product, but not
ashamedly so, because they are mighty good for the price they
demand.

External mice: It’s quite tiresome to work long hours on a
laptop, especially if it involves a lot of cursor activity. It is
advisable to keep an external USB mouse for such sessions.
Many vendors have introduced optical mice for laptops.
These are small and fit into your carry case with ease. They
are slightly uncomfortable, but still better than the touchpad.

Carry cases: Laptops come with reasonably good looking
and sturdy carry cases. These usually have a pocket to acco-
modate the power adapter. However, if you are a frequent
flier and carry other accessories along, look out for specially
made laptop bags. Elegant leather bags that have special
pockets to keep the power adapter, external optical drives,
etc., are more durable than the resin bags provided by the
manufacturer. Hard-cased laptop bags protect the laptop
from excessive wear and tear. 

External laptop coolers: The use of desktop components in
entry-level laptops reduces costs. However, these compo-
nents also dissipate a large amount of heat. Strangely, hardly
any of the laptops have ventilation systems efficient enough
to deal with this problem. 

Companies providing cooling solution for desktops saw
this opportunity and developed an external cooling solution
for laptops that helps to reduce the heat dissipation. Antec’s
laptop cooling solution has a plastic base with a brushed per-
forated aluminum surface that makes contact with your lap-
top. Two high-rpm fans placed between the plastic base and
the aluminum surface draw the heat away from the laptop.
Moreover, the cooler is USB-powered and offers a USB port,
so that you still have a USB port on the laptop.

External lights: IBM integrates small LEDs into the LCD
screen so that you can see the keys clearly when working in
the dark. For other laptops, use USB-powered light sources
that you can clip to the top of the screen. 

Standby batteries: Usually, laptop batteries last for about 5
hours. Hence, it makes sense to carry a charged standby bat-
tery along while travelling. 

We recommend that you purchase these batteries from
the laptop manufacturer rather than from a third-party ven-
dor at a lower rate.
Other accessories: A Kensington lock is a wire lock that can
be used to secure the laptop to a desk. Protect your LCD
screen using a screen protector. These are thin plastic sheets

that can be
stuck to the
LCD to pre-
vent it from
getting
scratched. 

Use special
lint-free fab-
rics to clean
the LCD
screen. 

Laptop Accessories

1/4th AD

A Kensington lock
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AAccii
Centrino

Pentium M 1.7 GHz
512 MB

14.1
40 GB / 4,200

Intel 855 
Combo Drive

RealTek AC'97
2USB/✖ /✖ /✔
✖ /✔ /✔ /✔

Monitor D-Sub and S-Video
3
✖

1
Web cam integrated

305 x 260 x 32
2.5

2 Scroll buttons
3.5
3

3.5
3

2.5

28
43

✖

✖

B's Recorder Gold, WinDVD 4
✖

Carrycase, power adapter
✔

30.4
76

845
2,275
9,719
11,269

1,728
1,730

13,624
19
4
19
4
12

127
66
37

1,972

3
3 Hrs 10 Min

20.24
21.10
10.70
4.00

56.04

3.11

89,990

AAcceerr
TravelMate 290

Pentium M 1.4 GHz
256 MB 

15
40 GB / 4,200

Intel 855
Combo Drive

RealTek AC'97
3USB/✖ /✔ /✔
✔ /✔ /✔ /✔

Monitor D-Sub and S-Video
2
✖

1
✖

333 x 276 x 32
2.8
✖

3.5
3

3.5
3
3

26
38

Win XP Home Edition
✖

✖

✔

Power adapter
✔

27.4
90

4690
1,877
7,979
9,274

1,721
1,725

14,152
21
4
17
5
13

121
65
31

1,854

3.5
4 Hrs 53 Min

24.03
23.10
10.80
4.00
61.93

3.87

79,990

BBPPLL  
Notebook

Pentium M 1.3 GHz
128 MB 

15
40 GB / 4,200

Intel 855 
DVD-ROM
CMI AC97

3USB/✖ /✔ /✔
✔ /Optional/✔ /✔

Monitor D-Sub and S-Video
3
✖

1
Flash memory card reader,
Audio DJ CD-audio player

320 x 275 x 25
2.75

Scroll Pad
3.5
3

3.5
3.5
2.5

26
34

✖

✖

✖

✖

power adapter
✔

18.7
94

4,255
1,733
7,431
8,636

1,745
1,751

13,839
19
5
19
6
10

118
63
17

Failed 

2.5
4 Hrs 50 Min

22.89
23.10
13.00
2.00
60.99

3.59

85,000

WWiipprroo
Little Genius

Pentium M 1.4 GHz
256 MB

14.1
20 GB / 4,200

Intel 855 
DVD-ROM

SigmaTel C-major Audio
3USB/✖ /✖ /✔
✔ /✔ /✔ /✔

Monitor D-Sub, S-Video
✖

✖

1
memory card reader, 

Audio CD

318 x 277 x 30
2.6

Scroll Pad
3.5
3.5
3.5
3.5
3

26
42

Win XP Home edition
Norton Antivirus

Inter Video WinDVD 
✔

carry case,power adapter
✔

26.1
89

4,543
1,857
7,975
9,277

1,689
1,700

18,946
28
4

27
6
12

122
65
35

1,883

3
4 Hrs 53 Min

24.78
20.60
10.90
8.00
64.28

3.49

91,990

ZZeenniitthh
One Up 4X

Pentium M 1.3 GHz
256 MB

14.1
30 GB / 4,200

Intel 855
Combo Drive

CMI AC97
4 USB/✖ /✖ /✔

✔ /✔ /✔ /✔
Monitor D-SUB

✖

✖

1
✖

310 x 259 x 30 
2.3

Scroll pad
3.5

3.5
3.5
3.5

26
42

✖

✖

B’s Recorder Gold, WinDVD 4
✖

Carrycase, power adapter
✔

24.8
80

4,294
1,751
7,420
8,640

1,695
1,703

13,754
19
5
17
7
10

120
90.1
46.5
1,995

3
3 Hrs 3 Min

20.54
23.10
12.00
4.00
59.64

4.26

70,000
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Brand
Model

Processor (Type and Speed)
Memory (Amount) 
TFT Display Screen size (inches)
Hard disk (Capacity / Speed in rpm)
Graphics adapter
Optical drive 
Sound card
Ports (USB/Serial/parallel/Firewire)
Connectivity (IrDA,WiFi,LAN,Modem)
Audio-Video OUT options
No of Shortcut keys provided
Extra Batteries provided
No of Compact Flash slots 
Miscellaneous

UUssaabbiilliittyy  2200%%
Dimensions (L x W x H) (mm) 
Weight (Kgs)
Extra Input Devices (Scroll, pointing stick)
Build Quality (SO5)
Keyboard touch and feel (SO5)
Mouse Touchpad sensitivity (SO5)
Overall Ergonomics (SO5)
Built-in speaker Quality test (SO5)

TTeemmppeerraattuurree
Ambient Temp (degree Celsius)
Laptop under surface (degree Celsius)

Operating System bundled 
Office application suite
Other software & applications provided
Recovery Options
Accessories (carry case,docking station,etc)
User guide

OOvveerraallll  SSyysstteemm  bbeenncchhmmaarrkk
ZD-Bench Business winstone  2002 (units)
Video Encoding Test (Seconds)

SSiiSSoofftt  SSaannddrraa  ((CCPPUU  tteesstt))
CPU Dryhstone
CPU Whetstone
Multimedia - CPU  Integer
Multimedia - FPU SSE

MMeemmoorryy  tteesstt
ALU / RAM (Int)
FPU / RAM (Flt)
FFiillee  ssyysstteemm  tteesstt
Drive Index (MBps)
Sequential Read (MBps)
Random Read (MBps)
Sequential Write (MBps)
Random Write (MBps)
Average access time (ms)

QQuuaakkee  IIIIII  AArreennaa--((ffppss))
Normal (640 x 480 x 16) 
High (800 x 600 x 32)
Max (1024 x 768 x 32)

33DD  MMaarrkk22000011  SSEE

Displaymate assorted test (SO5)
MobileMark 2002 Battery Test

Performance (35%)
Features (35%)
Usability (20%)
Package content (10%)
Overall

Value for money
Grade
Price (Rs)

IIBBMM
T40

Pentium M 1.5 GHz
512 MB

14.1
40 GB / 4,200

ATI mobility Radeon 7500
Combo Drive

Soundmax
2 USB/✖ /✔ /✖

✔ /✔ /✔ /✔
Monitor D-Sub and S-Video

4
✖

2
Night Lamp, LCD switch OFF
button, spill-proof keyboard

305 x 250 x 28
2.2

Track point and zoom button
4
4
4
4

3.5

26
33

WinXP Professional
Norton Antivirus

✔

Power adapter
✔

27.7
83

4,884
1,998
8,534
9,932

2,010
2,010

15,766
23
5
21
6
10

229
125
78

4,109

4
3 Hrs 42 Min

24.93
26.40
15.50
9.00
75.83

2.23

1,69,900
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DESKTOP REPLACEMENTS

As the name suggests, these laptops are built to retire the
bulky desktop PC without compromising on the per-
formance aspect. They takes up lesser amounts of space

than a normal PC, and offer certain amount of mobility.  Desk-
top replacements are bulky and weigh above 3.5 Kgs, making
them the heaviest among all notebook categories. Their thickness
varies with the components and the number of connectors pres-
ent on the laptop. In fact, some of them may not come with bat-
teries, and hence need a constant power supply.

Since desktop replacements are supposed to fill in for a full-
fledged PCs, they have all the ports available on a standard sys-

tem, and at the same time, perform just as well. While buying a
desktop replacement, pay attention to the screen size, the avail-
able hard disk space and the type of hard disk. Many might come
with a normal IDE hard disk that is cheaper than most small lap-
top hard disks. Do remember to make a note of the processor
and the amount of RAM you require for doing your tasks, espe-
cially if you use memory-intensive applications such as Photo-
shop. Large comfortable keyboards, tabs on the under surface
that incline the keyboard at an angle, and other such features
add to its comfort levels.

The ACi Ultima is powerful
and well-balanced—it
cramps in a standard desk-

top Pentium4 2.26 GHz, a mam-
moth 1 GB of DDR RAM, an 80
GB hard drive and a combo-drive
as well. The 17-inch wide format
TFT gives you a great viewing
experience.

The outer casing is fin-
ished in silver. Weighing 4.1
Kgs, it packs in a standard
keyboard with jet-black keys and bright white inscriptions. The
touchpad is slightly offset towards the left. This comes in the way
while using the number-pad keys. Placing it in the dead centre
would have improved its ergonomics.

Other features included are an integrated Web-camera and a
TV-tuner with a remote control. The air exhaust ports are under-
neath—hardly 5 mm above the desk. Thus, air is pushed towards
the keyboard causing the keys to heat up. The base was a searing
45 degrees Celsius by the time the test concluded. 

Performance-wise, the Business Winstone score was amongst
the best, but we expected more. The Pentium 2.26 GHz passed the
CPU test with flying colours. The memory, as well as the hard
disk, also returned commendable scores. This system can handle
any resource-hungry application without a hitch. The onboard
Radeon 9000 graphics adapter turned in a good frame rate in
Quake III and Unreal Tournament, but don’t expect the same per-
formance when playing Half-Life2, Halo 2 or any new games. 

Though a wee bit expensive at Rs 1,20,000, there is no other
laptop that can match the ACi Ultima’s combination of config-
uration and looks.

The ACi Emerald Pro pushes
the performance envelope
further by including a

desktop Pentium 3.06 GHz CPU,
512 MB of RAM, a 40 GB hard
disk, a combo-drive and a 15-inch
TFT LCD. The Radeon 9000
graphics adapter makes a won-
derful graphics sub-system. 

The good use of colour
combination gives this muscu-
lar laptop a distinct character.
Weighing 3.5 Kgs, it was the
lightest, and also the
thinnest in this category. The keyboard is not as comfortable as
the one on the Ultima. Due to its reduced size, a full-size keyboard
was omitted. The touchpad is again biased to the left, and caus-
es some discomfort. The touchpad buttons are stiff, and require
quite an effort to click. This laptop also comes with an integrat-
ed Web cam that’s placed just above the LCD.  

The Emerald Pro seared to 40 degrees—even the keyboard
and touchpad get hot due to the trapped heat.

On the performance front, the Hyper-threaded CPU and the
512 MB of RAM yielded excellent results. It finished video encod-
ing in just 95 seconds—the fastest in the entire comparison. Sim-
ilarly, the Business Winstone returned a high score of 27, an
indication of its capability to handle resource-hungry applica-
tions. The gaming benchmarks also saw the laptop returning
some terrific scores. Despite such power-hungry components, the
battery can still last for 2 hours and 18 minutes. 

Priced at Rs 74,000 it offers a great price-to-performance
ratio—just as long as you carry a portable air conditioner.

ACi Ultima  
Portable theatre

ACi Emerald Pro
Call it the diamond

ACi Ultima 

Performance
Features
Usability
Value for money

C-C-

Price: Rs 1,20,000
+ Amazing wide-format LCD screen,
good looks 
– Emits a lot of heat 

ACi Emerald Pro

Performance
Features
Usability
Value for money

B+B+

Price: Rs 74,000
+ A good configuration, great per-
formance 
– Gets heated, lacks aesthetic appeal  
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Weighing 4.25 Kgs, the
BPL DeskBook was the
bulkiest, measuring

about 50 mm thick. The dull sil-
ver-grey finish and grey plastic
used for the keyboard and touch-
pad give it a bland look. It has
well spaced keys and a large
palm-rest. The touchpad is sen-
sitive, but its buttons are tacky.
It’s configured with a desktop
Intel Pentium 4 1.5 GHz, 128
MB of RAM, a 40 GB hard
drive, a 15-inch LCD screen
and a DVD-ROM. The processor is underpowered, and 128 MB
of RAM isn’t enough to run Windows XP. There is no standby
battery, so you have to calculate your usage. 

The only exciting feature is the flash memory card reader.
BPL has also provided a carry handle for the DeskBook; fold
back the carry handle to use it as a peg that inclines the Desk-
Book while typing. Interestingly, it has the best ventilation sys-
tem, and stayed at 32 degrees Celsius even after 4 hours of use.

Its performance was nowhere near the ACi laptops. In the
Business Winstone, the measly 128 MB took its toll and the sys-
tem returned a mere 14 units. Video-encoding took over 2 and
half minutes. However, the standard IDE hard drive scored
impressively. The onboard 845 display adapter did a poor job on
graphics.

The BPL DeskBook is priced at an affordable Rs 61,900.
Though this is quite okay for its configuration,  we recommend it
only if you need an affordable desktop replacement that you do
not wish to use on the move and
can sacrifice on performance.

The Fujitsu LBC 2220 marries great looks with perfect
ergonomics and a decent performance to give birth to a
great product. 

It comes with an Intel Pentium 4 M 2.2 GHz, 256 MB of
RAM, a 14.1-inch crisp TFT LCD and a 30 GB hard drive. The
underlying Radeon chipset provides an integrated graphics
adapter for some decent gaming. Four USB ports, a serial and
parallel port each, are provided. Apart from the Ethernet and
modem connector, it also features wireless connectivity. A mem-
ory card reader is also included.

Lighter shades of silver on its outer surface and a darker sil-
ver grey on the inside, give the laptop a distinct style statement.
The off-white keyboard gels perfectly with the theme, as does

BPL DeskBook  
Starved of resources

Fujitsu LBC 2220
Fashion victim

BPL Deskbook

Performance
Features
Usability
Value for money

B-B-

Price: Rs 61,900
+ Great build-quality
– No batteries

Gaming on laptops has evolved in leaps and bounds today,
from playing simple games such as Solitaire and FreeCell, to
graphically intensive and complex Quake III and Unreal 2.
This has become possible due to the availability of powerful
processors such as the Pentium 4-M, and the introduction
of better graphics chipsets such as the Geforce Go series
from nVidia, and the Radeon Mobility range from ATi. But
for an avid gamer, playing games on a notebook will never
offer the same depth and immersion as playing on a desk-
top computer. This is partly due to the presence of the thin
liquid crystal-based displays for the notebooks. Although
LCDs are the obvious choice as display units due to their
minimal weight and sleek design, the flatness of their
screens limits the viewing angle. Also, while playing 3D
games on a LCD, the player’s view often appears to be
boxed and limited, giving the impression of a 2D game,
rather than a full-blown 3D experience. Though, this can be
corrected by wearing special 3D glasses while viewing 3D
applications, but these glasses are usually very expensive
and hard to obtain. A more practical and simpler method
has been discovered to convert the flat screen of a LCD into
a 3D display, using plain transparent cellophane—sheets of
plastic used for packaging. This cellophane technique is
based on the principle of how humans perceive three-
dimensional objects in their field of vision, and the fact that
the light from a LCD is polarized light.

Human vision is stereoscopic in nature, i.e. besides
length and width; we can also gauge depth and height, and
therefore discern and correctly identify 3D surfaces and
objects. While looking at any object, both the right and left
eye send separate images to the brain, which then merges
the two, and then gauges the actual depth and distance of
the object from the differences in the images. But our visual
system is not sensitive enough to gauge the difference
between ordinary light and polarized light. Ordinary light
consists of a scattering of light waves, which vibrate in dif-
ferent planes from each other; whereas in polarized light,
the light waves vibrate coherently in a single plane. The
main advantage of polarised light is that it can be blocked
and manipulated very easily just by altering its direction of
polarization. Cellophane has this distinct ability to rotate the
direction of polarization of any polarized light passing
through it. 

The light from the LCD in laptops is linearly polarized
due to the presence of a polarizer sheet covering the top
surface of the liquid crystal screen. Now take a cellophane
sheet, and cover half of the laptop screen with it. This will
create an effect wherein your left and right eyes will per-
ceive two slightly different images due to the polarization
occurring at one half of the screen. The 3D effect is finally
obtained, when a crossed polarized sheet i.e. a sheet which
has its polarizers oriented at a difference of 90 degrees to
the cellophane on the laptop, is placed a little distance away
from the screen, in front of the observer. And so, with a lit-
tle bit of ordinary cellophane, you can enjoy an unrestricted
and complete 3D experience, while playing your favourite
3D games.

3D Gaming on Laptops
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the off-white touchpad, with
silver-grey buttons surround-
ing it. The Audio DJ controls
are placed in the front on the
bevelled edge. Hard drive
access, AC power and battery
life are displayed on a small
LCD screen that also serves as
an Audio DJ display. 

A toggle button makes it
easy to switch between the
computing system and the
Audio DJ. The large key-
board is comfortable to use,
but could do with better
positive tactile feel. The
touchpad is sensitive and accurate, and so are the buttons.
Weighing around 3.5 Kg, it’s 45 mm thick and has great build-
quality. Its temperature did not exceed 38 degrees Celsius even
after 12 hours of use.

It was on par with the ACi Ultima in the CPU test but lost
terribly in the memory scores indicating a bottleneck in the
memory subsystem. Its hard disk scores were not impressive
either. Due to the power optimised Pentium4 CPU, the battery
life of the LBC 2220 was better than most models, lasting for
more than 3 hours. The graphics subsystem scored poorly.

Priced at Rs 91,000, the Fujitsu LBC 2220 is expensive, but
has good features, solid build quality and great ergonomics.
We recommend it to those who want style at any cost.

Fujitsu LBC 2220

Performance
Features
Usability
Value for money

C+C+

Price: Rs 91,000
+ Gorgeous looks, long battery life
– Quite expensive

Conclusion

The desktop replacement category consisted of some of the
best laptops in terms of performance, and a price tag ranging
from as low as Rs 62,000 to a huge Rs 1,20,000. Though quite
expensive when compared to a desktop PC it certainly offers
some advantages of its own. Both the models from ACi were
absolute fire crackers in terms of performance, and blasted the
others to teeters. The Fujitsu, on the contrary, was a much bal-
anced offering with great looks and decent performance.  The
only let down in this category was the BPL DeskBook, which
has its existence firmly rooted in the true desktop replacement
theory, indicated by the lack of any batteries.

The ACi Ultima was undoubtedly the winner—the USP of
this laptop being the presence of wide-format 17-inch screen
(great for multi-tasking with numerous applications), the rock
solid performance and a very good hardware portfolio. The
Emerald Pro, on the other hand, beats the gun out of every
other laptop. With the hyper-threaded chip used in the laptop
you are never out of juice for any system intensive-applica-
tion. The price tag of Rs 74,000 is quite reasonable, and offers
maximum bang for the buck, making it our value for money
champion. We would like to see some better clothing for these
laptops, which would definitely improve their visual appeal;
some relief on the thermal issues that keeps cropping up would
be nice too!
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CATEGORY

AACCii
Emerald Pro

Pentium 4 3.06 GHz
512 MB

15
40 GB / 4,200

Mobility Radeon 9000
Combo

RealTek AC97
3 USB/✔ /✔ /✔

✔ /✖ /✔ /✔
Monitor D-SUB and S-Video

✔ / 2 
3
✖

1
Integrated Web camera 

322 x 270 x 35
3.4

2 scroll buttons
3

3.5
3

2.5
2.5

26
40

✖

✖

Roxio and powerDVD

✖

Carry case and power adapter
✔

27.1
95

9,515
2,639
14,148
22,588

1,949
1,951

11,624
16
4
16
4
11

258
221
143

6,797

3.5
2 Hrs 11 Min

32.60
22.70
8.10
2.00

65.40

3.76

73,990

AACCii
Ultima

Pentium 4 2.26 GHz
1 GB 
17

80 GB / 4,200
Mobility Radeon 9000

Combo
RealTek AC97

3 USB/✔ /✔ /✔
✔ /✖ /✔ /✔

Monitor D-SUB, S-Video and CATV in
✔ / 2 

3
✖

1
Web camera, TV tuner card remote

control

380 x 270 x 40
4.1

2 scroll buttons
3.5
3.5
3
3

3.5

26
45

✖

✖

Roxio and powerDVD

✖

Carrycase, power adapter
✔

25.8
118

5,818
1,270
8,931
11,372

1,828
1,827

17,805
26
5

26
6
11

210
197
143

6,540

3.5
2 Hrs 6 Min

30.26
28.70
9.60
2.00
70.56

2.50

1,20,000

BBPPLL
DeskBook

Pentium 4 1.5 GHz
128 MB 

15
40 GB / 5,400

Intel 845 
DVD-ROM

AC97
4USB/✔ /✔ /✔

✖ /✖ /✔ /✔
Monitor D-SUB and S-Video

✔ / 2 
3
✖

2
Flash Memory card reader

350 x 300 x 50
4.25

scrollpad
3.5
3.5
3

2.5
2.5

26
32

✖

✖

Norton Antivirus 2003,
powerDVD

✖

Power adapter
✔

14.3
162

4,007
835

5,969
7,575

1,740
1,763

24,703
36
7

36
2
7

80
50
13

Failed

3.5
No battery

14.61
22.70
8.10
2.00
47.41

3.26

61,900

FFuujjiittssuu
LBC 2220

Pentium 4 M 2.2 GHz
256 MB

14
30 GB / 4,200

Radeon IGP
Combo

ALI AC97 
4 USB/✔ /✔ /✔

✔ /✔ /✔ /✔
Monitor D-Sub and S-video

✔ / 2 
2
✖

2
Flash memory card reader 

and Audio DJ

315 x 260 x 45
3.5

2 scroll buttons
4

3.5
3.5
3.5
3.5

26
38

Windows XP Professional
✖

✖

✔

Carry case, power adapter
✔

19.6
146

5,738
1,261
8,729
11,112

1,100
1,103

12,911
18
4
17
7
11

40
32.6
24

886

3
3 Hrs 53 Min

22.86
26.80
10.10
4.00
63.76

2.98

91,000O
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BBrraanndd
Model

Processor (Type and Speed)
Memory (amount) 
LCD Display Screen size (Inches)
Hard disk (Capacity / Speed in rpm)
Graphics adapter
Optical drive 
Sound card
Ports (USB/Serial/parallel/Firewire)
Connectivity (IrDA,WiFi etc,LAN,Modem)
Audio-Video OUT options
Mouse Touch pad and No of buttons
No of Shortcut keys
Extra Batteries provided
Compact Flash slots (nos)
Miscellaneous

UUssaabbiilliittyy  ((1155%%))
Dimensions (L x W x H) (mm) 
Weight (Kg)
Extra Input Devices (Scroll, pointing stick)
Build Quality (SO5)
Mouse Touchpad sensitivity (SO5)
Keyboard Touch and feel (SO5)
Overall Ergonomics (SO5)
Built-in speaker Quality test (SO5)

TTeemmppeerraattuurree  
Ambient Temp (degree Celsius)
Laptop under surface (degree Celsius)

Operating System bundled 
Office application suite
Other software & applications provided

Recovery CDs
Accessories (carry case,docking station,etc)
User guide
OOvveerraallll  SSyysstteemm  bbeenncchhmmaarrkk
ZD-Bench Business winstone  2002
Video Encoding Test (Seconds)

SSii  ssoofftt  SSaannddrraa  ((CCPPUU  tteesstt))
CPU Dryhstone
CPU Whetstone
Multimedia - CPU  Integer
Multimedia - FPU SSE

MMeemmoorryy  tteesstt
ALU / RAM (Int)
FPU / RAM (Flt)

FFiillee  ssyysstteemm  tteesstt
Drive Index (MBps)
Sequential Read (MBps)
Random Read (MBps)
Sequential Write (MBps)
Random Write (MBps)
Average access time (ms)

QQuuaakkee33  AArreennaa  ((ffppss))
Normal (640 x 480 x 16) 
High (800 x 600 x 32)
Max (1024 x 768 x 32)
33DD  MMaarrkk22000011  SSEE  

Displaymate assorted test (SO5)
MobileMark 2002 Battery Test

Performance (45%)
Features (35%)
Usability (15%)
Package content (5%)
Overall

Value for money
Grade
Price (Rs)
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The latest buzz in mobile computing are tablet PCs. The con-
cept conceived by software giant Microsoft, and these
devices are a cross between palm tops and laptops. A tablet

PC allows you a palmtop-like input facility via a stylus and the
touch sensitive LCD screen. Tablets are often used in hospitals,
where the doctor can access prescription data of a particular
patient while taking rounds, or in manufacturing and construc-
tion sites to glance quickly through any required information.

Such work places demand devices that are portable and can
be handled comfortably. Dimensions, weight and configuration

are the factors that determine the cost of a Tablet. There are cur-
rently two types of tablet PCs available: the stand-alone models
that are true tablets, and the convertibles. This can also mas-
querade as a laptop. The weight of these devices is usually
between 1.5 Kgs to 2.5 Kgs. The true tablets have no moving parts
and are robust, the apparent mechanical complexity of the con-
vertibles makes them delicate gadgets. One more aspect that
makes tablets different from laptops is the use of smaller LCD
displays—12-inch displays are the norm.

The Acer C110 is built around the
convertible idea, and offers dual
functionality as both a laptop

and a tablet. Its most striking feature
is the amazingly compact form fac-
tor. This was the cutest device in the
comparison.

The C110 weighs a mere 1.5
Kgs and measures 25 x 21 x 28
cms, making it the lightest and
smallest tablet in the compar-
ison. It may be small, but in
no way is it underpowered.
The 10-inch LCD display is
clear and crisp with a good viewing angle. It has a Pentium M 900
MHz processor but comes with 512 MB of DDR RAM to make up
for the low-processor speed. Despite the small size, Acer manages
to cramp in a 40 GB hard disk, and as it runs on the Centrino plat-
form, it also offers wireless connectivity. 

The keyboard is comfortable as it is arc-shaped. The keys are
small, but comfortable, and have good tactile feedback. The
touchpad is small and quite cumbersome to use. To change to
the tablet mode, you need to unlock the clamps holding the
screen on the sides, and twist it and fold it flat. The locking
mechanism for the screen is quite flimsy. The hotkeys are per-
fectly placed within easy reach of your fingers, as is the stylus.

The C110 showed signs of being under-powered in the CPU
and hard disk tests. However, the memory subsystem is excel-
lent—it beat the Toshiba 3500’s SD-RAM subsystem convinc-
ingly. The graphics performance was certainly the best amongst
the lot, courtesy the latest generation on-board graphics by Intel. 

At Rs 1,59,990, the Acer C110 is better priced than the
Toshiba tablet. Only its no-so-elegant looks and flimsy build
quality were disappointing, but at such a good price, it is the
better option.

This convertible tablet PC
from ACi is like a pickup
truck—massive, relatively

ugly and slow.  The tablet weighs
around 2.5 Kg and measures a
bulky 315 x 260 x 30 cms. The
LCD display measures a full 14-
inches, which is considered
monstrous for a Tablet PC.
With such dimensions and
weight, the very purpose of a
tablet seems to be lost. 

Aesthetically, the steel grey
finish and the chrome lining make the product look cheap. The
interior has black keys and dark grey panels, contrasting with the
pool of chrome and grey plastic.

Ergonomically, the keyboard is well spaced out and comfort-
able. The shortcut buttons for the tablet mode are placed on the
sides. You have to get used to them and know exactly where each
one is, before they even begin to be ‘shortcut’ keys.

The ACi tablet has a VIA Nehemiah 1 GHz processor, with
256 MB of RAM, a measly 20 GB hard disk and an onboard SiS
adapter as the graphics card. The tablet comes with just two USB
ports—all legacy ports are missing. However, other features such
as flash memory card reader, external USB DVD-ROM, external
floppy drive and compact flash reader are provided.

Via processors have weak FPU’s, and the pathetic FPU score
in the Sisoft Sandra CPU test and below par gaming benchmarks
proved that. It was the lowest scorer of all in the Business Win-
stone test. Moreover, ACi does not bundle Windows XP Tablet
Edition, making us wonder why they called it a tablet in the first
place. 

Though it’s priced at just Rs 69,990, you’ll have to shell out
extra to get a tablet edition OS. The ACi Tablet is cheap, looks the
part and absolutely fails to deliv-
er where it matters.

Acer C110  
Baby’s day out

ACi Tablet
The elephant ballet

Acer C110 

Performance
Features
Usability
Value for money

CC

Price: Rs 1,59,990
+ Extremely portable, good configura-
tion 
– Needs a better build quality

ACi Tablet

Performance
Features
Usability
Value for money

AA

Price: Rs 69,990
+ Large screen  
– Poor performance, quite bulky
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Toshiba Portégé 3500 was one
of the first devices to feature
the Tablet Edition of Win-

dows XP Professional. At first
glance, this device looks exactly
like a small notebook. Don’t be
fooled by its looks though—the
12.1-inch screen can be rotated
180 degrees and folded flat
on top of the keyboard to
activate the Tablet mode.

As far as hardware
specs go, this baby sports
a Pentium III 1.3 GHz mobile processor, 256 MB SDRAM, a 40
GB hard drive, 12.1-inch Poly-Silicon TFT colour display sup-
porting up to 16 million colours at 1024 x 768, Trident graph-
ics controller, Ali M1535 integrated software sound, inbuilt
speakers and microphone. Input options include an 84-key
keyboard with 12 function keys, integrated touchpad, a tablet
pen with hovering feature and four hardware buttons. 

Tipping the scales at less than 2 Kgs, the Portégé 3500
measures 11.6 x 9.2 x 1.2 inches and sports a standard matte
black body with elegant silver touchpad, swivel strip and the
pivot at the base of the screen. The stylus is located in the
screen bezel and pops out when pressed. The unit lacks an opti-
cal device—Toshiba should have bundled an external CD-ROM
device.

The keyboard is quite sturdy, and the keys well spaced out
and comfortable to use. The viewing angle of the LCD screen is
quite narrow by normal standards—you need to keep the screen
straight to view the colours and text properly.

The fun begins when you switch to tablet mode. The display
orientation automatically changes to portrait mode. It has hand-
writing and speech recognition, with an input window for this
available on-demand, docked at the bottom of the screen. A tap
of the stylus onto the touch sensitive screen is a single-click and
a double-tap is a double-click. A small button on the stylus has
to be pressed when tapping, to get a right-click. Handwriting
recognition is fairly accurate, though a user will require some
time to get used to it. Speech recognition, on the other hand, 
is not very accurate and you may come up with some really 
funny results. 

The Portégé 3500 churns out a decent performance. Most
scores returned by this tablet indicate that it is a decent business
application device, and will get most of your work done, but
don’t expect the same for games—it isn’t meant to be one. The
battery life of around 2 hours may fall short of your requirements.

As far as the price tag is concerned, at Rs 2,04,999, the Portégé
3500 is definitely expensive. Yet the price tag may not be a limit-
ing factor for a hotshot executive on the move, and for those who
recognise the need for this kind of functionality. The price, how-
ever, needs to drop drastically for
it to be accepted by others.
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Toshiba Portégé 3500

Performance
Features
Usability
Value for money

C-C-

Price: Rs 2,04,999
+ Elegant looks 
– Very expensive

Toshiba Portégé 3500  
Near perfect

Conclusion
The laptop market is just opening up with the introduction of
notebooks costing below Rs 60,000, and under such circum-
stances a Tablet PC that cost Rs 1,50,000 upwards is still too
niche a product to be in mass demand. Microsoft’s support to
this technology has certainly helped it to grow, but sustaining
this growth over a longer period of time looks doubtful. Tablets
are good devices, marrying the ease of use of a handheld to the
capabilities of a laptop, but the trade off does not work all the
time. Some models come with passive stylii—a simple plastic
stick.  Certain other tablet systems come with active stylii that
have buttons so that you can make mouse clicks with them. The
tablet mode is ideal for usage in workplaces such as hospitals,
assembly-line plants, etc., that require you to be constantly on
the move and take notes, simultaneously. These laptops that
can be converted into tablets as and when you need them that
way have their own sets of build quality problems. This arises
due to the mechanical complexity of the turnable LCD panel
that folds flat for the tablet. 

The touch-sensitive LCD screen is a fragile piece of hard-
ware and needs to be handled with care.  Mishandling  or rough
use might damage its sensitivity to touch. Repairing it is a cost-
ly affair that you would not like to get involved in. 

We managed to get three tablets, from three different ven-
dors, and that too priced drastically different from each other.
This was the reason we decided to go without a comparison
between them. The most expensive of the lot—Toshiba Portégé
3500 exuded class and elegance. The build quality was top class,
and devoid of any flaws, except for the compromised ergonom-
ics omnipresent to any convertible tablet. The Portégé 3500 was
amongst the first few tablets that came around, and hence the
hardware is pretty out dated by today’s standards; yet this was-
n’t a hindrance with its performance. The configuration should
be improved with the launch of the next model. 

The Acer tablet came with better hardware and performed
significantly better than the Toshiba, but it comes no where near
the latter in aesthetic appeal. The Toshiba Portégé 3500 closely
emulated the qualities that a tablet PC should possess. As for
the ACi tablet, the less said the better.
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One look at the new Apple PowerBook,
and you’re sure to fall in love with it. Apple
products are known for their unique
styling, and this baby is no exception;
everything spells pizzaz. 

Discarding the old titanium cover, the
G4 is dressed in silver-coloured aluminium
casing. Tipping the scales at 2.6 Kgs, it’s
slightly heavy, but not uncomfortably so.
The wide 15-inch LCD is more than
enough, and a DVI connector offers con-
nection to any external digital monitor, or
projection device. The plethora of connec-
tivity options available on the PowerBook is
something to talk about—two USB 2.0
ports, a standard (IEEE 1394) FireWire and
another FireWire 800 (IEEE 1394b).  This
was the only laptop with an IEEE 1394b
port. Similarly, the PowerBook has a high
speed Gigabit Ethernet connector, a phone
jack (RJ-11) and an optional Airport Extreme
card for wireless connectivity.

The slot loading SuperDrive is a boon to
the mobile user—just slide in the CD, and
go about your business. The backlit disre-
gards poor lighting conditions, and sensors
detect the ambient light and adjust the
backlight—of the LCD and the keyboard—
accordingly. The only dissapointment came
in the form of the jerky trackpad.

Under the sleek hood, is a G4 1.25
GHz processor and 512 MB RAM. Mac OS
X version 10.2.5 combines the ease of use
of a Mac, with the stability of Unix, and
has almost every imaginable application
pre-installed—iTunes, iMovie, iDVD,
speech recognition software, etc. The sys-
tem lasted only two hours and 40 min-
utes on a full charge. 

At close to Rs 1.77 lakh, this stunner is
sure to wrench your heart out through your
wallet. But once you have it, remember to
flaunt it at every possible occasion!

Apple G4 powerbook
CATEGORY

TToosshhiibbaa  
Portege 3500

Pentium III M 1.3 GHz 
256 MB 

12
40 GB / 4,200

Trident CyberALADDiN-T 
✖

SoundMax Digital audio
2 USB/✖ /✖ /✔

✔ /✔ /✔ /✔
Monitor D-SUB

✔ / 2

✔

✖

2
Flash memory card reader

295 X 234 X 32
2
✖

3
3.5
3.5
3
3

26
38

Windows XP Professional
✖

Toshiba control ultilities

✔

Power adapter

✔

17.1
168

3,625
1,789
7,001
8,772

564
552

14,721
22
4
19
4
12

26
16
8

1,520
3

2 Hrs 10 Min

24.90
18.90
11.90
6.50

62.20

1.8

2,04,999

AAccii
Tablet

VIA Nehemiah 1 GHz
256 MB

14
20GB / 4,200

VIA S3G 
External Combo

VIA AC97
2USB/✖ /✖ /✖
✔ /✖ /✔ /✔

Monitor D-SUB 
✔ /2 buttons

✖

✖

1
Memory Card Reader 

and External FDD

315 x 260 x 30
2.5
✖

3
3

3.5
2.5
3.5

26
38

✖

✖

Roxio Easy CD creator 
and Power DVD

✖

Carrycase and power
adapter 

✔

13.4
277

1,603
369

2,207
2,511

765
426

11,552
16
4
16
4
11

31
20
14

676
3

2 Hrs 13 Min

22.22
16.50
10.30
4.00
53.02

4.5

69,990

AAcceerr
Tablet

Pentium M 900 MHz
512 MB

10.4
40 GB / 4,200

Intel 855
✖

CMI AC'97
2 USB/✖ /✖ /✔

✔ /✔ /✔ /✔
D-sub 

touchpad, 2 buttons 
and scroll pad

4 buttons, 5 tablet buttons
✔

1
Special LCD cleaning

Fabric, Extra stylus tips

250 x 215 x 28
1.5
✖

2.5
3
3

2.5
3

26
39

Windows XP Home Edition
✖

Tablet PC softwares

✔

Carrycase, power adapter
and extra battery

✔

19.9
130

2,992
1,208
5,142
5,977

1,660
1,687

9,046
12
3
12
3
12

100
65
36

1,832
3

2 Hrs 20 Min

28.06
21.40
12.40
6.00
67.86

2.5

1,59,990
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Brand
Model

Processor (Type and speed)
Memory (Amount) 
TFT Display Screen size (Inches)
Hard disk (Capacity / Speed in rpm)
Graphics adapter
Optical drive
Sound card
Ports (USB/Serial/parallel/Firewire)
Connectivity (IrDA,WiFi etc,LAN,Modem)
Audio-Video OUT options
Mouse Touch pad and No of buttons

Shortcut keys on keyboard
Extra Batteries provided
Compact Flash slots (nos)
Miscellaneous

UUssaabbiilliittyy  ((2200%%))
Dimensions (L x W x H) (mm)
Weight (Kg)
Extra Input Devices (wheel, pointing stick)
Build Quality (SO5)
Keyboard Touch and Feel (SO5)
Mouse Touchpad sensitivity (SO5)
Overall Ergonomics (SO5)
Built-in speaker Quality test (SO5)

TTeemmppeerraattuurree
Ambient Temp (degree Celsius)
Laptop under surface (degree Celsius)

Operating System bundled 
Office application suite
Other software & applications provided

Recovery CDs
Accessories (carry case,docking station,etc)

User guide

OOvveerraallll  SSyysstteemm  bbeenncchhmmaarrkk
ZD-Bench Business winstone  2002
Video Encoding Test (seconds)

SSii  ssoofftt  SSaannddrraa::  CCPPUU  tteesstt
CPU Dryhstone
CPU Whetstone
Multimedia - CPU  Integer
Multimedia - FPU SSE

MMeemmoorryy  tteesstt
ALU / RAM (Int)
FPU / RAM (Flt)

FFiillee  ssyysstteemm  tteesstt

Drive Index (MBps)
Sequential Read (MBps)
Random Read (MBps)
Sequential Write (MBps)
Random Write (MBps)
Average access time (ms)
QQuuaakkee  IIIIII  AArreennaa  ((ffppss))
Normal (640 x 480 x 16) 
High (800 x 600 x 32)
Max (1024 x 768 x 32)
33DD  MMaarrkk22000011  SSEE

Displaymate assorted file test (SO5)
MobileMark 2002 Battery Test

Performance (35%)
Features (35%)
Usability (20%)
Package content (10%)
Overall

Value for money
Grade
Price (Rs)
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Ultra-portable laptops are for frequent fliers who need an
extremely light and small device. They are made keeping
size in mind, and hence do not perform as well as their

bigger siblings—the thin and light laptops. They are small and
light enough for you to lug them around the whole day without
tiring yourself. Ultra-portables usually have LCD screens meas-
uring not more than 12 inches; the ones with a 10-inch screen
are termed sub-notebooks.

Their small size results in poor ergonomics and the keys
might end up giving you sore fingers. These small machines are

mainly used to work with Word processors, make Powerpoint
presentations and check e-mail while on the move. Previously,
many of these laptops used Intel’s PIII range of processors. How-
ever, the new breed has adopted the latest Centrino mobile tech-
nology that offers inbuilt wireless connectivity, longer battery
life and sleeker designs, without compromising on performance.
The batteries on the new Centrino models last for at least 3 hours;
pre-defined power schemes such as Presentation, Movie, etc,
extend that period to 4 hours.

The PnP ultra-portable lap-
top was based on the VIA
Antuar platform. The com-

pact dimensions of this notebook
compelled us to put it in the ultra-
portable category. It weighs just
1.4 Kgs and measures a mere 27 x
21 x 25 inches. It comes with a 1
GHz VIA Nehemiah CPU, 256 MB
of RAM, a 40 GB hard drive and
an S3 graphics core. No legacy
ports are available, but you get
two USB ports and a Firewire
port for data transfer. 

It has a reasonably large keyboard that is well spaced out for
comfortable typing. The keys are extremely responsive. The
touchpad is sensitive and track true, while the  accuracy is spot
on. The ports are ideally placed for easy and unhindered usage. 

The off-black finish and subtle use of silver at the base of the
lid lend it a stern character. The same theme continues on its
inside and makes it stand out from the rest of the crowd. 

VIA processors are never known to be powerhouses, and the
same is reflected in the FPU scores, which is the weakest on all
VIA processor. This weakness was also reflected in all the graph-
ics benchmarks such as Quake III and 3D Mark 2001 SE. The
hard disk holds up to the demand quite well. The battery life
is, as usual, near the 3-hour mark.

Given its configuration, it’s priced expensively at Rs 69,999.
Its only USP is its extremely low profile design that makes it
light and compact. It gets most of your light work done in a
jiffy, but crawls along when faced with any processor-intensive
tasks. We recommend it to those on the lookout for a an
extremely light and ultra-portable laptop at an affordable price.   

The Toshiba Portégé M100 was
the only true ultra-portable
that made it to this compari-

son. Based on the latest Centrino
technology, it packs a lot of punch in
its small body. The M100 looks ter-
rific in its champagne-coloured out-
fit. 

Black side panels line the crisp
12-inch TFT LCD. The jet-black
keyboard and the blue track point
contrast well with its gold colour.
The top lid is hinged to the cen-
tre of the base, while the chub-
by speakers protrude out at its extremities.

The keys are fairly spaced out, and you don’t fumble while typ-
ing. Our only gripe was the positioning of the Windows key with
the function keys at the top of the keyboard. A pointing stick along
with four buttons fills in for the touchpad. The placement of these
buttons with respect to the pointing stick is perfect, and does not
require you to stretch your fingers. Weighing 1.9 Kgs and measures
26.5 x 24.5 x 35 inches, which is quite compact. Despite being that
small, it manages to offer a combo-drive. 

In the overall system benchmark that used Business Winstone,
the M100 delivered an astounding 25 units—the best score you
can get on an ultra-portable. This can be attributed to the Pentium
M 1.2 GHz CPU that uses the Centrino platform. Similar results
were seen across the board, indicating the presence of high-per-
formance hardware. The 40 GB hard drive delivered a commend-
able performance. The graphics sub-system is powerful enough to
get along with most of the old 3D games. The batteries lasted for
about 3 hours. Use a power scheme and you gain an extra hour. 

For an ultra-portable, Rs 1,79,999 is expensive, but it’s the best
compact travel companion that money can buy.

PnP Ultra-portable laptop
Processor weak

Toshiba Portégé M100
Raise a toast

PnP Ultra-portable
laptop

Performance
Features
Usability
Value for money

A-A-

Price: Rs 69,999
+ Extremely light and portable 
– Expensive for its configuration

Toshiba Portégé M100

Performance
Features
Usability
Value for money

C-C-

Price: Rs 1,79,999
+ Great looks and good performance
– Slightly cramped keyboard
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CATEGORY

TToosshhiibbaa
Portege M100

Pentium M 1.2 GHz
256 MB 

12
40 GB / 4,200

Intel 855
Combo

SoundMax Digital audio
2-USB/✖ /✖ /✔

✔ /✔ /✔ /✔
Monitor D-SUB 

No- four button track point
2
✖

2
Flash memory card reader

265 X 245 X 35
1.9
✖

4
3.5
3
4

3.5

26
39

Windows Xp professional
✖

Toshiba control ultilities
✔

Power adapter

✔

25.7
102

4019
1611

6838
7948

1635
1642

16,876
24
5

23
6
9

110
64
28

1820

3
2 Hrs 55 Min

29.1
27.2
13.5
7.0

76.8

2.1

1,79,990

PPnnPP
Ultra portable

Via 1 Ghz Nehemiah
256 MB

12
40 GB / 4,200

VIA S3 
✖

SoundMax Digital audio
2-USB/✖ /✖ /✔

✖ /✖ /✔ /✔
Monitor D-SUB and S-Video

Yes 2 butons/ scroll
3
✖

2
✖

270 x 210 x 25
1.4

2 scroll buttons
3
3
3

2.5
2.5

26
38

✖

✖

✖

✖

Power Adapter and
Carrycase

✔

14
333

1606
370

Failed
Failed

472
306

15,405
22
3

22
6
13

43
Failed
Failed

331

2.5
2 Hrs 13 Min

19.0
20.3
14.4
3.0
56.7

4.0

69,999
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Brand
Model

Processor (Type and speed)
Memory (Amount) 
TFT Display Screen size (Inches)
Hard disk (Capacity / Speed in rpm)
Graphics adapter
Optical drive 
Sound card
Ports (USB/Serial/parallel/Firewire)
Connectivity (IrDA,WiFi etc,LAN,Modem)
Audio-Video OUT options
Mouse Touch pad and No of buttons
No of Shortcut keys
Extra Batteries provided
Compact Flash slots (nos)
Miscellaneous

UUssaabbiilliittyy
Dimensions (L x W x H) (mm) 
Weight (kg)
Extra Input Devices (wheel, pointing stick)
Build Quality (SO5)
Keyboard Touch and Feel (SO5)
Mouse Touchpad sensitivity (SO5)
Overall Ergonomics (SO5)
Built-in speaker Quality test (SO5)

TTeemmppeerraattuurree
Ambient Temp (Degree celsius)
laptop under surface (Degree celsius)

Operating System bundled 
Office application suite
Other software & applications provided
Recovery CDs
Accessories (carry case,docking station,etc)

User guide
OOvveerraallll  SSyysstteemm  bbeenncchhmmaarrkk
ZD-Bench Business winstone  2002
Video Encoding Test (seconds)

SSii  ssoofftt  SSaannddrraa  ::  CCPPUU  tteesstt
CPU Dryhstone
CPU Whetstone
Multimedia - CPU  Integer
Multimedia - FPU SSE

MMeemmoorryy  tteesstt
ALU / RAM (Int)
FPU / RAM (Flt)

FFiillee  ssyysstteemm  tteesstt
Drive Index (MBps)
Sequential Read (MBps)
Random Read (MBps)
Sequential Write (MBps)
Random Write (MBps)
Average access time (ms)

QQuuaakkee  IIIIII  AArreennaa  ((ffppss))
Normal (640 x 480 x 16) 
High (800 x 600 x 32)
Max (1024 x 768 x 32)
33DD  MMaarrkk22000011  SSEE

Displaymate assorted file test (SO5)
MobileMark 2002 Battery Test

Performance (35%)
Features (35%)
Usability (20%)
Package content (10%)
Overall

Value for money
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Price (Rs)
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Decision Maker

You
need:

Look for:

Our pick:

Price:

Laptop for your desk

A reasonably well-powered laptop
that can replace your desktop PC,
and provide the same amount of
processing power with some bat-
tery backup

Processor above 2 GHz, with atleast
512 MB of RAM, a decent ATi or
nVidia based graphics adapter, 60
GB above hard disk space and array
of connectivity options
Aci Ultima, Aci Emerald Pro, Dell
Inspiron 1100 and Fujitsu LBC 2220
Rs 74,000 to Rs 1,25,000

An office laptop

A sturdy, light, decently config-
ured laptop that can run most
of your office, and also has wire-
less connectivity. Centrino
based laptops would be great
choice
A laptop with 1.4 GHz Pentium
M processor, at least 256 MB of
RAM, 40 GB hard disk and a bat-
tery life of more than three hours

IBM T40, HP-Compaq Nx9000,
Wipro Little genius and Zenith 4x
Rs 70,000 to Rs 1,75,000

Laptop for travellers

An extremely light, portable lap-
top that can be used anywhere, is
easy on shoulders and allows you
to do most of your office work
plus browsing Via hotspots

Anything that weighs 1.5 Kgs or
less, is built around the Centrino
platform and at least three hours
of battery life

Toshiba M100, IBM T40 and 
PnP laptop.
Above Rs 1,00,000

Laptops for flaunting

A laptop that looks like a dream,
has a high flaunt value and dif-
ferentiates you from the crowd

Tablets or convertibles laptops,
with certain exceptions in
mainstream laptops

Toshiba Portege 3500, Acer
C110 and Hp-Compaq nx-9000
Above Rs 1,50,000

Contact details
Brand 
Contact
phone 
Fax
Email
Website

Brand 
Contact
phone 
Fax
Email
Website

Brand 
Contact
phone 
Fax
Email
Website

Aci
ACI Asia Ltd
022-56943260 / 56407000
022-26733119
sales@aci-asia.com
www.aci-asia.com

Fujitsu
Aci infocom Ltd
022 - 2826 6031/32
022 - 28250674
sales@aciinfo.com
www.fujitsu.com

Toshiba
HCL Infosystems Ltd
0120-4544534
0120-4533877
notebook@hclinsys.com
www.toshiba.com

Acer
Acer India Pvt Ltd
080 5219531-34
080 5219537
diptarup_chakraborti@acer.co.in
www.acer.com

IBM
IBM India Ltd
080 2063199
080-2063702
sanmenon@in.ibm.com
www.ibm.com

Zenith
Zenith Computers Ltd
022-28377300
022-28377297
one-up@zenith-india.com
www.zenith-india.com

Apple 
Apple Computer International Pvt. Ltd.
080-5550575
080-5550660
indiainfo@asia.apple.com
www.apple.com

Hp-Compaq
Infobahn Technical Solutions India Ltd
022-28500821
022-28511681
info@infobahnindia.net
www.hp.com

PnP
Plug N Play Technologies
022- 5634 8784
022-5634 0276
sales@plugnplaytech.com
none

BPL
XServe India Pvt Ltd
080-5572601/02
080-5572603
info@xserves.com
None

Wipro
Wipro Ltd
080-8440011
080-8440031
littlegenius@wipro.com
www.wepindia.com

Dell
Dell Computers Asia Pvt Ltd
1-600-33-8044
080-5586107
marketing_response@dell.com
www.dell.com

Conclusion
Ultra-portables are made with one purpose in mind—portability for
frequent travellers. Miniaturisation leads to increase in the price,
and hence these devices are very expensive, making them quite a
rare commodity. But the scene is changing rapidly, and nearly all
vendors such as IBM, HP-Compaq, Dell, Toshiba, etc., have come out
with a range of ultra-portables based on the new Centrino platform.
This platform offers smaller chips with higher processing power and
lower power consumption. It also offers wireless connectivity, thus
greatly improving any mobile device that runs on Centrino. The
Toshiba M100 featured in this shoot-out was the only ultra-portable
from a reputed brand; the PnP brand laptop, on the other hand,
comes from an Indian vendor who assembles them in India, and cur-
rently has a presence only in Mumbai. 

The Toshiba M100, despite being an ultra-portable, had some
distinct features such as the inclusion of the optical drive with-

out significant increase in the bulk, the champagne finish and
exclusion of touchpad. On the pure performance stake, it betters
even the thin and light category winner IBM T40 and there is no
doubting its abilities when it comes to the task. The omission of
the touch pad was felt badly initially, but the well placed track
point compensated for the loss. The price of the M100 is a bit
steep, but that’s what they cost. Whereas on the other hand, the
PnP laptop just can’t match the Toshiba in either performance or
features. This was the only laptop weighing below 1.5 Kgs, and
allows great mobility. The PnP does its job, provided you use it as
it was meant to be—any diversion here and there, and it will go
bonkers. You can probably get a laptop with a much better con-
figuration for the same price, but nothing that will offer you the
same portability.

SANKET NAIK

sanket_naik@thinkdigit.com
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You can save a bundle by opting for an alternative to MS Office, but will you be able to exchange files
with the MS Office users all around you? We test five of the best Office alternatives for exactly this...

Office productivity applications
have an importance that sim-
ply can’t be ignored. It would-
n’t be an overstatement to say

that offices can’t survive without a decent
set of these applications. And the
moment you think of office suites, the
one that comes to mind is Microsoft
Office—the undisputed market leader.
Heavy price tag, and frequent upgrade
cycles have prompted MS Office users to
look at alternatives. Their major concern
is the compatibility of these alternatives
with the native MS Office file formats of
.doc, .ppt, and .xls.

There have always been arguments
as to why other office suites should have
MS Office compatibility built into them.
And while different people have differ-
ent opinions on this, it’s reasonable for
organisations and individuals to expect
a fair amount of compatibility from

these suites. The reason for this is that
even if the native file formats of these
applications are superior to those of MS
Office, people still have to be able to
work with existing office documents,
which will, without a doubt, be in MS
Office formats.

Our purpose here is to evaluate the
level of compatibility offered by various
alternative suites with MS Office XP files.

The office suites we picked for this
test were the best alternatives to be
found currently across multiple operat-
ing systems—Windows or Linux, to be
precise. A few years ago, this test would
not include any Linux office software,
because of their rudimentary support for
MS Office file formats. But now, with
products such as StarOffice and OpenOf-
fice.org coming up on Linux, this is no
longer the case. A brief introduction to
all the contenders follows:

StarOffice 7: StarOffice 7 is based on
the OpenOffice.org project. In the Word
documents test, it performed similar to
OpenOffice.org; it had the good as well
as the bad features. For one, it takes ages
to load and keeps on popping up extra
untitled documents each time a new
document is opened. 

OpenOffice.org 1.1.0: OpenOffice.org
1.1, a free downloadable (www.openof-
fice.org), is a major improvement over pre-
vious versions. The current version
incorporates several features from StarOf-
fice 7. The results, therefore, were quite
similar to what we got with StarOffice 7.

Ability Office: Ability is an office soft-
ware suite which includes packages that
help increase productivity. The said
packages include Write, Spreadsheet,
Database and Photopaint. Except for the

IMAGING : Parag Joshi
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Compatibility among applications can be
judged on two grounds: functional and pro-
cedural. Functional compatibility is the abili-
ty of the software to emulate the functional
capabilities of other software. Procedural
compatibility is the software’s  ability to
enable one to do the same job, using simi-
lar steps. Functional compatibility is
required to ensure that the software works
with the existing application. Procedural
compatibility, on the other hand, reduces
the time required to re-train oneself when
migrating to the new application. Here, we
only tested the functional compatibility of
the alternative suites with MS Office. Hence,
the testing  concentrated on the ability of
the alternative suites to open existing Word,
Excel and PowerPoint files, make changes to
them, save them and finally, let them open
again in MS Office. The files were created to
take into consideration the limitations that
vendors face while ensuring MS Office com-
patibility. We therefore included only a bare
minimum of the set of features that MS
Office offers, compatibility with which is
essential in any office environment. The
more advanced of features were left out.

The test documents came under two cat-
egories: ones that were created by us, and
ones that were downloaded from the Inter-
net. The ones downloaded from the Internet
contained a lot of graphical diagrams and
mathematical equations. The mathematical
equations range from very simple ones to
highly complex nested equations.

Each document that opened without
any errors scored five points; those with
minor errors scored three points; those
with major errors, but which were still
operable got one point; while documents
which were unopenable scored
zero for the suite.

Word Processors: In the case
of word processors, text for-
matting is very important. So,
the main test document con-
sisted of text written in a variety
of fonts, with varying font sizes
and formatting. In certain places, the back-
ground and foreground colours were
reversed. Almost all the other test docu-
ments had images, screenshots and dia-
grams, and the ability of the word
processor to display these was tested. In
total we tested each suite with 10 docu-
ments. Some screenshots had callouts
describing the various components, and

the ability of the applications to render
these was also tested. In total, there we’re 

Spreadsheets: Here, correct reproduction of
formulas and embedded graphs was given
top priority. We used nine documents to test
this category. Many of the test documents
were designed to test the ability of the appli-
cations to open multiple worksheets in a sin-
gle spreadsheet. These had formulas
referencing multiple worksheets, and also
used graphs that were cross-referenced to
other worksheets. One test spreadsheet had
complex functions and
basic Windows widgets
(simple controls such as
buttons) embedded. We
didn’t expect it to work on
Linux-based applica-
tions—they were specifi-
cally meant for Windows.

Presentations: The PowerPoint presentation
files were used to check the ability of the
alternative presentation tools to correctly
display the content of the slides. Both the
quality, as well as the precision of the dis-
played slides, was evaluated. We used 12
presentations to test this category, one of
which was designed to check the ability of
the software to reproduce colours and tran-
sition effects. Another presentation tested
graph capabilities. This presentation consist-
ed of various types of graphs. It starts off

with simple bar graphs, and proceeds
towards more complex graphs. In each
graph type, both a 2D as well as a 3D ver-
sion of the same graph was used. Several
slides had embedded foreground and back-
ground images, along with text displayed
using sliding effects, and the correct repro-
duction of these was given weightage.

Classification of errors: Errors in documents
were classified as fine, minor, major and
unusable. Documents displayed with hardly
any errors were listed as ‘fine’; those with
very few mistakes were listed as ‘minor’.
Slightly more complex errors that spoilt the
user experience were classified as ‘major’.
‘Unusable’ errors were ones that rendered
the document unusable.
For example, in the case of presentations, if
the background image was not displayed in
the same way as in the original, the error
was considered as ‘major’, since the purpose

of putting a background image in a presen-
tation is to reduce its prominence, and to
give a subtle effect.

In the case of Word documents, the rules
were slightly different. If, for example, an
image was slightly misplaced, the error was
classified as ‘minor’. But if it was completely
misplaced and, say, overlapped with the

text, it was considered ‘unusable’. However,
in documents where the images were simple
but highly relevant to the text, the absence
of even a single image was considered an
‘unusable’ error.

In the case of spreadsheets, the ability of
the software to correctly understand formu-
lae and display embedded graphs was given
more importance than minor formatting
errors. But certain places where formatting
was more relevant, such as cells merged to
indicate common data under a single head-
ing, were given high importance.

➜

How We Tested

Merged cells were
given more impor-
tance since they indi-
cate major cate-
gories, and con-
tribute to the overall
impact of the data

Background images
were given more
importance while
evaluating presen-
tation software

In word processors,
slightly misplaced
images were given less
importance than com-
pletely misplaced ones
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missing presentation tool, Ability Office
has all the tools required for day-to-day
office tasks.

Corel WordPerfect 11: Corel Word-
Perfect consists of three components—
WordPerfect 11 is the word processor,
Quattro Pro 11 is the spreadsheet tool
and Presentations is the presentation tool.

Lotus SmartSuite 9.8: Lotus Smart-
Suite consists of a group of applications
that also include office software. The
office components include Lotus 1-2-3,
WordPro and FreeLance Graphics. Apart
from these, the other applications includ-
ed are Lotus SmartManager, an informa-
tion management tool; Lotus Approach,
a database; Fastsite, a Web publishing
application; and a time management tool
called Lotus Organizer.

WORD PROCESSORS

StarOffice 7 Writer
Star of formatting

StarOffice Writer offered the best com-
patibility with MS Word documents.
While the displayed text was not as crisp
as in MS Word, there were very little for-
matting errors. It was also able to display
a majority of the images and diagrams in
the test documents. Strangely though, it
had problems displaying some of the

simple images that were similar to the
ones it displayed perfectly. It also had
problems displaying a majority of the
callouts on the screenshots.

Ability Write:
Symbolically handicapped

Ability Write has good compatibility
with documents that are a simple mix of 
text and images. The displayed text and 
formatting in Write was more or less sim-
ilar to the one in the original document
opened in MS Office, except that a few
symbols were changed at some places.
But it did have trouble displaying para-
graph headings with exactly the same
formatting.

But there were other problems too.
Ability Write couldn’t properly align the
bullet lists in some of the test documents,
and had a problem displaying footnotes.
The footnotes were displayed at the place

of reference, rather than at the end of the
page. A majority of the embedded images,
too, were not displayed. 

While bullet lists just had problems
with alignment, the numbers in num-
bered lists were simply not incremente—
it showed ‘1, 2, 3’ as ‘1, 1, 1’. One of the
few images that were displayed didn’t
have proper labelling in place.

A peculiar problem observed in Abil-
ity office was that after continuously
opening and closing a few documents, it
could not open any more documents—
they all opened up as blank documents.
Restarting the application solved the
problem. At places it had problems with
formatting, it displayed several headings
as normal text.

Ability Write could not hold it all
together in a good way. While it dis-
played a majority of the embedded
images and screenshots, it could not give
the documents the same effect that MS
Word gives. Overall, this is a product that

StarOffice Writer managed to display almost
all the embedded images, with decent quality

Callouts on embedded screenshots were not
displayed properly

Footnotes were displayed in place, in between
the text, instead of at the bottom of the page

In spite of its good compatibility, StarOffice
missed out on some of the diagrams

The text formatting and displayed images
were generally good, except for headings and
a few formulas

The callout
in this
image was
not visible
in Ability
Write

Ability Write had no
problems displaying
a majority of the
graphs, but its ren-
dering of the pie
chart was not satisfactory

Some of the formatted text, such as headings
and bold characters, were not displayed prop-
erly in Ability Write
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could do with a few improvements.

Corel WordPerfect 11
Nearly perfect

WordPerfect renders text perfectly, and
you can’t differentiate it from the text
displayed in Word. It also fared well in
the document with the complex table.

The placement of images in the doc-
ument was not always perfect, and in
some cases it went completely haywire -
so much so that the original image could
not be identified. In the document used
to test callouts on images, the image itself
was not displayed properly, and callouts

were completely lost.
Lotus WordPro
Irresponsible with images

WordPro was able to display all the
graphs in the test documents. Its render-
ing of the pie chart was the best among
the lot, but it did goof up slightly on a
simple bar graph. Text formatting, for-
mulas, HTML links and placement of
footnotes was also near-perfect. While it
was able to display some of the embed-

ded screenshots properly, diagrams and
images caused problems. It missed out
on a lot of them, and among the ones
that were displayed, a couple of them
were distorted beyond recognition.
These were, typically, diagrams with sev-

Ability Office
lost all the
information
that was con-
tained in this
table in one of
the test docu-
ments

The rendering of text and formatting was
near-perfect in WordPerfect

The callouts
were alto-
gether
absent, and
WordPerfect
couldn’t even
display the
embedded
screenshot
completely

This simple diagram was completely
deformed, and displayed over the original text

A common problem with WordPerfect is com-
plete distortion of diagrams within documents

At places, the alignment of images with
respect to the text was bad

WordPerfect was able to render this complex
table perfectly

Lotus WordPro was able to perfectly repro-
duce graphs, including pie-charts, and it
had problems with just one bar graph

These simple diagrams was deformed beyond
recognition
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eral ellipses and circles.
SPREADSHEETS

StarOffice 7 Spreadsheet
Not a friend of Linux

StarOffice 7 Spreadsheet was able to open
almost all our Excel files without a glitch.

It was also able to dis-
play the document
with complex func-
tions (hlookup), but
as we  expected, it
failed to show the
controls on the work-
sheet. This was not a
glitch in the software;
since the controls

used were native Windows controls—
there was no way it could be used on
Linux. Other than this, StarOffice Spread-
sheet gave decent compatibility, and han-
dled all the files with multiple worksheets,
embedded graphs and referenced formu-

las without major errors.
Corel Quattro Pro 11
Symbol jumble

Of all the tools we tested, Quattro Pro 11
was the best. It could correctly display
almost all the graphs, as well as formulas.
There are slight changes in the way for-
mulas get written— instead of an ‘=’ sym-
bol at the start of the formulas, Quattro
uses the ‘@’ symbol. But it does a very good
job at converting existing Excel spread-
sheets, and doesn’t alter the behaviour of
the formulas. In fact, of all our test spread-
sheets, just one was unusable. This was the
one with the embedded Windows control.

Ability Spreadsheet
Lacking in ability

Ability Spreadsheet was the worst of all the
spreadsheets; only two test sheets had
minor errors, one had major errors and the

Ability displayed vertically merged cells perfectly

Formulas that referred to multiple worksheets
were displayed, but graphs were absent

Ability Spreadsheet completely ignored graphs

While the timeline in this graph was not as
good as it looks when displayed in Excel, it
was good enough to work with

Although the image was properly displayed,
the captions were missing

Some of the diagrams simply refused to not
come up in WordPro

StarOffice Spreadsheet 7 had no problems
displaying multiple worksheets and embed-
ded graphs

StarOffice Spreadsheet was one of the few
applications that could display the directions
in this box exactly as it was in Excel

Word processor scores
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rest were completely unusable. While it
supported multiple worksheets in a single
spreadsheet and understood the formulas
without any errors, the graphs in the
worksheets did not turn up. It also had
minor formatting problems, but displayed

the vertically merged
cells perfectly.
Lotus 1-2-3
Formatically chal-
lenged

Lotus 1-2-3 has an
amazing level of com-
patibility with Excel
files. In the main
sheet, all the data, for-

mulas and graphs across multiple work-
sheets were properly imported. However,
the formulas were written in a completely
different format. When there were prob-
lems with importing, it created and dis-
played a detailed log file. There were minor
formatting errors, though—it didn’t dis-
play vertically merged cells properly.

PRESENTATION SOFTWARE

StarOffice Presentation
A star indeed!

StarOffice Presentation was the best tool as
compared to the other presentation soft-
ware. In PowerPoint slides, StarOffice 7
gave better performance than the other
software, but had problems displaying
some of the custom bullets.

OpenOffice.org Impress
It did impress

This product was very similar to the
StarOffice Presentation tool, and gave
similar results. Overall, however, StarOf-
fice is a better product since it came with
its own java libraries whereas OpenOf-
fice.org didn’t have one. When it came to
custom bullets, OpenOffice.org com-
pletely ignored them whereas StarOffice

replaced them with simple ones.
WordPerfect Presentations11
Far from being perfect

Presentations 11 had problems with the

Lotus Freelance Screenshow had no problems
displaying complex slides, such as the one here

Corel Presentations 11 had a problem display-
ing background images. At places, it displayed
the background image over the foreground text

Lotus 1-2-3 had a problem with merging
vertical cells

Some of the slides could not be reproduced
perfectly by Presentations

Spreadsheet scores

Although it’s good at handling its own
file formats, and offers excellent render-
ing of text, images and tables, Apple
Works has problems in the MS Office
compatibility department. In our word
document tests, AppleWorks wasn’t able
to display simple colours within the
tables in one of the test files; it showed
grey shades in place of the actual green
and red. Moreover, it couldn’t handle the
table layout properly. It had problems in
the standard text formatting test file too;
white text on a black background was
not displayed. As far as presentations are

concerned, AppleWorks can’t handle
PowerPoint files, so there’s no question of
compatibility.

In Excel, Apple Works couldn’t handle
more than one worksheet. The formulas
that used multiple worksheets got altered
when opened in AppleWorks, and the
parts of the formulas that referred to
other worksheets were removed. The
graphs that were linked to the main
worksheet, but displayed in other work-
sheets also weren’t displayed. In sum,
Apple Works simply is not a product
meant for MS Office compatibility.

AppleWorks 6
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transitions test file. While the colours
were displayed properly, it could not dis-
play the contents of the slide. Some of the
transitions, too, weren’t displayed prop-
erly. One of the test files wasn’t opened at

all, and Presentations
gave an error message
saying the file was cor-
rupt; the same file was
opened by the other
office suites. 

Some documents
weren’t imperfectly dis-
played, apparently
because the conversion
filters required to import
the documents were
unavailable, but we got the same errors
even after complete installation of the soft-
ware, with all the filters included.

Lotus Freelance Screenshow
Not a great show!

Freelance ScreenShow had absolutely no
problems with graphs, and displayed all
of them perfectly. But it could not render
transitions and slide effects properly.
Some of the mathematical formulas were
not displayed in their original form.

Conclusion
The level of compatibility offered by the
alternative suites with MS Office docu-
ments varies widely. This even varies to

great degrees amongst
individual components
of suites. These varia-
tions proved costly for
the suite as a whole.

While Quattro Pro
offered good compati-
bility with Excel files,
the other compo-
nents—WordPerfect
and Presentations—

brought the scores down. It managed an
overall score of 64, and was fourth best.
Ability Office, on the other hand, just did-
n’t seem ready at all to handle our tests,
consistently coming in last in all the tests.
Ability ended up with a pathetic overall
score of 21.

While Lotus SmartSuite 9.8 topped the
spreadsheet and word processor  tests, it
was foiled in the presentation test, com-
ing is last. Lotus SmartSuite finished third
overall, with a score of 85.

OpenOffice.org 1.1 and Star Office 7
were the only two real contenders to the
title, and as expected, took the top two
spots. OpenOffice.org was impressive, and
managed to tie with Star Office in the
word processor and spreadsheet tests. Star
Office made a late dash for the finish in
the presentation test, beating OpenOf-
fice.org by 5 points to end up with a
decent overall score of 103. Unlike Star
Office, OpenOffice.org is completely free,
and made a very commendable effort.

In the end, we decided that Star
Office 7 was indeed the best suite as a
whole, and is the best Microsoft Office
replacement out of the lot.

PRAVEEN KURUP

Freelance Screenshow had problems dis-
playing background images

Some of the embedded foreground images
could also not be displayed

While it generally had no problems with
formulas, Freelance Screenshow sometimes
just couldn’t get the layout right

Some of the graphs, too, couldn’t be dis-
played

Presentation scores

Overall scores
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A list of the best products in different 
hardware and software categories

CPU
Pentium 4 3.2 GHz 
800 MHz FSB
+ Supports 800 MHz FSB and
Hyperthreading
- Very expensive
Contact: Nebula Technologies
Phone: 022-26848612
E-mail: pratik@nebulatech.com
Price: Rs 37,000

Motherboard
865PE Neo2 
+ Great performance, dual-chan-
nel DDR 400
- Expensive
Contact: Cyberstar
Phone: 080-2276986
E-mail: narend@cyberstarin.net
Price: Rs 12,500

Primary Storage
Maxtor 250 GB MaxLine
Plus II
+ Tons of space
- Gets heated
Contact: Cyberstar
Phone: 011-6438216
E-mail: yogi@maxtor.com 
Price: Rs 19,000

Secondary Storage
Combination Drive
Sony CRX 300A
+ Top performance, 
vertical mountable, 
half height, Mt. Rainer support
- No CD-R or CD-RW media
Contact: Rashi Peripherals
Phone: 022-28260258
E-mail: ho@rptechindia.com
Price: Rs 5,200

Input Devices
Microsoft Multimedia
Keyboard
+ Great feel
- Expensive
Contact: Microsoft Corporation 
Phone: 011-5151 1234
E-mail: connect@microsoft.com
Price: Rs 1,498

Graphics Card
Gainward GeForce 
FX 5900 Ultra 256 MB
+ Unmatched performance
- Very expensive
Contact: Mediatech India
Phone: 022-56396696
E-mail: sales@mediatechindia.com
Price: Rs 37,875

Sound Card
Creative SoundBlaster
Audigy 2 Platinum 
+ 6.1-channel output
- Expensive
Contact: Creative Technology Ltd
Phone: 9820357713
E-mail: rajshekhar_bhatt@ctl.
creative.com 
Price: Rs 15,199

Speakers
Creative MegaWorks 
THX 5.1 550 
+ Mindblowing sound
- No digital inputs
Contact: Creative Technology Ltd
Phone: 9820357713
E-mail: rajshekhar_bhatt@
ctl.creative.com 
Price: Rs 25,999

Display
LCD Monitor
SONY SDM-N80 18.1-inch
+ Stylish, great performance
- External power supply takes up
extra space
Contact: Rashi Peripherals
Phone: 022-28260258
E-mail: ho@rptechindia.com
Price: Rs 1,47,000

The A-List

Microsoft Wireless
IntelliMouse Explorer
+ Optical Mouse, USB interface,
two extra buttons
- Expensive
Contact: Microsoft Corporation
Phone: 011-5151 1234
E-mail: connect@microsoft.com
Price: Rs 4,278

Products that topped
our performance tests

Laptop
IBM T40
+ Great design, excellent per-
formance
- Expensive
Contact: IBM India Ltd
Phone: 080 2063199
E-mail: sanmenon@in.ibm.com
Price: Rs 1,69,990

Brandedc PC
Zenith Premium PC
+ 3.2 GHz, 17-inch LCD
- No Operating System
Contact: Zenith Computers Ltd 
Phone: 022-2837 7300
E-mail: one-up@zenith-
india.com 
Price: Rs 60,000

Multi-functional
Device
Xerox WorkCentre
Pro 412
+ Fast printing, excellent qual-
ity
- Expensive
Contact: Xerox Modicorp
Limited
Phone: 0124-2561930/ 940
E-mail: kuldeep.malhotra@
ind.xerox.com
Price: Rs 73,500

Laser Printer
Samsung ML-1710
+ Extremely fast
- Does not support USB 2.0
Contact: Samsung Electronics 
India information and
Telecommunication Ltd 
Phone: 011-51511234
E-mail: farrukh@ 
samsungindia.com 
Price: Rs 16,000

Inkjet Printer
Canon S530D
+ Supports direct printing from

digital cameras
- Expensive
Contact: Canon India Ltd 
Phone: 011-26806572
E-mail: rajeev.singh@
canon.co.in  
Price: Rs 24,995

Scanner
HP Scanjet 4570C
+ Excellent scan quality
- Heavy and bulky
Contact: HP India Ltd
Phone: 011-26826000
E-mail: ashwini-k_aggarwal@
hp.com
Price: Rs 17,999

PDA
Sony CLIE PEG-TG50
+ Runs Palm OSS and has a
320 x 320 TFT LCD display
- Rapid battery consumption
Contact: Solar Systems
Phone: 022-56916834
E-mail: solarsystems@vsnl.net
Price: Rs 25,500

Mobile Phone
Sony Ericsson P800
+ Easy and intutive navigation
- Blocky design makes it bulky
Contact: Sony Ericsson Mobile
Communications International
Phone: 011-26180808
E-mail: sudhin.mathur@
sonyericsson.com 
Price: Rs 35,400

Digital Camera
Canon IXUS 400
+ Cerabrite body, better 
buttons layout, wide shutter
speed range
- Ultra compact body 
hampers handling
Contact: Canon India Pvt Ltd 
Phone: 011-2680 6572
E-mail: Shyam@canon.co.in 
Price: Rs 49,995

MP3 Player
Apple iPod
+ Hard-drive based, FireWire
cable bundled, line-out socket
- Very expensive
Contact: Apple Computer
International Private Limited
Phone: 080-555 0575
E-mail: indiainfo@asia.apple.com
Price: 30 GB-Rs 45,000, 15 GB-
Rs 36,000, 10 GB-Rs 28,000
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Secondary Storage
CD-Writer
Benq CRW5224W
+ Cheap
- Data cable not bundled
Contact: BenQ India Pvt Ltd
Phone: 022-25705231
E-mail: salesenquiryin@benq.com
Price: Rs 2,800

Speakers
Adcom ACSPSW-660 2.1 
+ Two satellite speakers and one
mini sub-woofer, good gaming
performance
- Maximum volume causes
distortion
Contact: SABS
Phone: 022-23808564
E-mail: sabs@vsnl.net 
Price: Rs 550

CPU
AMD Athlon XP 1800+
+ Sufficient power for normal
desktop use
- Difficult to install the heat sink
Contact: AMD Far East India Ltd
Phone: 011-26238620
E-mail: amd@surfgold.com
Price: Rs 3,200

Motherboard
ASUS A7S266
+ Supports DDR and SD, onboard
video, onboard sound, onboard
graphics, USB 2.0
- Not appropriate for gamers
Contact: Neoteric Infomatique
Phone: 022-24172600
E-mail: sales@neoteric-info.com
Price: Rs 3,500

Primary Storage
Samsung SV1203N 120 GB
+ Noise Guard and ImpacGuard
- 5400-rpm drive
Contact: Samsung Electronics
India Information
Telecommunication India Pvt. Ltd
Phone: 011-515111234
E-mail: marketing@
samsungindia.com
Price: Rs 6,900

Display
CRT Monitor
LG StudioWorks 700S
+ High resolutions, 
great performance, anti-static,
anti-glare, anti-reflection surface
treatment
- No extra accessories
Contact: LG Electronics India 
Pvt Ltd
Phone: 0120-2560900
E-mail: response@lgezbuy.com
Price: Rs 7,500

Branded PC
HCL EzeeBee
+ Winner of Best Value and
Best Performance
- Needs a better graphic card
Contact: HCL Infosystems Ltd
Phone: 0120-2520977
E-mail: raman@hclinsys.com
Price: Rs 27,490

Laptop
ACI Ethos 4
+ Good configuration for
the price
- Hampered ergonomics
Contact: Allied Computer 
International (Asia) Pvt Ltd 
Phone: 022-56943260/
26733124/ 56407000
E-mail: sales@aci-asia.com  
Price: Rs 54,000

Multi-function
Devices
HP PSC 2110 
+ Good print quality
- No fax capabilities
Contact: HP India Ltd
Phone: 011-26826000
E-mail: seema.dawar@hp.com
Price: Rs 9,999

Laser Printer
Samsung ML-1510 
+ Good image quality
- Slow print speed for combo
document
Contact: Samsung Electronics
India Information and
Telecommunication Ltd
Phone: 011-51511234
E-mail: farrukh@
samsungindia.com 
Price: Rs 9,999

Inkjet Printer
HP 3325 Deskjet
+ Very small form factor
- 765 KB of buffer memory
Contact: HP India Ltd   
Phone: 011-26826000
E-mail: ashwini-k_aggarwal@
hp.com 
Price: Rs 2,999

Scanner
HP 2300 Scanjet
+ Low warm-up time
Contact: HP India Ltd  
Phone: 011-26826000
E-mail: ashwini-k_aggarwal@
hp.com
Price: Rs 3,499

PDA
Palm Zire 71
+ Affordable, good battery life,
comprehensive PIM applications
- No Palm Universal Connector,
no backlight, no expansion slots
Contact: Tech Pacific Technology
(India) Limited 
Phone: 022-55960101
E-mail: aparna@corvoshandwick.
co.in
Price: Rs 7,500

Digital Camera
Kodak DX6340
+ 3.1 megapixel camera with 
4X optical zoom
- Only 16 MB memory 
Contact: Neoteric Infomatique
Phone: 022-24172600
E-mail: rajeev@neoteric-info.com 
Price: Rs 23,900

Mobile Phone
Sony Ericsson T200
+ Light-weight, perfect grip,
WAP 1.2.1 browser and 
43.2 Kpbs GPRS, PIM features
- Keys are hard and noisy,
unusual socket for the charger
Contact: Sony Ericsson Mobile
Communications International
Phone: 011-26180808
E-mail: sudhin.mathur@
sonyericsson.com 
Price: Rs 6,495

MP3 Player
Ennyah Digisound II
DS601
+ Fast data transfer, feature-rich
Contact: Great World Tech 
Pvt Ltd
Phone: 022-23892828
E-mail: sales@gtechworld.com
Price: Rs 6,500 (approx)

Graphics Card
Compro Paladyne FX 5600
128 MB
+ DirectX 9.0 compatible
- Very expensive
Contact: Mediatech India
Phone: 022-56396696
E-mail: sales@mediatechindia.com
Price: Rs 11,275

Products that are 
the best value buy

Input Devices
Samsung PC Keyboard
+ Unmatched value for money
- No multimedia buttons, wrist
support not bundled
Contact: Samsung Asia Pvt Ltd
Phone: 022-22814886
E-mail: marketing@samsungindia.
com
Price: Rs 300

Logitech Scroll Mouse
+ Ambidexterous design
Contact: Rashi Peripherals
Phone: 022-28260258/ 59
E-mail: ho@rptechindia.com
Price: Rs 475



Price: Rs 14,800
Contact: Monarch Video Vision
Phone: 022-2261 9022
Fax: 022-2261 8706
Email: viren@bom2.vsnl.net.in
Website: www.monarchvision.com

Monarch MV-20

Performance
Features
Ease of use
Value for money

B+B+
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We test the latest and the best hardware and software products available in the market 

The MV-20 is an affordable
and versatile video capture

card. It offers support for cap-
turing videos directly to DVDs.
It has both S-video in and
out connectors, and also
Composite in and out con-
nectors. Stereo mini jacks
are provided for audio line-
in and line-out. With such
an assortment of connec-
tors, you can do profes-
sional-level video editing
with ease.

The card can take
video input from the
either a VCR or your DV cam-
era, and transfer the video to
your computer. You can then
save it in a format of your
choice. The options provided
are quite a few, including
MPEG-1, MPEG-2 and DVD
PAL. After you capture the
video, you can edit it using
the bundled Ulead VideoStu-
dio software. The software
offers numerous effects and
transitions that you can
apply with ease. You can also
edit the audio to make it
more professional. The appli-
cation interface is pretty
straightforward.

You can also take snap-
shots of your videos, which
you can use to make jewel
cases, or view as a slideshow.
This is especially useful for

video professionals who make
marriage and other family
function videos. To put all this
on to a DVD, Monarch uses

the Ulead DVD MovieFactory
software. The application pops
up when you click the Make
DVD/VCD button, and all you
need to do is follow the
instructions.

With this card, you can
also connect your VCR or DV
Camera to a computer, and
watch the output on TV while
the card does its job. Such
functionalities will definitely
be appreciated by users and
professionals alike, especially
at its reasonable price.

SPECIFICATIONS

Output formats: DVD, VCD
and SVCD, onboard bright-
ness, contrast, hue and satura-
tion controls, 2 RCA jacks for
Composite, 2 for S-video, 2 3.5
mm stereo audio jacks.

Monarch MV-20
Precious moments on DVD

MSI GeForce FX 5600 128MB
Authoritative performance

Price: Rs 13,000
Contact: Cyberstar Infocom Ltd
Phone: 080-2276986/ 226781
E-mail: narend@cyberstarin.net 
Web site: www.msi.com.tw 

The FX5600-VTDR128 is
based on nVidia’s FX5600

chipset.  As usual, MSI’s offer-
ing is packed to the gills with
free games, remote control,
VIVO connectors, composite
and S-video cables, etc. To top
it all, you also get two soft-
ware discs—Restore-It and

WinDVD.

T h e
installation was
hassle free. The card runs
at a core clock speed of 325
MHz, while the memory
clock speed is 275 MHz with
a memory bandwidth of 8.8
GBps. This card sup-
ports DirectX 9, so you
can happily play all the
up and coming games,
with all the eye-candy
turned on too.  

We ran the usual
assortment of tests on
this card, and boy did this
card run them. If you want to
play all your favourite games
at high resolutions, this card
will definitely not disappoint
you. Though our perform-
ance winner in the last com-
parison—the Gigabyte 9600
PRO—remained the top scor-

er in all the tests, the MSI did
give it some close competi-
tion. The Gigabyte soared in
the 3DMark 2003 tests with a
score of 2798, while the MSI
scored only 2248, but the
MSI maintained a lead of
about 29 fps in the Serious
Sam and Quake III Arena tests.

Overall, the Gigabyte
card just about managed to

hold on to its
crown, as the
MSI is a great

product. How-
ever, they need to

revise the price of
the GeForce FX 5600

if they want to make
an impact. We suggest

you wait a bit till the
price drops before snatching
up this beauty.

MSI GeForce FX 5600
128MB

B+B+

Performance
Features
Build quality
Value for money

SPECIFICATIONS

GeForce FX 5600 chip; 
325 MHz core clock speed; 
275 MHz memory clock; 
1.3 billion texels/sec fill-rate;
DX9/OpenGL 1.4 compliant

* Higher is better
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If you want to make a fash-
ion statement, this little

beauty is for you. The crystal-
clear 16-bit display ensures
perfect readability, which,
however, is slightly affect-
ed by the sun. A tiny mir-
ror on the back panel
allows you to take your
own picture. A big plus
is that even at the weak-
est signal strength,
voice is astoundingly
clear.

The address book
allows you to store
510 contacts with 8
entries each. The
phone allows you to
store a little over 2 MB of
data, if you remove the pre-
defined set of items. You
might think this is too little,
but it should be enough, for
several reasons. There are a
couple of bundled games;
there’s a service that lets you
upload your images to the
Sony Ericsson server, which

allow you to free up space;
and there’s a static memory
for the phone and SMS and
voice tags.

Text messages can be
printed via a Bluetooth con-
nection, and also saved to the
SIM. Support for long mes-
sages is also provided, so you
aren’t stuck to the 160-char-
acter limit. However, the
‘Send To Many’ function is
missing, which means that if

you want to send a message,
you have to manually hunt
down each contact you want

to send your message to.
The MMS editor
in this phone
is better imple-
mented than in
most. It also
allows you to
block advertise-
ments and mes-
sages from
anonymous users.

There’s a DJ
mixer, using which
you can create your
own tunes. The pre-
defined tunes are

nice, and moreover,
since the phone supports 32-
bit or ‘true tones’, the sound
is refreshingly clear. The bat-
tery will last 3 days with nor-
mal usage, and upto 5 days
with minimal usage.

The T610 is not perfect,
though. Newer phones allow
you to view SIM and phone
data simultaneously; this
phone doesn’t. The image
quality of the camera is no
great shakes; the resolution is
only 255 x 388. Another
thing that’s missing is a pro-
gram to back up your SMSes,
WAP profiles, etc.

But all in all, if you’re
planning to buy a colour
phone with loads of features
at a reasonable price, you
need look no further.

Sony Ericsson T610
Talk in style!

SPECIFICATIONS

16-bit display, 2 MB memory,
95 grams, Tri-band, GPRS and
HSCSD, 32-bit polyphonic
sound, support for Java and
Mophun games

Price: Rs 19,995  
Contact: Sony Ericsson India 
Phone: 011-2618 0808
Fax: 011-2618 7878
Email: dhiraj.soni@sonyerics-
son.com

Sony Ericsson T610

Performance
Features
Ease of use
Value for money

A-A-
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The Click Plus mouse is
ergonomically shaped,

albeit only for the right-
handed. Its contours are
slightly curved at the top,
making it a little uncomfort-
able for people with small
hands. The mouse looks
good, with a blue and silver
body, instead of the staid
white or beige. The buttons
themselves are very well
calibrated, and respond
very well too. Besides
the standard right and
left buttons and the
mouse wheel, the mouse
also features a tiny extra but-
ton just beneath the mouse
wheel, and two thumb but-
tons on the sides—putting
six buttons within easy
reach. It can be operated up
to 5 to 6 feet away fromthe
receiver.

The Click Plus mouse
performs very well, and is
very precise in both move-
ment and selection of objects

on the monitor. The scroll
wheel’s movement is slightly
jerky, but definitely
smoother than earlier Log-
itech mice.

The mouse is good for
use with applications such as
Photoshop and
Microsoft Word, but

in our
g a m i n g

test, it was a dif-
ferent story altogeth-

er. The mouse was over-
sensitive, with the crosshair all
over the place; this isn’t really
a mouse meant for a gamer.
Surprisingly, when we tested
the mouse with newer games

Logitech Cordless Click Plus
Just point and click

three LEDs, to indicate the
printer’s operational status, as
well as errors. The 1015 can
connect to a PC through both
the USB and parallel port
interfaces—the cables aren’t
bundled.

Despite the 16 MB buffer,
the 1015’s performance was
mediocre, especially while
printing complex documents.
The combo PDF document was
printed in 19.2 seconds, but
the quality of the printout was

average. It scored even worse
in the image test, with promi-
nent banding seen throughout
the printed photo. The printer
did perform much better in the
MS Word print tests, with

excellent quality and at good
speeds.

The 1015 is targeted pri-
marily at home and SoHo
users. But, with its poor per-
formance in  printing complex
documents, it can only be suit-
able for users with simple print-
ing requirements. Even though
the 1015 looks good on paper,
the  Rs 14,499 price tag is
entirely unjustified.

Price: Rs 14,499
Contact: Hewlett Packard India Ltd
Phone: 0124-256 6111
Fax: 0124-256 6112
Email: seema.dawar@hp.com
Website: www.hp.com

HP LaserJet 1015
Performance
Features
Build quality
Value for money

BB

The HP LaserJet 1015 is eas-
ily one of the most com-

pact and lightweight laser
printers available, tipping the
scales at just 5.9 Kg. The
printer body is dark blue in
the front and silver-grey on
the sides. The output paper

t ray
c a n ’ t
hold more
than 25 sheets at a time. The
input tray can hold up to 150
sheets, and 10 sheets can be
lined up for manual feed.

The 1015 has 16 MB of
non-upgradeable buffer mem-
ory. The user interface con-
sists of a simple two-button
combination, along with

This printer stands out
from the rest of the

crowd: try this little test. Take
a printout from any inkjet
printer and immediately
pour water on it. Does the
printout stay the same? It
wouldn’t. But it does with
this printer. We actually
tried it!

The printer has a small
footprint, and will fit snugly
on your desk. The interface is
USB, but you also have the
parallel port option. The
paper feed tray is top-loading.
There are three buttons on the
top—one for the power, one
for changing the ink car-
tridge, and one for can-
celling a print.

The text printout was
quite good; however, at
lower font sizes, the dither-
ing is pretty obvious. The
photo quality was average;
the overall image was dark,
but contrast reproduction was
very good. In the text with
image printout, the results
were quite good, indicating
that this printer was built 
primarily to serve as a text

printer, with a sprinkling of
images.

The Epson Stylus C63
retails for a competitive Rs
3,999. Going by the price-to-
performance ratio, you can’t
go wrong with it.

SPECIFICATIONS

232 KB buffer RAM, 17 ppm,
USB and parallel interface,
paper types supported: A4 and
letter sizes and special paper

Price: Rs 4,000
Contact: Epson India ltd
Phone: 022-2826 1515
Fax: 022-2825 7287
E-mail: bertha@eid.epson.co.in
Web site: www.epson.co.in

Epson Stylus C63

Performance
Features
Build quality
Value for money

A-A-
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SPECIFICATIONS
RF, optical sensing technology,
PS/2 or USB interface for RF
receiver, three extra customis-
able buttons, ergonomic
design for right-handers, two
AA batteries included.

SPECIFICATIONS
133 MHz RISC processor,
16 MB buffer, 14 ppm,
USB 1.1/IEEE 1284, PCL 5/e
and host-based drivers, media
supported: A4, envelopes,
transparencies, postcards

Epson Stylus C63 
Smart impressions

HP LaserJet 1015
Hardly jet-set
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Ulead Photoimpact XL
offers a little bit of every-

thing—from full-fledged
image editing to designing
Web-page effects, to improv-
ing photos taken by digital
cameras. The
software has a
very handy and
one-step tool,
called Express-
Fix, which can
analyse photo-
graphs and
automatically
display the cor-
rect options for
retouching and
restoring them,
all within a few seconds.
Images can be imported from
a wide range of media, such
as digital cameras, scanners,
or straight off the Net.

Special effects and filters
can be simply dragged and
dropped on to a palette man-
ager, which also allows for a
quick preview of the selected
filter. Photoimpact also boasts
of some very useful, creative
effects such as lightning and
meteor showers, which can
be animated effortlessly.

With all its features, Pho-
toimpact XL does have some
serious limitations. The main
disadvantage is its inability

to work with the CMYK
image format. On opening a
CMYK file, the software
immediately converts the
image into 48-bit RGB, which
is very inconvenient for pro-

f e s s i o n a l s
involved with
h e a v y - d u t y
editing. Also,
the interface
could do with
some tweaking.

Ultimately,
although Pho-
toimpact XL
can do with a
little improve-
ment, its huge

repertoire of tools, along
with its uncomplicated and
savvy design, make it stand
out from the crowd of mid-
level image editors. Consid-
ering the high price of the
recently released Adobe Pho-
toshop Creative Suite, Pho-
toimpact XL, with its com-
paratively low price is a good
purchase choice.

Ulead Photoimpact XL
XLent Impact

SPECIFICATIONS

Microsoft Windows XP, 98SE,
NT 4.0 SP6, 2000, ME, Intel
Pentium II or better, 64 MB
RAM (256 MB recommended),
450 MB hard drive space

Price: $89.95 (approx. Rs 4,100)
Contact: Micrographics
Phone: 9886082075
Fax: 011-2201590
E-mail: micrographics@vsnl.com
Web-site: www.asiapac.ulead.com

MSI 865PE Neo2 B+B+
Performance
Features
Ease of use
Value for money

1/2 p V AD

such as Halo, it gave much bet-
ter results.

The Click Plus cordless is
a great product, with its cool
looks and impressive features.
But considering the mixed

results in the gaming tests,
usability may be restricted to
mainstream office applica-
tions, and applications such
as image editing software.

Price: Rs 4,300
Contact: Logitech Far East Ltd.
Phone: 022-2490 5149
Fax: 022-2490 4145
Email: response@logitech.com
Website: www.logitech.com

Logitech Cordless 
Click Plus
Performance
Features
Ergonomics
Value for money

BB
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tacular. The quality
of keys in terms of
tactile feel is very
important, and
though the keys
afford touch typing,
they are a bit tacky,
and tend to get stuck with fast
typing. Similarly, the multi-
media buttons are of thick
rubber, and using them is def-
initely not comfortable. They
also totally lack finesse. 

Priced at Rs 425, the key-
board is not expensive for the
features that are on offer, but

it fails where it matters the
most. Despite its low price
tag, we don’t recommend it.

Price: Rs 425 
Contact: Shree Sagarmatha 
Distrubutors Pvt Ltd
Phone: 011-26428541
Fax: 011-26428540  
E-mail: sagarmatha_dlh@bol.net.in  

SPECIFICATIONS

PS/2 interface; 14 extra multi-
media keys; three application
buttons

Tech Com Keyboard 

Ergonomics
Features
Build quality
Value for money

BB

The HandsPrint A6 pocket
printer is small handheld

printer targeted at laptop and
PDA users. It’s light and comes
with a velvet carry bag. 

The A6 Pocket Printer is
based on thermal printing
technology, and prints on A6
sized papers at a maximum res-
olution of 400 dpi. However,
you always need to use ther-
mal paper to print. Connectiv-
ity to laptops and PDAs is pro-
vided through the serial port
and infra-red. It requires four
AA batteries for standalone
printing, and also comes with
a 230 V AC adaptor.

We printed a regular Word
document from a PC, and it
gave fairly good results. The
smallest fonts were legible,
and there weren’t any
smudges, but the print speed
was somewhat slow. We then
tested it on PDAs from differ-
ent manufacturers. On PDAs

with the Palm
OS, even after installing the
proper drivers, the Pocket
Printer refused to print, for no
apparent reason. 

This product has a price
tag of Rs 5,000, a bit too high
for the functionality it pro-
vides. It’s unique in that it’s
portable, and it does its job
perfectly well. It would be a
wonderful companion for
PDA users, once compatibility
issues are smoothed out.This keyboard is a vanilla

keyboard with some
extra multimedia keys
thrown around for an
upmarket feel. The keyboard
sports a silver body, studded
with black keys with white
inscriptions. The first thing
you notice is the extra but-
tons along the top edge,
which allow you to
c o n t r o l

various features. They allow
you to open the calculator,
My Computer, increase or
decrease the volume, open
Media Player and play your
favourite movies, or even
open your e-mail client or
browser. There is a ‘Sleep’
button to instantly put your
computer into standby
mode. The installation

process is easy, with no
issues at all, and the
software is easy to
configure. 

On the ergonomics front,
the keyboard isn’t really spec-

Tech Com Keyboard 
Keep off!

SPECIFICATIONS

Thermal printing technology,
400 dpi maximum resolution,
A6 format printing, four AA bat-
teries in standalone mode, A/C
adaptor provided

Price: Rs 4,999 
Contact: Pushpam Infotech 
Corporation 
Phone: 9520-4215162  
Fax: 9520-4211279 
E-mail: sachin@pushpam.com  
Web site: www.pushpam.com

HandsPrint A6 
Pocket Printer
Performance
Features
Build Quality
Value for money

B-B-

* Lower is betterThe BenQ M550G GSM
dual-band sports a
c h a m p a g n e -

coloured front facia,
with a black rear
panel. Chrome strips
on the sides make it
look sleek, but com-
promise on grip. The
build quality is bad—
it squeaks when you
press it hard.

One feature that
sets it apart is the
inverted black LCD
display—white text on
a black background, with a
choice of a blue, purple, or
orange backlight. Though
the purple looked gaudy, it
was still the best backlight
for the phone. 

The buttons are placed
tightly, making this phone
a message junkies night-
mare. The four-way naviga-
tion button is sure to give
you dead-clicks. You can
assign different icons for
home, office, fax, etc., for
your phonebook entries. The

phone comes with a charger,
hands-free headset and a CD.

The M550G has voice
clarity comparable to a
Sony Ericsson T100. We
couldn’t check Internet
connectivity, as there
was no data cable pro-
vided. At Rs 5,750, the
M550G is quite cheap
for a phone that has
GPRS and a bundled
headset, but it loses on
aesthetics and build-
quality. Only if you’re on

a shoe string budget, and
want a GPRS enabled phone,
should you consider this an
option.

BenQ M550G
Ony a budgeteer’s option

Price: Rs 5,750
Contact: BenQ India Pvt ltd
Phone: 022-25705230
E-mail: salesenquiryin@benq.com 
Web site: www.benq.com

SPECIFICATIONS

Dual-band; WAP 1.2.1; GPRS;
500 phone book memory; 
79 gms; inverted black LCD;
hands-free kit

BenQ M550G

Performance
Features
Build Quality
Value for money

BB

HandsPrint A6 Pocket Printer
A handy printer

* Higher is better
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is that it does not allow you to
modify the Standard Deduc-
tions Details, thus entangling
you to update the package
each year as the laws change.

It is priced at Rs 3,250,
which in itself is a good price;
but if you need to update each
year and pay a Rs 1,500, it’s
not a good option. The com-
pany provides no free
updates; at the same time, it
doesn’t provide any services
free of cost. You need to pay
service charges, travel charges

and daily allowances.
The final question that

needs to be asked is, after you
buy this product, can you save
more money in tax than the
price of the software, or the
cost of the update every year?

Price: Rs 3,250 (Upgrade Cost 
Rs 1,500)
Contact: Relyon Softech Ltd
Phone: 080-3354600
080-3356605
E-mail: emo@relyonsoft.com 
Web site: www.relyonsoft.com 

SYSTEM REQUIREMENTS
Hardware: Pentium 100 MHz
or higher; 32 MB RAM; 50 MB
free hard disk space 
Software: Microsoft Windows
95, 98, Me, NT, 2000, XP;
Internet Explorer 5 or Later;
Office 97 or Later 

CompTax

Performance
Features
Ease of Use
Value for money

B-B-

CompTax is targeted at
small to medium

accounting firms. Two useful
features are calculation of
advance and self-assessment

taxes, and calculation of inter-
est payable U/s 234A, 234B
and 234C. It also enables
reverse tax calculation, there-
by helping the user prepare a

tax plan.
The software

needs specific tech-
nical inputs at quite
a few locations
throughout the
package. Apart from
these, it is simple to
use. The interface is
very simple. One
aspect that’s lacking

CompTax 
Computing Income Tax Made Easy 

Movie DVSuite 4.0 is part of
the MovieX family of

video-editing tools. It comes
with a complete
video editing
suite, a PCI DV
capture card
with four
FireWire ports
and a FireWire
cable. There is
also some third
party software—
Sonic MyDVD,
which lets you
create DVDs; and a 30-day trial
of Movie3D. 

Installation was a breeze.
The main workspace has
many sub-components, the
most important of these being
the Timeline, browser win-
dow, work window, the effect
box and the preview window.

The timeline has four
video and two audio tracks,
and make the task of inserting
and editing frames very sim-
ple. Apart from this, Movie
DVSuite also has a storyboard
mode that makes importing

clips and inserting transitions
a snap.

While the software packs
a punch as far as features
are concerned, it does
take a beating on the
usability front. The inter-
face is complex, and the
user has to spend time
getting used to it. This
aside, it does provide
some detailed video edit-
ing features.

Professional video
editors can consider this prod-
uct as a cheaper option, but
they will find Adobe Premire or
Ulead MediaStudio more fea-
ture-rich and useful. 

AIST Movie DVSuite 4.0 
Inexpensive, but complex

SYSTEM REQUIREMENTS

Intel Pentium II 400 MHz or
higher; Windows 98SE, 2000,
ME, 2000; also, Windows NT
4.0 with SP 6 if FireWire not
used, 64 MB RAM, 8 GB hard
disk space for video produc-
tion; display card with
OpenGL support; SoundBlaster
compatible sound card

Price: Rs 3,500  
Contact: Access Online Pvt. Ltd.
Phone: 022-23840809
Fax: 022-23840789 
E-mail: cshah@bom8.vsnl.net.in 
Web site: www.aist.com  

AIST Movie DVSuite 4.0 A-A-

Performance
Features
Ease of Use
Value for money

Kodak is the first digital
camera manufacturer to

integrate an Organic LED dis-
play into a camera. OLEDs
save a lot of power, as they
don’t need to be backlit.

The LS633 is a 3.11 mega-
pixel camera with 3x optical
zoom. The camera has 5 pre-
defined modes, so you can
take pictures with ease. It also
has a manual override facility
for prolonged exposure. The
icon-based menu is intuitive;
and browsing is straight for-
ward with the joystick. 

The camera returned
decent images, and didn’t
produce dark pictures with
the Auto setting—which most
cameras struggle to do.
Colours were reproduced pre-
cisely, and it picked up the
details very clearly, making it
good choice for those who are
into product photography. 

Its 37-111 Schneider-
Kreuznach Variogon optical
zoom lens did well in our

Zoom
test. The image was
a little grainy because of the
3.3x digital zoom, but this
happens with more expensive
cameras as well. 

The LS633 is a good buy,
and at a cost of Rs 29,900 with
the bundled Li-Ion recharge-
able batteries, has low run-
ning costs too.

Price: Rs 29,900
Contact: Neoteric Informatique
Phone: 022-2417 2600
E-mail: rajeev@neoteric-info.com  
Web site: www.kodak.com 

Kodak LS633 Digital Camera
Light on battery, great on performance

Kodak LS633 
Digital Camera
Performance
Features
Build quality
Value for money

BB

SPECIFICATIONS
3.1 mega-pixel, 3x optical
zoom, 3.3x digital zoom, OLED
display and Li-Ion battery
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■ undercover

It all started out as a great morning. The
day looked promising. I’d just taken a
sip of my morning coffee, when my

secret-agent communication device
sounded an SOS. Answering the device,
which is cleverly designed to look like a
cell phone, I learned that a friend’s
antique Celeron processor had just died.
He was inviting me to the funeral, which
involved a little newspaper wrapping and
a quick burial in the local dustbin, and
then a desperate trip to find a better
replacement. He had decided on an Intel
motherboard and a Pentium 4 CPU, but
had no clue about what cabinet to buy. 

Not one to miss out on a tech-shop-
ping spree, I met him at the now infa-
mous Lamington Road, in south Mumbai.
A quick scan of my super-secret black
book told me that I was close to a dealer
I had bought from earlier. He didn’t
remember me though, but was polite
enough to lie, “Kaise hain aap? Haven’t
seen you for a long time”. My friend
quickly detailed his requirements—some-
thing large and airy that would hold all of
his 7,65,23,476 peripherals. Off went the
vendor, and disappeared into a secret
crevice that only he knew existed—the
shop could hold three, four if you want-
ed to be better acquainted with someone.
He returned, carrying a rather ordinary
looking beige and blue Frontech mini-
tower cabinet. Priced at Rs 1,250, it had a
300W power supply, which he claimed
was “Full 300W. Substandard nahi hai!”,
and also came with a 1 year warranty. It

had vents for fans, but we weren’t con-
vinced. After another quick disappearing
act, he came back with an Intex cabinet
that cost Rs 1,300. It had adequate drive
bays, a 300W SMPS and a year’s warranty.
Though it had everything that you’d need
such as air vents and fans, many colours
to choose from and a spa-
cious interior, we
weren’t convinced
just yet. We bid him
farewell and moved
on to find a little
more variety.

The next shop we
walked into had a better
feel to it. It was spacious,
had a look of professional-
ism and had a well dressed ven-
dor behind the counter. As soon
as we mentioned cabinets, he
asked what CPU and motherboard
combination we had. “If you are
buying a Pentium 4 it’s fine, but
if you have an Athlon, you
have to be very careful,” he
warned us. “Athlons heat up a
lot more than Pentiums. If you
have other high-end equipment
such as a GeForce graphics
card, it’s going to be hot in
there and you’ll need addi-
tional fans”.  He showed us a Mer-
cury Oscar cabinet for Rs 1,400. It came
with a one year warranty, many cooling
vents at the back and a 300W SMPS. When
we asked to see something better, he

showed us an iBox and an unheard of VIP
brand of cabinets that cost Rs 1,500 each.
The VIP looked really good, and he said it
was a local brand, but had a rock-steady
power supply—good for over-clocking.
The VIP had easy-to-remove sliding panels
and air vents by the dozen. It had every-

thing we needed, but the unheard
of branding sent us shop-hop-

ping down the road.
The next store

looked swanky as well,
but the dealer started
pulling out all these

unheard of brands with
ugly tacky-looking cabi-

nets. They had lights galore,
and looked like they were
designed by the same person
who decorates the insides of
some of taxis. He could see
the look of disdain on our
faces, and asked, “Would
you prefer to see the top of
the line models?” 

What he pulled out then
made us almost squeal with
delight. There are cabinets,
good cabinets and then there
are Antec cabinets. He pulled
out a jaw-dropping model
with thumb screws, remov-

able 3.5-inch bays and screwless lock-
ing for 5.25-inch devices—you can install
just about anything without ever using a
screwdriver. It had vents galore, a 350W
SMPS and a blowhole. Now here’s a real
solution to ventilation. Instead of normal
vents, blowholes on the top of the cabinet
blow air out from just above the CPU fan.
However, it cost Rs 6,500 and he would-
n’t accept my undying gratitude—cash
and credit cards only please.

An hour later, when I finally ran out of
arguments and conceded that my friend
could not sell his mother’s jewellery, we
decided that something a lot cheaper was
best. We were left with two options: either
a Mercury or VIP cabinet. Though I was
more impressed with the features of VIP,
my friend preferred to spend his money of
a better known brand. The Mercury it
was. I went back home dreaming of own-
ing the best Antec there is.

■ Insist on cases with adequate
ventilation, with fixtures to help
you mount fans. Look for rear and

front vents.
■ Get extra fans mounted on the case,

even if you don't intend to over-clock. It will
provide better airflow and make your hard-
ware run smoother and last longer.
■ 300W power supplies are standard and
adequate for today's computers. Look for
steady power supplies, as fluctuations in
the power will cause lockups and damage
hardware. 
■ Choose a large cabinet: either a big

mini-tower, or tower cabinet. Make sure
that it will hold your motherboard—
MicroATX or ATX form factor. This 
aids ventilation and allows easy access 
to hardware. 
■ Screw mounted blanking plates in the
rear (that cover unused bays) are better
than those that have to be broken. You
can reattach these later when a bay is
unused, preventing unnecessary exposure
to dust. 
■ Look for cases with thumb-screws or
slide out access panels that let you open
your cabinet easily. 

ILLUSTRATOR: Mahesh Benkar

A Case of Cabinets
Agent 001 jumps into the world of cabinets
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“640 KB ought to be enough for
anybody”, said Bill Gates in
1981. Things have changed a

lot since then. Storage costs have dropped,
and application sizes have increased. With
the penetration of the Internet into almost
every facet of our lives, online storage has
also grown in popularity—it’s free and
convenient. With that applauded, the
benfits of the service are many—back up,
sharing data and of course, a virtual brief-
case to carry your business around in.

Since like money, no amount of space
is ever enough, online storage is like an
accomodating, omnipresent neighbour—
everything that doesn’t find a place on
your hard disk, can be put online. In lim-
ited measures, naturally. Once housed,
you can share your stuff or transfer it
across geographics.

There are several dif-
ferent types of
online stor-
age to

choose from. Some offer a paid solution
and others let you store just about any-
thing for free. Yet others are more specif-
ic, allowing you to store pictures and
photo albums, providing you free Web
space,  either paid or unpaid.

Web sites that give you e-mail and
Web hosting space can be used to store
morsels of data. You can also use Web sites
that offer high e-mail storage space. All
you have to do is create an e-mail account
with them, and then e-mail the files you
want to back up to that address. Create
appropriate folders, and you’re done.

Online Grand canyons
Sharemation.com (www.sharemation.com) is
the first name that pops up when you talk
of sites that offer free online storage space.
This site is actually meant to be used when
evaluating the Xythos WebFile server

(ww.xythos.com). The evaluation
accounts have a storage space

of 5 MB, and the site has
an easy-to-use Web

interface that
allows you to
copy, move,
delete, or
share files eas-
ily. You can
even set file
level permis-
sions for shar-

ing documents. Permission is granted on
the basis of three levels of users—owners,
Sharemation account holders and the
general public. The address of your Web
folder is as simple as http://www.sharema-
tion.com/<yourusername>, and you can map
this as a drive to easily drag and drop files.
Just open Windows Explorer and go to
Tools > Map Network Drive…, choose a drive
letter in the ‘Drive’ field, and type the URL
of your Web folder in the ‘Folder’ field.
Now click on Finish, and you will be asked
for a username and password. Enter them
and click OK.

NetDocuments (https://vault.netvoyage.
com/) offers a free space of 3 MB, with
many useful features such as Web folders,
e-mail accounts, etc. To sign up, visit
https:// vault.netvoyage.com/neWeb2/signup
/signupfree.asp. This site only works if you
run Windows with Internet Explorer 5.0,
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Sharemation.com is a great online storage
Web site to store your data

It’s Never
Enough
Tired of using floppies and CDs to haul
your data around? Try these free online
storage services and access your
documents from anywhere...

IMAGING: Atul Deshmukh
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or later. The first time you login, it installs
an ActiveX control. When you sign up, an
e-mail address is created as <youruser-
name>@mail.vault.netvoyage.com. To upload
a file, just send it as an attachment to that
address. To access your Web folder from
Windows XP, open ‘My Network Places’
and double click ‘Add Network Places’.
Click Next, select ‘Choose another net-
work location’ from the list of ‘Service
providers’ and click Next. Type https://
vault.netvoyage.com/webfolders’ in the address
field, and click Next. Enter your username
and password when you’re asked for it,
click Next and then click on Finish. Anoth-
er interesting feature is its integration with
Outlook. You need to download and install
a small file, which adds a button to the
Outlook toolbar that lets you save mes-
sages and attached documents directly into
your NetDocuments account.

If you need large amounts of free
space, BTInet Storage (http://webstorage.
btinet.net/) is the choice for you. It’s a 

plain site, which offers nothing but 25 MB
of space, where you can store anything
you want. 

My Secure Files was earlier known as
Freeback.com. It offers 10 MB of com-
pressed space; all the files you upload, are
compressed and then stored. One very
useful feature is that you can encrypt your
documents while storing them. This
assures the security of all your sensitive 
data. To sign up, visit http://isavix.net/mem-
ber/signup.jsp.

Znail.com (www.znail.com) grants 
5 MB of real estate, plus unlimited storage
for bookmarks. This site has a unique nav-
igation system that makes use of pop up
windows every time you click on a link,
similar to the dialogue boxes in Windows.

Everything but the kitchen sink
If you like matching your e-mail client to
your online storage space, try Yahoo!.
Yahoo! offers a combined 30 MB of space
in the form of Yahoo! Briefcase and
Yahoo! Albums. To access the Yahoo
Briefcase, go to http://briefcase.yahoo.com.
You can use your Yahoo ID to access all
Yahoo! services including e-mail,
Briefcase and Photo Album. An easy way
to upload files to your Briefcase is to send
them to your Yahoo! e-mail ID as an
attachment, then open the e-mail and
click ‘Save to my Yahoo! Briefcase’. 

Indiatimes (www.indiatimes.com) is
another site that offers e-mail, calendar and
briefcase services. It offers 6 MB e-mail stor-
age, and 12 MB for the Briefcase. To send
attachments to the Briefcase, click ‘Down-

load: My Briefcase’ in the attachment
description box at the bottom of the e-mail.  

Doneasy.com (www.doneasy.com) is an
integrated online service platform that
offers an e-mail account with 2 MB of stor-
age, calendar, message board, chat rooms,
online bookmarks, journal, notepad and
file storage with 10 MB of space. The best
part of this site is that there is no limit on
the individual file size, which means you
can upload even a 10 MB file. Although
the navigation is a bit difficult to under-
stand, the site is visually appealing. 

Web sites galore
If you want to host your own Web site, you
have options aplenty. Many Web sites will
gladly give you enough space. Some have a
limited individual file size, or the types of
files that you can upload, but many don’t. 

Yahoo!, via Geocities.com grants 15 MB
of space. It has an individual file size limit
of 5 MB, but accepts MP3 and Zip formats. 

O-F.com (www.o-f.com) offers 100 MB
of free space, but with a file size limit of 

Send the file that you need to store as e-mail
attacments to NetDocuments

Doneasy lets you store files as long as 10 MB

Web site
Sharemation.com

BTInet

MySecureFiles

Znail
Yahoo!

O-F.com

Brinkster

Doneasy
ImageStation

Fotopic

Address
www.sharemation.com

webstorage.btinet.net

http://isavix.net/

www.znail.com
www.yahoo.com

www.o-f.com

www.brinkster.com

www.doneasy.com
www.imagestation.com

www.fotopic.net

Space
5 MB

25 MB

10 MB

5 MB
30+4+15 MB

100 MB

30 MB

12 MB
Unlimited

250 MB

Pros
Web folders can be mapped to the local
drive; Allows you to set permissions for
shared folders
Large storage space

Allows you to encrypt while saving

Bookmarks can be stored 
Large storage space; Integrates with
Yahoo! Mail and the Photo Album
Large storage space

Accepts Zip files

No limit on the individual file size
Upload photos and videos; Multiple
uploading procedures
Provides page view count; Multiple ways
to upload, including FTP, WAP access to
your photos, other image formats sup-
ported; More space can be requested

Cons
Small storage space, suited only for doc-
ument 

Can upload files only through the Web
interface 
Can upload files only through the Web
interface 
Small storage space
5 MB limit on the individual file size 

1 MB limit on the file size;
Bandwith restriction of 20 MB per day
Lengthy sign-up process, interface 
cluttered with advertisements
Navigation difficult to understand
FTP access missing, support for only
JPEG images and MPEG videos
FTP downloads not supported

The Best of the Crowd
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1 MB as well as a restriction of bandwidth
to 20 MB per day. The total amount of
uploads and downloads should be less
than 20 MB per day.

Brinkster (www.brinkster.com) gives you
30 MB of free Web space. The best part is
that it accepts the Zip file format, so you
can store just about anything you want by
zipping the file first. The sign-up process
is lengthy, and the interface cluttered with
advertisements.

Angelfire (www.angelfire.com) offers 
20 MB of storage, and accepts the Zip and
MP3 file formats.  

eSmartStart.com (www.esmartstart.com)
gives 20 MB, with FTP access. This means
that you can upload any file you want, but
with a bandwidth limitation of 35 MB per
day. You can use an FTP client such as
CuteFTP (www.cuteftp.com), WS_FTP
(http://www.ipswitch.com/Products/WS_FTP/),
or BlazeFTP (http://www. flashpeak.com/
blazeftp/blazeftp.htm) to make use of the
FTP facility. You can also open FTP folders
in Internet Explorer by typing ‘ftp://user-
name:password@sitename.com’. Once the
folder opens, you can drag and drop the
files through Windows Explorer. 

Similarly, www.fortunecity.com gives 
25 MB of free space with FTP access. 
The FTP address is ftp.fortunecity.com. 
You can use ‘ftp://username:password@ftp.for-
tunecity.com’ to access your folder with
Internet Explorer. 

Speak a thousand words
Until recently, the obvious choice for
online photo albums was Yahoo Photos,
but according to a notification on the site,
this free service is going to be made very
limited soon. Thus we’re forced to look for
other options.

Sony’s Image Station (www.imagesta-
tion.com) is good place to store images and
videos online. You can upload images in
JPEG format and videos in MPEG format.
The individual file size limit for JPG
images is 6 MB, while it is 40 MB for
videos. You can choose between the stan-
dard Web interface to upload your files
(maximum 30 at a time), or just e-mail the
files as an attachment to a specific e-mail
address. In the former, you can install a
tool that lets you drag and drop. 

Another good Web site is Kodak’s
www.ofoto.com. This place gives you unlim-
ited space for storing your pictures for 12
months—more if you order prints from
here. You can also share your photographs
by inviting your friends through an e-mail
sent by ofoto. 

Fotopic.net (http://fotopic.net) gives you
250 MB of space to store your photo-
graphs, but even if you use up all this
space, you can request for more. When
you create photo albums, you get weekly
statistics about the viewers. You can also
access the galleries from your WAP
enabled mobile phone. You can choose to
upload photos by the Web interface, by
sending an e-mail with the pictures as
attachments to upload@fotopic.net, or use
the FTP access. 

Photodex PictureCD.com (www.pic-
turecd.com) is another site which offers
unlimited space for storing photographs.
There is only one way to upload photo-
graphs to this site, the Web interface.
Whenever a photo is uploaded, you get
the option to keep the photo private, or
make it public. This allows easy sharing of
photographs. The only drawback is that
you can upload only one image at a time. 

Shutterfly (www.shutterfly.com) is a well-
known service for online storage of photo-
graphs. To upload photographs, just install
a tool from the site. Using this tool, you

can select multiple pictures to upload, get
the upload progress status, and drag and
drop the images from Windows Explorer. 

Photogra.com (www.photogra.com) also
offers unlimited space to store your pho-
tographs online. It allows you to create
public as well as private albums. 
www.photoisland.com on the other hand,
offers only 10 MB of space to store the
photographs online, but has some cool
tools such as an event-specific album cre-
ation wizard and sending your photos as 
an e-card.

Points to ponder
There is one more thing you can do
to store your documents—e-mail them
as attachments to yourself, and keep them
in your mailbox. You should use services
that give you larger e-mail storage space—
10 MB or more, such as HushMail
(www.hushmail.com), Fast Mail (www.fast-
mail.fm) and Arabia mail (www.arabia.com).

There are a few things that you need to
keep in mind when storing your data
online. First, remember that transfer time
matters, especially if you are using a dial-up
connection. If the file you want to upload
is large and the Web site allows compressed
files, compress your files using WinZip or
other such utilities.Secondly, remember
that most of these file transfers aren’t very
secure, so avoid storing sensitive docu-
ments on the Internet. Another concern is
thereliability of these sites; earlier, most of
these sites were free, but with the ever
changing business and Internet scenario,
Sites are increasingly becoming paid, or just
shutting shop. To counter this, you should
store important files at more than one site,
so that you can gain access to the data as
and when you need it. Also, read the copy-
right policiescarefully and check whether
you are abiding by them.

UPENDRA SINGHAI

upendra_singhai@thinkdigit.com

Photos stored at Fotopic.net can viewed on
your mobile phone

Kodak’s ofoto.com offers you unlimited storage
for one year 

Photodex PictureCD.com gives you the option
of keeping photos public or private
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The need for wireless communications
arose when people started using
more than one electronic device to

store personal data, such as contacts, pho-
tos, appointments, etc. All this data was
stored all over the place: in laptops, PDAs,
mobile phones, and even in wrist watches.
Using wires for communication beats the
very purpose of mobile devices. So, the first
wireless standard to gain acceptance in the
market was infra-red. Then Bluetooth
arrived, and it is slowly but steadily enter-
ing the market. These standards, however,
had low data transfer rates; so a new stan-
dard named WiFi was born. It supports
high data rates and is used primarily in lap-
tops for network access.

Infra-red
Infra-red is similar to normal light and is
just another electromagnetic wave. It is
called infra-red because the frequency and

wavelength takes it below the red end of
the spectrum, making it invisible to
humans. Infra-red is the simplest and one
of the most prevailing wireless communi-
cation standards. It uses an infra-red beam
to transfer data between devices. Remote
controls for various devices—televisions,
CD players, air conditioners, etc.—all use
this technology. IrDA (Infra-red Data Asso-
ciation) is an organisation that maintains
the standard for communication via Infra-
red, and there are currently more than 100
member companies and many more
devices that have an IrDA port.

Like any other standard, IrDA is a
cable replacement standard; it creates a
virtual wire using an infra-red beam to
transfer data. It is a half-duplex, point to
point protocol—only one device can
transmit data at a time. Also, the devices
need to have a clear line of sight between
their ports to function—the IrDA ports of

the communicating devices must face
each other without obstructions. The two
devices that take part in this communica-
tion are called primary and secondary
devices. Primary devices are the ones that
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We take a look at the three
most common wireless
standards available today—
infra-red, Bluetooth and WiFi.
Learn how they work, and
how to use them

■ technology
PHOTOGRAPH: Mexy Xavier, IMAGING: Atul Deshmukh

Beyond Wires

Sony Ericsson T310 is a popular IrDA enabled
mobile phone. The black rectangle seen here is
the infra-red port

Beyond Wires
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look for IrDA-enabled devices through a
process called discovery. Once it finds a
secondary device, two random 32-bit
addresses are generated for each device—
even if the same address is generated for
both devices, there are mechanisms to
resolve them. Once the addresses are
assigned, a connection is established and
the devices figure out each other’s capa-
bilities: supported data rates, data size,
turnaround time, etc. After these rituals,
the data transfer commences at the high-
est supported speed. A ‘permission to
transmit token’ is used, which ensures
only one device talks at a time. Only the
device possessing the token can transmit
data. Though more than two devices can
communicate with each other, only one
can talk.

There is no fixed speed for IrDA
devices, but all devices need to be capable
of at least 9.6 Kbps, as this is the speed at
which initial discovery and negotiation
takes place. Currently, the maximum sup-
ported speed is 4 Mbps, but a 16 Mbps stan-
dard is in the pipeline. IrDA devices can be
up to a metre apart, but work best within a
range of 5 cm to 60 cm. As IrDA commu-

nication happens only by conscious effort
of a user, the range is short and security
isn’t considered an issue—there isn’t any in
the standard. 

Bluetooth
Bluetooth is designed to be a personal area
network, where participating entities are
mobile and require sporadic communica-
tion with others. It’s omni directional; i.e.,
it doesn’t have the line of sight limitation
like infra-red does. Ericsson started the
wcork on Bluetooth, and being a Denmark-
based company, they named it after the
Danish king Harold Bluetooth. Later, a
Bluetooth special interest group, compris-
ing companies such as
Nokia and Ericsson, was
formed to oversee the
development and stan-
dardisation of the tech-
nology.

Bluetooth operates in
the 2.4 GHz area of the
spectrum, and provides a
range of 10 metres. It
offers transfer speeds of
around 720 Kbps. When

Bluetooth devices are connected to each
other, they form a network called piconet.
Each piconet can have a master, and up to
seven slaves. Communication takes place
only between the master and the slave. If
the slaves need to communicate with each
other, they can’t route via the master—they
have to form a separate piconet. A device
can participate in more than one piconet at
any given time—it can be a slave in one
piconet, and a master in another. Such
networks are called scatternets, where dif-
ferent piconets are connected using a com-
mon device.

To accommodate interference from
other signals, Bluetooth uses frequency

➜
Not just mobile phones and PDAs, Bluetooth can be used for other
wireless applications like this Microsoft Bluetooth keyboard and mouse

System support
To communicate with an IrDA
enabled device, your computer
needs to have an IrDA port.
Some motherboard models
come with an infra-red port on
board, but most include only
the IrDA header, which is a con-
nector between the mother-
board and the back panel of the
cabinet. The IrDA adapter which
contains the infra-red transmit-
ter and receiver has to be con-
nected to the IrDA port at the
rear of the cabinet. Usually,
motherboard manufactures
don't include the IrDA adapter,
even if the motherboard has an
IrDA port. Read your mother-
board manual to find out if you
have an IrDA port. If you do,
buy an adapter from your dealer. 

Another option is to use
USB stick-based IrDA ports.
Just plug one of these devices
into a vacant USB port, install
the drivers if required, and
your computer is IrDA-ready.
These devices are available for
about Rs 1,000.

Pros
Being the simplest of the lot, it really doesn't
make sense to buy a product for its IrDA unless
you have an existing IrDA-enabled device or sys-
tem. It is best suited for transferring small
amounts of data such as schedules, contacts, etc.
Use it for transferring data from your system to a
mobile device or between two mobile devices.
Cons
Don't use IrDA for transferring large amounts of
data between a laptop and a system. Although
data can be transferred, the slow data rate and
line of sight requirement will make it a very
avoidable experience.

Devices using infra-red
IrDA ports are found in personal electronics
devices such as mobile phones, PDAs, remote
controls, etc. Nokia models such as the 6510,
8250, the Sony Ericsson T310 and T610, 
the Palm Zire 71, etc., all come with infra
-red ports.
If your mobile phone is IrDA-capable, you can
transfer ring tones, wallpapers, contacts, etc., to
and from your phone. However, you will need
to have a mobile phone management utility
such as Oxygen Phone manager. Get it at
www.oxygenphonemanager.com. Similarly, you
can transfer data and synchronize your PDA
with your computer.

Interestingly, IrDA-enabled PDAs can be
used as substitutes for remote controls. All you
need to do is load an application such as
OmniRemote (www.pacificneotek.com) onto
your PDA, point a remote towards the PDA and
press the most commonly used keys. For a tele-
vision remote, you probably use Channel up,
Channel down, Volume up and Volume down
more than any other buttons. After you press a
key on the remote, you can assign a PDA key to
mimic the function. Once you've assigned the
keys, you’re all set to use your PDA as a
remote—secretly switching channels while your
father sits guarding the remote, gaping at the
swimsuit round of Miss World, is one sure way
of getting a few laughs.

How IrDA Works
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hopping. The devices frequently change
the frequency at which they operate—as
often as 1,600 times a second. This pre-
vents interference with other devices that
may be operating at the same frequency.
When a piconet is formed, the master
informs all the slaves of the frequency hop-
ping sequence, and the slaves follow these
instructions.

To conserve power, devices can go
into three modes when they aren’t active-
ly involved in a piconet. In increasing
order of power consumption, they can be
in park mode, hold mode and sniff mode.
All the slave devices in a piconet are
assigned an active member address
(AM_ADDR). When a slave enters the park
mode, it will give up its AM_ADDR and
get a park address, PM_ADDR. The parked
devices will listen to the master at regular
intervals, allowing them to conserve
power, and will yet be able to rejoin a
network when required. When a device
enters hold mode, it is assigned a hold
timer and no data transfer takes place
until the timer ends. In sniff mode, the
device retains its AM_ADDR, but reduces
its role in the piconet, thus conserving
power. This mode is flexible, and parame-
ters such as sniffing interval can be pro-
grammed.

One of Bluetooth’s advantages is that
it can handle both data (asynchronous)
and voice (synchronous), which others
such as infra-red can’t. One must under-

stand that the requirements of a voice and
data channel are very different. A data
channel needs to be strictly error free
while it can tolerate timing errors, for a
voice channel it is exactly the opposite.
Both synchronous and asynchronous
channels can be handled simultaneously.
This has lead to products such as Blue-
tooth headsets for mobile phones; these
headsets allow users to talk via the cord-
less headsets while the mobile phone
resides in their pockets.

Every Bluetooth device has a 48-bit
BDA (Bluetooth Device Address) burned
into its ROM. This address can’t be easily
changed by the user. Similarly, each device
can be given a user-friendly name such as
‘Sachin’s mobile’. These names will make
it easy for the user to identify a device in
a piconet. A Bluetooth device can be set to
periodically scan for other devices in its
vicinity, or users can perform manual
scans. After a scan is performed, a list of all
Bluetooth devices detected is shown. Each
device in the list will have the name
assigned by its respective owner, and the
user can select a device and com-
municate with it. A Bluetooth
device will show up in a scan only
when it is in discoverable mode.
Discoverable mode should be
turned off to prevent bluejacking—
sending anonymous messages to
users via Bluetooth.

WiFi
Bluetooth is a convenient way of commu-
nication for a personal network, but it is
not suitable as an LAN replacement, or for
perennial data transfer. But the growing
popularity of laptops necessitated the need
for a wireless standard that would allow
people to walk around with their laptops,
and still be connected to a network. WiFi,
an abbreviation for Wireless Fidelity, is a
wireless standard that promises mobility
while offering data rates comparable to
those of a wired LAN. WiFi is a collection
of standards ratified by the IEEE (Institute
of Electrical and Electronics Engineers). In
1997, IEEE approved the 802.11 standard,
which laid down the specifications for
wireless LAN. Subsequently, revisions were
made to this standard and these resulted in
three other standards, namely 802.11a,
802.11b and 802.11g. The entire family of
802.11 standards are collectively called
WiFi. The letters appended to the standard

System support
The easiest way to enable Blue-
tooth support in a system is to
attach Bluetooth USB sticks.
Some motherboards, such as the
MSI KT3 Ultra2-BR, come with
inbuilt Bluetooth support. Once
plugged into the system, you’ll
have to install the drivers for the
device to start using it. The sys-
tem will then periodically scan
the surroundings for Bluetooth
devices. 

Pros
Currently, Bluetooth offers the
best solution for hassle-free
communication between
portable devices. With low
power consumption and
user friendliness, Bluetooth
has all the requirements of a

personal area network. Those
who need to transfer data on
a regular basis and prefer
portable device should
definitely opt for Bluetooth.
Cons
In spite of promises that
Bluetooth support will be

cheap, consumers avoid it
mainly due to cost. A Bluetooth
USB stick costs about
Rs 2,000, which may be on
the higher side for mainstream
customers. Don’t think of this
technology as a LAN replace-
ment, though.

Devices using Bluetooth
Bluetooth is slowly beginning to
reach the hands of consumers.
Most premium-range mobiles and
PDAs support Bluetooth; it has
started appearing in the main-
stream range as well. Users buy-
ing mobile phones, or PDAs
should look for Bluetooth enabled
devices. Using Bluetooth, you can
transfer contacts, ring tones,
images, etc., between devices eas-
ily.

How Bluetooth Works

M1
S2

S2
S1

M2/S1

Piconet 1 Piconet 2There are two piconets shown
here; the master of each
network is indicated by M1 and
M2. Similarly, S1 and S2
indicate the slave devices of
Piconet 1 and 2 respectively.
Note that M2/S1 is a device
that is the master in piconet 2;
at the same time, it is a slave in
piconet 1

The Apple Airport can be plugged into a Mac system to
make it WiFi compatible
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indicate the task group that proposed the
modifications For example, task group ‘b’
put forth the 802.11b standard.

A wireless network can work in two
modes; namely ad-hoc and base station. In
an ad-hoc (also called peer to peer) net-
work, several computers equipped with
wireless hardware come together to form a
network. All the computers communicate
with each other directly. Unless one of the
computers participating in the ad-hoc net-
work is connected to a wired network, no
system can gain access to a wired network.
Three friends meeting in a park and shar-
ing files between their wireless laptops is
an example of an ad-hoc network. 

The other type of network involves the
use of an access point (also called base sta-
tion). The access point acts as the central
point of the network, and is the link
between the wired and wireless networks.
An access point can be a dedicated hard-
ware system, or just software running on a
system. In airports and coffee shops, main-
ly in the US and Europe, access points are
provided so that customers can walk into
the shops and start using the Internet from
their laptops. It may not be possible to cover
an entire airport, or an office, with a single
access point. In such cases, more than one

access point is required. Users can take their
devices and roam across different access
points. All access points have a SSID (Ser-
vice Set ID) assigned to them, as do all the
clients connected to them. When an access
point is installed, the default SSID must be
changed to increase security, and to prevent
users from connecting to some other spot.

The name WiFi was first given to the
802.11b standard. Approved in 1999,
802.11b offered extensions to the original
802.11 that improved the highest data
rate from 2 Mbps to 11 Mbps. It operated
in the 2.4 GHz frequency range, like as the
original and has a range of about 300 feet.
Keep in mind that range and speed are
interrelated—as the wireless clients move
further away from each other, the speed
is bound to deteriorate.

802.11a is a standard that operates at a
frequency of 5 GHz, and hence it is incom-
patible with 802.11b. So, a laptop with an
802.11b card can’t connect to an access
point running on 802.11a. Also, the range
of 802.11a is lower than that of 802.11b;
hence, more access points are needed to
cover a large area. On the brighter side, it
offers a much higher throughput of 54
Mbps. Interference is a problem with wire-
less networks. Bluetooth devices and cord-

less phones are some sources of this inter-
ference. 802.11a is less susceptible to inter-
ference when compared to other standards
such as 802.11b. 

To solve the limitation of ‘b’ and at the
same time provide the speed of ‘a’, the
802.11g was introduced. 802.11g offers
speeds of 54 Mbps, while maintaining com-
patibility with 802.11b networks, so a lap-
top with a 802.11g card will be able to use
a 802.11b access point.

WiFi has a basic level of security pro-
vided at the physical level, called WEP
(Wired Equivalent Privacy). But vulnera-
bilities in WEP have already been discov-
ered, and it can’t be used as the only secu-
rity mechanism. However, it is recom-
mended that WEP be turned on, as it pro-
vides a basic level of security. Additional
levels of security can be provided at the
software level in the form of firewalls. The
level of security offered by WEP depends
on the number of bits used for the encryp-
tion key; almost all WiFi products come
with a 40-bit encryption key. A 104-bit
encryption key is also available, and it is
recommended that the largest available key
should be used.

MOULY ARUN PRABHU

mouly_arunprabhu@thinkdigit.com

System support
For a system to connect to a
WiFi network, it should have
a WiFi network card, or an
access point connected to it.
WiFi network cards are like
normal network cards that
plug into PCI slots, but have
a protruding antenna. It’s
also possible to plug an
external WiFi adapter into a
USB port. Once the network
cards are installed and con-
figured, the system can con-
nect to any WiFi network.
Hardware access points can
be connected to network
equipment such as a bridge,
or it can be connected to a
system that has access to a
wired network. It’s also possi-
ble to install software that
will convert the system into
an access points. Hardware
access points are generally
used in commercial hot
spots, while software access
points are used to share an
Internet connection in
homes and SoHos. 

Pros
Given the current situation, WiFi
should be adopted when there is a
demand for high speeds on the move.
WiFi is suited for corporates with sev-
eral executives roaming around the
office with their laptops. Homes look-
ing for a means to share a broadband
Internet connection can also consider
adopting WiFi. If you’re buying a lap-
top, look for WiFi-enabled devices. 

Cons
A WiFi setup is rather expensive
when compared to a regular LAN.
Also, since WiFi drains
batteries much quicker, PDA
users should avoid using it—
especially if they have a
Bluetooth option available. It is
difficult to provide security in
a WiFi network, as it is difficult
to control access to the network.

Devices using
WiFi
While WiFi may be
widely used for
communication
between computers,
there are PDAs that
support it. It’s also
possible to add WiFi
support to
a PDA by inserting
a WiFi card into the
SD (Secure Digital)
slot. PDAs such as
the Toshiba e750
have inbuilt support
for WiFi. In March
2003, Nokia
announced plans
to build mobile
phones that can
seamlessly switch
between 802.11b
and public networks.
The major problem
with WiFi is the high
power consumption,
which mobile
devices just can’t
afford.

How WiFi Works

Access point

Ad hoc WiFi network
Access point WiFi network
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Most designers and artists who 
use and manage a large number
of fonts will empathise. Fonts

take up a lot of space, and are difficult to
manage. Everyone needs to know how to
manage fonts, and it isn’t as simple as it
seems. Windows has to load all the
installed fonts at system startup; applica-
tions such as Photoshop load fonts when
they start. The more the fonts installed on
the system, the slower it runs. A lot of pro-
grams also have their own fonts that are
installed without your knowledge when
you install the program. This makes font
management an important aspect of main-
taining PC health. 

Designers, who use large number of
fonts, may need to use a font management
tool. Using these tools, you can split the
fonts into groups and load only the neces-
sary ones. Others need to make sure that
they have no unwanted or corrupt fonts,
as these can cause a system crash.

Windows keeps all the fonts in a
default folder (<Drive>:\Windows\Fonts),
where <Drive> is your Windows default
drive. Backup this folder, so that if you
accidentally delete an important font,
you can restore it later. To view the fonts
currently installed on the system, go to
Control Panel and open the Fonts applet.
The default font folder will be shown.
Remove the unwanted fonts by selecting
the font and pressing [Delete]. If the fold-

er contains fewer than a hundred fonts,
then it’s recommended that you don’t
delete any. Otherwise delete the unwant-
ed ones. Remember, however, that certain
fonts such as Times New Roman are used
by Windows, so don’t delete them. Go to
http://graphicssoft.about.com/library/extr
a/bldefaultfonts.htm to know more about
what fonts to keep.

If you absolutely need to have a lot of
fonts, the only solution is to categorise
them and install only the ones you need.
You can do this manually, or leave it to spe-
cialised utilities such as Typograph
(http://www.neuber.com/typograph/).
Essentially, what you need to do is keep
the font files in different folders and load
only the ones that you need to work with.
You can group the fonts based
on the project you are working
on, or on the type of font—nor-
mal, stylish, symbols, Indian
scripts, etc. Now, keep only
important fonts in the default
folder and delete the remaining
ones. Group the ones you delet-
ed in a backup folder. If you
want a font in more than one
group, just create a copy.  

Now, to use Typograph to
manage your fonts, open the
application to see a list of all the
fonts installed on your system.
You can double-click on any

font to view its complete
details. Click on the but-
ton named ‘Manage-
ment’ in the toolbar, and you will
see a font management window—
similar to a Windows Explorer win-
dow. Click on the button with a CD
symbol (the archive button); in the
dialog box that appears, navigate to
the folder where you stored your
groups of segregated fonts. At the
bottom of the dialog box, select the
‘Take directory structure’ radio but-
ton, and click on Continue. The
number of fonts  found will be dis-
played. Now click ‘All’.

The right pane of the Font manage-
ment window has a database entry;
expand it and you will see all your fonts
neatly categorised. You have the option
of either loading a particular category, or
installing it. Loading a font makes it
available for the current Windows ses-

sion, and will not be available when you
restart the PC; installing a font will make
sure that it is loaded at startup for every
Windows session. All you have to do
from now on, is right-click a font cate-
gory and choose to Install, Uninstall,
Load, or Unload it.

Play around with Typograph to find
more useful features such as font com-
parisons, keyboard layouts of symbol
fonts, and details about the fonts used.

MOULY ARUN PRABHU

mouly_arunprabhu@thinkdigit.com

Fonts Sans Confusion
Thousands of fonts and nowhere to run...Welcome to your destination 

The Font management window is easy to use, and looks
like Windows Explorer 

Typograph lists the fonts currently installed on your system
according to their font families

If you have certain fonts that you
use only with Adobe applications,

you can put them in the ‘<Drive>:\Pro-
gram Files\Common Files\Adobe
\Fonts’ folder, where <Drive> is your
Windows default drive. This will ensure
that the fonts do not load at Windows
startup, but are available to any 
Adobe applications 
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Securing your laptop is easier said than
done; the very fact that laptops are so
mobile makes them attractive and

easy targets. Losing your laptop is not just
losing really expensive computer hard-
ware—if your laptop is your main com-
puter at work, then it can also mean the
loss of several hundred hours of work. And
if you happen to be a corporate hotshot
(which you’d have to be to get one in the
first place), there goes all your hush-hush
company information. 

It’s a big bad world
Security means that you should be able to
forsee the possible threats to your laptop
and the data residing in it. Whether you
take your laptop all over the world, or just
from home to work and back, the fear of
physical loss of the laptop is omnipresent. 

Not all laptops are stolen and sent to
the local chop-shop to be resold; smart
thieves will target laptops to pick up
data that is otherwise inaccessible
from workstations behind company
firewalls. Third-party software tools
that will restrict logins and encrypt
drives are your best bet against data
thieves. The Bill Gates’ of the world prob-
ably have a posse of security men guarding
their laptops.

There are hardware locks available
that will let you secure your laptop as you
would your bags on a train. Also, using
commonly available tools, you can ensure
that even if it’s stolen, your data remains
safe.

Hardware paranoia
Securing your laptop is best achieved by
locking it down… literally! Laptop manu-
facturers provide a little slot with each lap-

Watch that
Move

Prevention, as they say, is better
than cure, and this goes double
if you are a road warrior living
off your laptop
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top where you can attach a lock. This slot
is connected to a steel rod within the chas-
sis; trying to take apart the rod is as good
as breaking the laptop. The slot can be
identified by a little lock icon, with the let-
ter ‘K’ on it. 

Hardware security devices available in
India range from the simple, to the sophis-
ticated. At the bottom of the list are ordi-
nary devices that lock into the security slot
and have a tough steel cable to wind
around a table leg or some permanent
hook-like fixture. This prevents a  crook
from just picking up your laptop and walk-
ing away with it. We looked at a mechani-
cal device, that has a combination lock and

comes with a 1.5m length of tough steel
cable around it. Setting it up is simple:
attach the device into the security slot,
wind the cable around a table leg (or use
the supplied steel hook that can be mount-
ed on a wall) and lock it. This device works
great if you tend to be less mobile. Short of
sawing through the thick steel cable, the
table leg, or trying to break the code on the
combination lock, you can’t steal a laptop
with this device protecting it. 

There are more sophisticated devices
available that work with inbuilt motion
sensors. We found that Targus’s DefCon 1
systems (www.targus.com) allow you to
set sensitivity levels on a motion sensing
equipped device; one particular model,
the PA 400, lets you connect a clip-like
device into the security lock, loop a steel
cable through it and lock it into the
motion sensing device. Shake the laptop
or the motion sensing device, and an ear-
splitting alarm sounds. You can only turn
it off by unlocking the three-digit combi-
nation lock and undoing the cable. This
should be enough to grab the attention of
everyone who isn’t already deaf and also
give the potential thief a good scare. An
even more sophisticated DefCon 1 prod-
uct, the PA 430B, comes with a motion
sensing device, cables, a clip and also has
a remote control that lets you trigger the
alarm by proximity as well as motion
detection. Move the tiny remote con-
troller beyond 12m from the laptop and
the alarm goes off. You can also trigger the
alarm by pressing on a button in the
remote controller. This device is ideal for
travelers who can secure their laptops
whilst travelling in high-risk public areas
such as airports. Both these security
devices will not allow you to access the
battery compartment until you unlock the
device, so somebody intent on stealing
your laptop cannot disable the alarm.
Keep in mind that while these devices are
relatively secure, there is still nothing like
total security; at best they provide a deter-
rent to stealing your laptop.

Secure the insides
It’s possible that despite all your best efforts,
you might still lose your laptop. If you are
insured, there will be negligible financial
loss, but what about the data sitting on
your hard drive? Corporate espionage is a
growing problem; the confidential data on
your machine may of immense value to the
competition. Even e-mail and ordinary cor-
respondence can be a source of informa-
tion. Your only shield here is making sure

that the computer cannot be accessed by
anyone but yourself, and that the data is
still unreadable should someone try to
swap drives—BIOS and Windows pass-
words are not adequate security. Use a rel-
atively more secure OS such as Windows
2000 or Windows XP that does not allow
users to log in without valid user accounts,
and patch the OS with the latest service
packs. Then use commercial tools to fur-
ther secure and limit access. To this end, we
worked with two tools, both of which offer
substantial boot-time security and real-time
drive encryption features. The tools used
here are Eracom’s ProtectDrive and
SafeBoot Solo—they can also be used to
secure your desktops. 

To run these tools, you need to have a
Windows-based laptop with a little hard
drive space and blank formatted floppy
diskettes. You will be prompted to create
rescue diskettes at installation, which can
be used to recover from hard drive failure,
or from a corrupted setup. These are
administrator diskettes and that they can
be used to log in to your machine, so store
them safely. 

SafeBoot Solo
SafeBoot Solo (www.safeboot.com) is simple,
easy to use and is shareware—after the trial
period expires, SafeBoot will delay boot-up
by a minute. It allows for simple configu-
ration and is a very easy-to-use tool. 

Installation: Installing SafeBoot is a
two-step process—installation and config-
uration. Double-click on the setup file to
start the installation. Once installed, you
are prompted to reboot, after which a sim-
ple configuration process starts. First up,
you will be prompted to enter a username
and password, which you will use to
authenticate, as well as change SafeBoot’s
settings. Now you can opt to encrypt all or
some of your drives—either partial or com-
plete encryption. A partially encrypted

The security slot will keep your laptop where
you last left it

The plain and effective mechanical lock and
chain that keep your laptop in place

The Targus DefCon 1 PA 400 motion sensing
device secures your laptop

Encrypting drives using SafeBoot 
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drive has 10 per cent of its drive volume
encrypted. You can use this to try out drive
encryption, but ideally, choose to encrypt
the whole drive. You can also create a cus-
tom warning message at boot time.

After this, the installer
starts copying all the addition-
al setup files. Keep a blank for-
matted floppy diskette handy,
as you will be prompted to cre-
ate a rescue diskette. Once
done, you can extract it from
the drive. If you chose to
encrypt drives, then SafeBoot
will conduct the drive encryp-
tion operation immediately.
You can choose to either
reboot, or continue working
with SafeBoot in the back-
ground; you can also stop and
restart it later. To view the sta-
tus of encryption, just right-click on the
SafeBoot icon and choose Show Status.

Booting up: The primary aim of any
security tool is to prevent unauthorized
users from logging on to the computer.
With SafeBoot installed, you are present-
ed with a login screen when the comput-
er is turned on. On the SafeBoot login
screen you will also find additional
options to either boot from hard drive or
floppy—these options are accessible from
the Options button. Once you authenti-

cate, Windows boots up normally.
Usage: While you work with

Windows, SafeBoot resides in the
system tray. Double-clicking on the
SafeBoot icon launches your screen-
saver and locks your computer. You
need to re-enter your Windows
password to continue working. 

Drive Encryption: While
SafeBoot forces you to authenticate
before Windows loads up, to safe-
guard your data, you should
encrypt your hard drives. This will
prevent someone from just remov-
ing your hard drive and reading

your data on another laptop. SafeBoot’s
encryption works on a real-time basis—
files read from an encrypted drive are
encrypted and decrypted on the fly.
SafeBoot does not offer you a choice of

encryption algorithm. It
uses the AES algorithm
(the Advanced Encryption
Standard) implemented
with 256-bit security.

If you have not
encrypted your drives dur-
ing installation, you can do
so by right-clicking on the
SafeBoot icon in the system
tray and choosing Config-
ure. You need to enter your
username and password.
You will also be prompted
to reuse the rescue disk you
created earlier. 

ProtectDrive
Eracom’s ProtectDrive (http://www.eracom-
tech.com/products/pd/pdrive.htm) is a highly
configurable tool. This is purely commer-
cial software—the demo version is insecure
and displays the username and password
of the ProtectDrive administrator. 

Installation: Installing ProtectDrive is
a two-step routine: launch the pre-instal-
lation program by double-clicking on the
setup file. After you agree to the license

agreements, ProtectDrive copies the main
setup files to the hard drive and prompts
you to reboot. Following a reboot, the
main installation program starts. Keep a
formatted floppy handy, as you will have
to create a rescue disk. You need this disk
to recover from crashes, failures and also
to uninstall ProtectDrive. After creating
the rescue disk, you head off to the Con-
figuration Options screen, where you can
set options for both the ProtectDrive
Administrator, as well as other users, such
as allowing them the password recovery
option and synchronizing to local Win-
dows accounts, as well as setting the min-
imum length of the password.

The default values work fine, but if
you’re paranoid, avoid the synchroniza-
tion and increase the minimum password
length. Now you can choose the encryp-
tion algorithms that you want—DES (Data
Encryption Standard) offers 56-bit securi-
ty, the proprietary PACS algorithm that
uses a 64-bit key, or the IDEA (Interna-
tional Data Encryption Algorithm) that
uses a 128-bit key. 

The higher the encryption key size, the
more time you’ll spend encrypting and
decrypting data—keep this in mind while
choosing your algorithm. Finally, the pro-
gram files are copied on to the hard drive.

Welcome to the world of laptop squealers;
like the ‘LoJack’ tracking device mounted
on vehicles to identify and track stolen
vehicles, there exist tracking software utili-
ties that beep their location as soon as the
laptop gets online. Checkout services such
as AbsoluteSoftware’s CompuTrace service
(www.computrace.com), zTrace
(www.ztrace.com), or Stealth Signal

(www.stealthsignal.com). You have to install
the software and pay a rental for the serv-
ice, generally yearly. Once you report your
laptop stolen or lost, it is tracked and the
information is shared with local law
enforcement agencies. Unfortunately the
services are not cheap—in excess of $40
per year of usage.  Moreover, the services
appear to be partial towards the US.

Tracking it Down

Log in before you boot up with SafeBoot
Choose your flavour of encryption security,
between IDEA  or DES and PACS

The AES algorithm is
the current data

encryption standard
approved for usage by
the US government. It
arose as a result of a
world-wide competition
for a next generation
encryption algorithm
for NIST (National Insti-
tute of Standards and
Technology).

Booting up with ProtectDrive
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If you have chosen to synchronize Protect-
Drive and the local Windows user database,
you authenticate with the same Windows
passwords and usernames. The final step in
the installation is when you will be prompt-
ed to encrypt your hard drive. Choose to
reboot and encrypt the drives later.  

Booting up: ProtectDrive provides a
pre-boot authentication sequence to pre-
vent unauthorized users from booting up
your computer. After the BIOS detects the
hardware, you need to authenticate to let
the computer boot-up. ProtectDrive
accepts three incorrect login attempts, after
which the computer reboots and the login
screen is displayed after a one-minute
delay. Enter the correct user-
name and password (user-
names are case-specific) to
start the Windows boot
process. If you have syn-
chronised the Windows
accounts with ProtectDrive,
you don’t need to log on to
Windows. 

Unlike SafeBoot Solo,
you don’t have any additional options
while booting up. 

Usage: After logging on to your
account, ProtectDrive informs you of all
successful and unsuccessful login
attempts. If you run Windows XP, you can

lock your computer by double-clicking on
the ProtectDrive icon in the system tray.
If you have shared folders, ProtectDrive
will not permit access unless a valid user-
name is used; guest accounts also have to
be password protected. 

Encrypting hard drives: Go to Start >
Programs > ProtectDrive and select Encrypt-
Decrypt Hard Drives. Select the drives you
would like to encrypt from the list dis-

played on top. You can choose to either
encrypt the whole drive, or just
the system areas. For optimal
security, choose full drive encryp-
tion. Depending on the encryp-
tion option, you can choose to
encrypt the drive volumes using
either 56, 64 or 128-bit security. 

The encryption priority can
be set to low, normal, or high.
Selecting low will allow you to

continue working through the encryption
process. Depending on how powerful
your computer is, encryption could
take a while. 

Encrypting Files: You can
use ProtectDrive to encrypt indi-
vidual files. To do so, go to Start >
Programs > ProtectDrive and select
Encrypt-Decrypt Files. In the left
pane, choose the files that you
want encrypted and click on Add
Files. Select Add Directory to add
all the files in a directory. Now
choose the files from the right pane and
select Encrypt to open the encryption
menu. Depending on the settings (key for-
mat) that you have selected, you will be
prompted to enter the keys. The encryp-
tion tool uses the encryption algorithm
that you have specified during installation.
If you would like to tweak the available
options, go to Key Format and choose the

format of the key and Key Length. Decrypt-
ing files is just as easy, and is done using the
same method, except that you are prompt-

ed for your password and need
to click on Decrypt instead. 

Advanced Configuration:
ProtectDrive has several
advanced configuration
options built into it. You can
access and change these, pro-
vided you are logged on as the
ProtectDrive administrator. Go
to Start > Programs > ProtectDrive

and select Advanced Configuration. You
can also choose to show additional logon
information, change the way you log on,
remove the status bar icon, etc. 

Security first
The security tools we used here may not
be infallible, but they do offer good secu-
rity against all, but the most determined
crooks. They are not easy to circumvent;
certainly, cutting through a length of
toughened steel cable, whilst being deaf-
ened by a 110 decibel alarm siren is not
easy. Nor is it easy for the average crook to
crypt-analyse encrypted data and without
access to some pretty substantial comput-
ing resources.

With the right equipment and careful
practices, you can keep your data and lap-
top safe, and with you always.

SRINIVASAN RAMAKRISHNAN

srinivasan_ramakrishnan@thinkdigit.com

IDEA is an algo-
rithm that has

been crypt-analysed
for several years
now without show-
ing any apparent
weaknesses 

Perhaps of more interest to laptop users is
the recent foray of companies such as
Phoenix towards developing technologies
that deter unauthorised access. Phoenix,
for example, is developing an interesting
add-on to the BIOS software that they
have been developing for decades. The
newly developed Core Managed Environ-
ment TrustedCore NB for laptops and
tablet PCs boasts of cryptographic capa-
bilities built right into the BIOS. This can
be used to authenticate digital signatures
and restricting access to stolen hardware.
It will also protect core system software
from malicious code.

Phoenix had earlier partnered with
Softex to develop a tracking system
which installed on the Core Management
Environment. The software connects to
the TheftGuard site once a laptop is con-
nected to the Internet, thus making it
easy to track it down.

Track those Crooks

Encrypting your drives is as easy as choosing
the drive, the algorithm, the priority and
starting the encryption

Set pass phrases and secure those files and
make sure no one can read them

Change logon options, set warnings right
from the Advanced Configuration Options
applet

DES is not
considered

secure anymore
by the US gov-
ernment for
military grade
encryption
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Your boss needs you to send some
documents across to a client ASAP
and get an answer from them too.

E-mail? Yes, you can, but don’t even
begin to think of an immediate response!
Fax it then. Yes, but er... your organisa-
tion never found the need for a fax
machine. Fear not! Turn your PC into
one! Surprised? Don’t be. It functions just
as well as a fax machine. And your boss
will be all smiles at your cheap initiative!

The most basic things you’ll need to get
started is a PC, a modem with fax capabili-
ties and a phone line. If you have all three,
you’re all set to use your PC as a fax (Fac-
simile Transmission) machine. If you have
Windows 2000 or XP, just use the bundled
Microsoft Fax utility. There are many ways
your PC can act as a fax solution: fax via e-
mail, which is basically nothing but an e-
mail with the fax as an atachment, or you
could choose to set up a fax server, which

lets any one in your organisation send a fax
to anyone using your PC as a server—very
cost effective, as everyone in your organi-
sation can send faxes using just one
modem and one phone line (see box ‘Setting
up a fax server’). If you’re looking for
additional functions such as those
mentioned above, you’ll need to
get Symantec’s WinFax PRO 10.0,
downloadable from http://
www.symantec.com/winfax/, or BVRP
Software’s PhoneTools Expert,
which you can get from
http://www.bvrp.com/ENG/products/
PhoneToolsexpert/. 

The fax within
Though Microsoft Fax comes
bundled as a part of Windows, it
is not installed by default. To
install it in Windows XP, go to
Start > Settings > Control Panel > ‘Add

or Remove Programs’ and then click on
‘Add/Remove Windows Components’ to
start the Windows Components Wizard.
In the Components list, check ‘Fax Ser-
vices’, and then click Next. If you haven’t

Matter
The FAX
Need to send a fax urgently and no fax machine in sight? Oh well, you always have the PC!

IMAGING: Solomon Lewis, PHOTOGRAPH: Jiten Gandhi

Specify the modem and send / receive settings for
Microsoft Fax in Configuration Wizard.

of the
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installed the modem yet, it starts up the
Add New Hardware wizard to do so. If
prompted, insert the Windows XP instal-
lation CD, and then click OK. Finally,
close all the windows.

In case the PC runs Windows 98, you
can install Microsoft Fax from the Win-
dows 98 installation CD. Browse to
Tools\OldWin95\Message\US and run
Wms.exe first and then Awfax.exe. Con-
figure Microsoft Fax by going to Start >
Programs > Accessories > Communications > Fax
> Fax console to bring up the Fax Configu-
ration Wizard. Click Next on the Wel-
come screen and fill in the Sender’s Infor-
mation such as name, address, etc., in the
next screen. This information  appears on
the fax cover page. Click Next, and
choose the modem that you want to use
to fax. Here, check the appropriate option
to specify whether you want to use that
modem only to send or receive faxes, or
for both the tasks. If you choose to receive
too, you will have the option of manual-
ly answering the call or answering it auto-
matically after a certain number or rings.
Setting it to receive automatically is use-
ful, especially when you want your PC to
receive faxes in your absence. 

Click Next and type in the Transmit-
ting Subscriber Identification (TSID) that
usually consists of the sender’s fax num-
ber and name, and appears in the header
area of a received fax. In the next screen,
type in the Called Subscriber Identifica-
tion (CSID) that appears on the sender’s
machine and helps ensure that the fax is
sent to the correct recipient. Click Next
and you are asked what to do when a fax
is received. Choose ‘Print it on’ if you
want the fax to be printed automatically.
You can also choose to create a local copy
of the fax received by clicking ‘Store a
copy in a folder’ and specifying the fold-

er. Click Next, review the settings you
chose and click Finish to complete the
configuration. You may change the set-
tings anytime by going to Tools > Configure
Fax in the Fax Console.

Once you complete the Configuration
Wizard, the Fax Console opens up. The
Incoming folder in the Fax Console con-
tains faxes that are currently being
received; the Inbox folder contains faxes
that have been received; the Outbox fold-
er contains faxes scheduled to be sent; the
Sent Items folder holds faxes that have
been sent successfully. 

To create a new fax, click ‘New Fax’
on the toolbar, or go to File > Send a Fax.
This will start the Send Fax Wizard. Click
Next on the Welcome screen and enter

the recipient’s information
such as name, fax number and
click Add to add the entry to
the recipient list. You can add
multiple recipients and also
build an address book.

Click Next, choose a tem-
plate and enter the subject and
note for the fax to prepare its
cover note. Specify the fax’s pri-
ority and when you want to
send it in the next screen. The
final screen shows you the fax
summary and also gives you an
option to preview it. Click Fin-
ish and voila! You have just sent
your first fax.

What if you need to fax an MS Word
document? Use the Fax printer that is
installed along with Microsoft Fax. To fax a
file from any application, go to File > Print,
select the Fax printer in the Print dialog box
and click OK. This starts the Send Fax wiz-
ard that lets you specify the receiver as dis-
cussed above.

Coming to the receiving part, if you
have configured it to receive faxes auto-
matically, then you don’t need to do any-
thing (remember the Fax Configuration
Wizard?). Click the Receive Now button on
the toolbar of the Fax Console, if you have
configured it to receive the fax manually.
Alternatively, activate the Fax Monitor by
going to Tools > Fax Monitor and click
Answer Now.

Specify the recipient’s information for Microsoft Fax in Send
Fax Wizard.

Schedule when you want to receive fax
automatically

Windows XP has a Windows Pictures
and Fax Viewer that comes in handy
when faxing an image or a scanned
document. Open Windows Explorer
and navigate to the image file. Dou-
ble-click or right-click the file icon,
click Open With > Choose Program…
and choose Windows Pictures and
Fax Viewer from the program list
and click OK. When the viewer
opens the image, click the printer
icon on the toolbar, or press [Ctrl] +
[P] to print the image. This will bring
the Photo Printing Wizard. Click
Next to move to the Picture Selec-
tion screen. Enable the checkmark
for all those images that you want to
fax. Click Next and choose Fax as the printer
in the Printing Options screen. Click Next to
move to Layout Selection screen. 

Here you can choose the layout, i.e. the

number, size and orientation of images on
the page. When you click Next on this
screen, the Send Fax Wizard will start. Fol-
low the steps of this wizard to send the fax.

Image Faxing

Use the Photo Printing Wizard to fax scanned documents
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Network faxing
Though quite comprehensive, Microsoft
Fax lacks features such as network faxing.
You will need powerful software such as
Symantec’s WinFax PRO 10.0.

The setup is straightforward. Once it’s
complete, the first screen asks you to enter
the CSID (called station identification),
your fax number and your phone number.
The second screen asks you to choose
modems and other devices that you want
WinFax PRO to use to send faxes. Next, the
chosen modem is tested to determine
speed and other parameters. Once this is
done, specify whether you want to put
WinFax PRO controller in the Windows
Startup. You can receive faxes via e-mail by
enabling that option in the next screen. All
you need to do is choose the e-mail pro-
gram and enter the password. 

If you wish to skip the registration
step, click on Cancel. Finally, the Live
Update starts to update WinFax PRO—this
can also be skipped by clicking on Can-
cel. That’s it!

Sending a fax
Bring up the WinFax PRO Message Man-
ager—the centre point for all of your fax
related tasks—by going to Start > Programs
> Symantec WinFax PRO > WinFax PRO Mes-
sage Manager. Go to Send > Send New Fax…,
or click Send on the toolbar to bring up
the WinFax PRO dialog box. Here, click
on an address book entry to insert the
name and fax number, or enter them
manually, and then click on Add to List.
Also, schedule the send time for individ-
ual recipients by clicking on Schedule.
Next, to create a cover page, choose
‘(Other…)’ from the drop-down list that’s
located just below the subject field, to
bring up the ‘Select Cover page’ dialog
box. Choose from the many pre-defined
templates here and add the note and the

subject that appears on the fax’s cover
page. Finally, click Send to send the fax.

You can view the status of the fax—
whether it failed or was sent successfully—
by clicking Send Log in the Message Man-
ager. If you want to send a fax as an e-mail,
click Send on the Message Manager win-
dow to bring up the Send dialog box. Here,
click Email on the toolbar. A new dialog
box opens where you specify the address
of the fax recipient, the subject and the
message. Next, click Insert to insert files
and click on Send when you are done. This
fax will be sent the next time you open
your e-mail client. The advantage of send-
ing a fax to e-mail is that your Word files,
etc., can be viewed by anyone, even those
who don’t have Word installed, and sec-
ondly, it goes in an unalterable format.
When you send fax to e-mail, it is sent as a
self-executing file that can be viewed on
any Windows PC.

Receiving a fax  
Check whether automated fax receiving
is enabled by right-clicking the fax icon
in your System Tray to show the con-
troller menu.

If ‘Automatic Receive’ is
enabled, faxes will be
received automatically. If it
is unchecked, you will have
to right-click the System
Tray fax icon, and click
‘Manual Receive Now’ or go
to Receive > Manual Receive
Now in the Message Manag-
er window to receive the fax.
You can customise the fax
receiving settings even fur-
ther by going to Start > Pro-
grams > Symantec WinFax PRO
> Program Setup > Receive and
then selecting Properties.

Use the options in the General tab to
specify the number of rings after which
the call should be answered. Specify the
time when you want calls to be answered
automatically by clicking on Schedule.
Decide the action that has to be taken
after a fax is received, such as playing a
sound or printing it in the ‘After Receive’
tab. In the ‘Junk Fax’ tab, you can speci-
fy what to do with junk faxes—faxes with
a missing or incorrect CSID. 

In fact, there are lots of features that
can be customised in WinFax PRO. For
this, you will have to go to the Program
Setup located in the Start > Programs >
Symantec WinFax PRO group. Here, you will
find options such as backing up and
restoring your faxes and logs.

That’s the way you get your PC to
double up as fax machine. You can also
try setting it up using faxing software
that comes with its  modem driver instal-
lation CD. These software have made fax-
ing very easy and less of a tedious job to
do. So, the next time the boss needs to
send things urgently, all you have to do
is use the PC! 

UPENDRA SINGHAI

upendra_singhai@thinkdigit.com

Message Manager is the control centre for all operation
related to WinFax PRO

Right-click the fax icon to access the most
common functions of WinFax PRO

WinFax PRO can be setup on a network in
an organisation such that PCs send their
fax jobs to one computer that acts as a
fax server. This lets you use a single
modem and a phone line. To set up the
WinFax PRO server, run the setup and
then go to Start > Programs > Symantec
WinFax PRO > Program Setup. Click on Fax
Sharing Host, select Properties and check
‘Use this WinFax PRO station as a Fax
Sharing Host’. You may also specify a
password here, so that only authenticated
users can access the fax server. Click OK,
and then click Close. 

On the client PCs, when you come to
the Modems And Communications
Devices panel in the Configuration Wiz-
ard, click WinFax PRO Fax Sharing and
click Next. Click Yes to configure the Win-
Fax PRO Fax Sharing device. In the Win-
Fax Fax Sharing Client Properties dialog
box, enter the name of the fax sharing
server in the Host Name section. Enter
the password, if it exists. The rest of the
steps are similar to the normal installa-
tion. Now, when a fax is sent from the
client machine, it goes to the server and
is sent automatically.

Setting up a Fax Server
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Any Linux system is functionally
organized at three levels: the ker-
nel, which schedules tasks and

manages storage; the shell, which con-
nects and interprets users’ commands,
calls programs from memory, and exe-
cutes them; and the tools and applications
that offer additional functionality to the
operating system. 

One of the unique features of Linux is
that the kernel source code is available for
download, so users can compile the ker-
nel to suit their requirements.

In this workshop we will compile and
install a new version of the Linux kernel—
we will keep all the other applications the
same, and change just the core of the OS.

Why would anyone in his or her right
mind decide to recompile the Linux ker-
nel? There are several compelling reasons.

Imagine you’ve bought a brand new digi-
tal camera and it’s not readily supported
by your existing kernel. The vendor does-
n’t provide any loadable drivers, but there
is support for the camera in a newer ver-
sion of the kernel. If this happens, you’ll
have to upgrade your kernel.

Another scenario: you use a Linux
desktop, and want to access NTFS parti-
tions on Windows XP. You don’t want to
rely on the experimental stuff that came
with your older kernel. The only alterna-
tive you have is to get hold of a new ker-
nel with better support for NTFS, and
compile it on your system.

In fact, the flexibility provided by the
Linux kernel, in terms of recompilation,
is one of the reasons for Linux being so
widely adaptable to almost every imagi-
nable platform and architecture.

One of the most detailed documenta-
tions available about the Linux kernel is
right there in one of the kernel directories;
you’ll find a goldmine of information in the
/usr/src/linuxkernelversion/Documentation direc-
tory. This directory contains individual text
files for each and every file and module that
is even remotely related to the kernel. While
the majority of the stuff in these text files is
quite techie, there’s enough for the novice
to get a fairly decent idea of what happens
where in the kernel. But there is a small
problem—this documentation is not one of
those cute little html or chm files we are so
used to seeing on Windows.

Installing the new kernel
To begin with, let’s figure out what has
and what hasn’t changed in the Linux
kernel. Earlier, the Linux kernel was a

■ linux worksinsight ■

One of the best things about Linux is that you can chop and change anything and everything you want.
the kernel—the heart of the OS—is no different, and we’ll show you how to go about doing just that

Tweaking the kernel
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monolithic structure. Everything was
compiled into the kernel, and loaded into
memory along with the kernel. Some-
where down the line, the kernel develop-
ers realised it would be better if some of
the not-so-important stuff could be placed
outside the kernel, and only loaded in
memory when required. So along came
modules, stuff that can be loaded by the
user (or automated user level programs),
as and when required. All the modules can
be found in the /lib/modules/kernelversion/
directory.

In this workshop, we will install the
latest Linux kernel (2.6.0-test11) side-by-
side your existing kernel (a stable 2.4.xx
version).

Before installing the new kernel,
you will have to check for the ver-

sion numbers of a few software installed
on your existing system.

First make sure that your gcc compil-
er version is 2.95.3 or higher. You can
check this by using the gcc --version com-
mand.

Next, check the versions of gtk+, glib
and libglade, using a combination of the
rpm and grep commands:

rpm -qa | grep gtk+
rpm -qa | grep glib
rpm -qa | grep libglade
Look for output lines that say some-

thing like: 
gtk+-1.2.10-11
glib-1.2.10-5
libglade-0.16-4, respectively.
Before going on to compile and install

the 2.6.0-test11 kernel, make sure you
have a distribution with a stable and work-
ing 2.4.xx release kernel. Upgrading from
an older 2.2.XX series kernel to the 2.6.0
kernel is nearly impossible; you might as
well install a new distribution rather than
upgrade a few hundred packages.

Once you have checked all the pre-
requisites, you can go ahead and

compile the new kernel. Download the lat-
est 2.6.0-test11 kernel from www.kernel.org.
Uncompress and untar this package into
the /usr/src/ directory. This is the directory
where all kernel source code resides.

Next, cd to /usr/src/linux-2.6.0-test11/
and type in the following com-

mand—make mrproper.
This command is not required during

a first time install, but it is recommended
to run it each time you recompile, since it
removes any intermediate files generated
during previous compilations.

The next step is to configure the new
kernel to enable all the required

options that you want included in the ker-
nel. These configuration parameters are
stored in a .config file in the kernel source
directory, and can be switched on or off
by directly editing the file. However, the
contents of the file are cryptic, and various
front-ends are available to configure the
kernel. The simplest way is to type in ‘make
xconfig’.

This will bring up a dialogue box that
can be used to configure the parameters
required for compiling the kernel.

In the new 2.6 kernels, there are mul-
tiple ways of configuring the kernel. Apart
from the older make config, make menuconfig
and make xconfig commands, there is a
make gconfig command that brings up a
gnome-based interface. Also to be noted
is that now, make xconfig does not use a
simple tk based interface; it is kde-based,
and won’t run unless the latest kde
libraries are installed. The gnome-based
interface also requires the latest gnome
libraries, failing which it will not run.
While this might be a source of irritation
to die-hard Linux fans, it reflects a con-
scious decision on the part of the kernel
developers, who came up with an inter-
face that is easier to use for novice users.

To use make gconfig you will need gtk+
2.0, glib-2.0 and libglade-2.0. If these are not
installed on your system, it would be better

to switch to a newer distribution, as upgrad-
ing these packages will be quite tedious. In
any case, if you still need to upgrade, you
could try the make menuconfig command that
brings up a barebones interface on the con-
sole. If you’ve used a text-based install of
Red Hat, you won’t have any problems
using this configuration utility.

Next, use the make dep command to
build all the required dependencies:

After this comes the main step—the
creation of the new kernel image. For this,
type in make bzImage

This creates a compressed image of the
Linux kernel that is used for system boot-
ing. The compression is done using the
bzip algorithm. In fact, ‘bzImage’ stands
for ‘big compressed image’, and you can
create a different version of the com-
pressed image that is guaranteed to be
smaller than 512 KB. If this step goes well,
you will get a message saying that the
image is ready.

The next step is to use the make mod-
ules command. This command is

responsible for compiling all the modules
that were configured at the start, and are
now in the .config file. After compilation,
the modules have to be installed in the

make menuconfig brings up a barebones
interface that can be used to configure kernel
parameters before compilation

The output of the make bzImage command
gives the location of the compiled image, and
some more detailed information

Patching the kernel is another approach to
keep your kernel up-to-date. In this method,
incremental patches are applied to the ker-
nel, the advantage being that you don't
have to download the complete kernel
source code, just the updated patches. The
downside is that you'll have to apply the
patches regularly. These patches are avail-
able at www.kernel.org. Once downloaded,
enter the top level directory of the kernel
source (for example, linux-2.6.xx) and then

patch it using the following command:
gzip -cd ../patch-2.6.xx.gz | patch -p1
or bzip2 -dc ../patch-2.6.xx.bz2 | patch -p1

Alternatively, you could use the 'patch-
kernel' script found in the scripts/ directory
in any kernel source directory. The patch-
kernel script must be passed a parameter
that shows the location of the kernel source
tree (for example, /usr/src/linux-2.4.0). It
picks up the patch file from the current
working directory.

Patching the Linux Kernel



About ‘make’
All throughout this workshop, and in many
of the previous workshops, we keep bump-
ing into this command called ‘make’, every
time we have to compile and install any
application. What exactly is make, and why
do we keep appending it with words such
as  ‘install’, ‘clean’, etc.? The secret of all this
lies in a single ‘Makefile’ that resides in the
directory in which you are compiling the
software. Typically, this is the main directory
that is created once you untar a ‘xxx.tar.gz’
or ‘xxx.tar.bz2’ file using the tar -zxvf or tar -
jxvf commands. This Makefile has all the
directions that the make utility needs to
compile and install the application. But all
these instructions are not just executed in
one single go. Instead, various groups of
commands, called targets, are clubbed
together in different sections of the Make-
file. The word that is appended to make util-
ity is, in fact, the name of the target group,
and can be found in the Makefile.

Linux kernel development tree:
The kernel typically has two releases out at
a time. One is the ‘Stable’ release—which
is currently the 2.6.X series—and one is the
‘Development’ release, which is currently
2.5.X. Stable kernels are well tested and
have passed through a great deal of quality
assurance testing and bug fixes. Develop-
ment kernels are experimental with a lot of
new, untested code. These are not recom-
mended for production machines. Most
Linux distributions ship the latest stable
kernel. The stable kernel is always an even
number, say 2.2.XX or 2.4.XX. The devel-
opment kernel is always an odd number,
like 2.3.XX, or 2.5.XX.

Cross-compiling:
Linux is an operating system that has been
ported to a multitude of platforms. Today,
Linux runs on almost any architecture cur-
rently available. This has been of immense
help to software developers, since the
source code for their applications can be
compiled on all these platforms with mini-
mal trouble. This is possible because almost
all the development tools have also been
ported to the respective architectures. In
particular, there’s a feature in ‘gcc’ that lets
developers cross-compile source code to

generate executable files that can be run
on a platform other than the one on which
it was compiled. What this means is that a
simple application, let’s say an mp3 player,
that was cross-compiled using gcc on an
Intel x86 pc to run on a PowerPC proces-
sor, can be just copied to the PPC machine
and run as though it were compiled on it.

This cross-compiling is not just restricted
to Linux applications, the Linux kernel can
itself be cross-compiled to run on another
platform. So using the same source code
and the same compiler, you can create a
new kernel image than can run on your
Mac running Yellow Dog Linux.

You don’t necessarily have to compile
the kernel just to install a new version of
the kernel. You could use recompilation to
switch on certain features in your existing
kernel that were not enabled by the ven-
dor—Red Hat, SuSE, etc. For example, if
you just bought a Aironet wireless
adapter, and want to configure it to run
on Linux, chances are you won’t have to
scout the net to get a driver module; it
will be right there in the kernel source
tree. You can configure the driver to be
either built into your kernel, or you can
build it as a kernel module during the
‘make xconfig’ stage.
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/lib/modules/version-number directory, where
‘version-number’ should be replaced by 
the version number of the kernel being 
compiled (2.6.0-test11 in this case). 
This is done using the make modules_install
command.

Check if all the modules were copied

to the destination by typing ls /lib/mod-
ules/version-number

After configuring and recompiling
the kernel, you need to copy it to

the /boot directory along with your
existing, stable kernel, and then let the
boot loader know of the existence of this
new kernel. 

Copy the bzImage file to the /boot
directory using the cp /usr/src/linux-2.6.0-
test11/arc/i386/boot/bzImage /boot/bzImage-
2.6.0-test11 command.

In LILO, you just have to update the
/etc/lilo.conf file and type in lilo at the
command prompt. If you are using
GRUB as the bootloader, you will have
to follow a slightly different approach.
Use the ‘grubby’ command to add the
newly created kernel to the GRUB boot
menu as follows:

grubby --add-kernel=/boot/bzImage-2.6.0-
test11 --title=TestKernel

This command will add a new entry
to the GRUB boot menu file,
/boot/grub/menu.lst. Make sure that the title
parameter is passed to grubby, since this is
the option that will be added to the boot
menu that appears during bootup. Open
the file in a text editor and check if the
entry was added correctly.

That’s it, we’re almost done. Just
reboot your machine, and select the
TestKernel entry in the boot menu 
to boot into your new kernel. If every-
thing went fine, you should not notice
any difference between your previous
GUI and the present one. To verify that
the newer kernel is being used, use the

uname -r command.
But this is just the beginning; once

you start using the new kernel, you will
be faced with a number of problems and
will have to work on these. But the
added advantages you get out of using
one of these bleeding-edge kernels out-
weigh the trouble involved in installing
a new one.

PRAVEEN KURUP
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All the new modules are installed in the
/lib/modules/2.6.0-test11 directory

The ‘grubby’ command will add an entry for
the new kernel in the menu.lst file

Kernel Secrets
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Linux not booting from disk
While re-installing Windows 98 SE on

my PC that also runs Red Hat Linux 9.0, I
received a warning about modifying the
boot sector. Upon restarting, I found the
LiLo boot menu missing. I tried the solution
given in one of your earlier issues to a sim-
ilar problem, but Linux would not boot
from my boot disk. SOS! 
Nikhil

Use the loadlin program to boot into
Linux from DOS mode. loadlin is located
in the dosutils directory on the Red Hat 9
Installation CD. Copy loadlin and vmlin-
uz—the Red Hat 9 image file—located
under the autoboot directory onto your
Windows partition. Restart in DOS mode,
and type loadlin C:\vmlinuz root=/dev/hdXX
at the command prompt. Replace XX in
hdXX with the location of the Linux root
(/) partition, e.g. hda1. This will boot you
into Linux. Modify the /etc/lilo.conf file to
reflect Windows by adding the following
entries to the end of the file:

other=/dev/hda1
optional
label=Windows
Here, change ‘hda1’ to your Windows

drive. Now, type ‘lilo’ at the command
prompt to place the Linux loader in 
the MBR. 

Red Hat not playing MP3s
I am unable to play MP3 files ever since

I installed Red Hat Linux 9. I downloaded

and installed the latest xmms (1.2.8) from
www.xmms.org, but MP3s just won’t play.
The progress bar moves quickly and the
speakers emit nothing! My sound card is
configured properly, since I can play audio
CDs. 

I don’t know how to play VCDs either. I
am unable to find software that plays 
.dat files. 

My PC is a Pentium IV 1.5 GHz that has
128 MB RAM, an 845 motherboard and an
AC97 onboard sound card.
Ashish Mehta

Unfortunately Ashish, Red Hat 9
does not support MP3s anymore since
the codec is no longer free. However,
there are a few workarounds. One is
to use the encoder library from an
older Linux installation. Copy
libmpg123.so located in /usr/lib/xmms/
Input/ from a PC running Red Hat 7.3 or
older, to the same location on your PC.
Else, download the source rpm for an
older version of xmms, preferably
xmms-1.2.7-2.i386, from http://www.
megaloman.com/~hany/RPM/libmpg123.so.h
tml. Next, run the rpm -ivh xmms-1.2.7-
2.src.rpm command. Replace xmms-1.2.7-
2.src.rpm with the name of the down-
loaded file. This installs the source code in
usr/src/redhat/SOURCES/. ‘cd’(change to a
directory) to this directory and unzip the
xmms file with extension .tar.bz2, using
the bunzip2 filename.

This replaces the .tar.bz2 file with a

new .tar file. Uncompress it using tar xvf
filename.tar.

This creates a new directory contain-
ing the xmms source code. ‘cd’ to
this directory that has the name of the
tar file and type ‘./configure’. Next, ‘cd’ to
the sub-directory named ‘Input’, and
type the following commands one after
the other:

make
make install
This compiles the MP3 libraries

and installs them in /usr/lib/xmms/Input.
You should be able to play MP3s
after this. 

Check if the library is installed prop-
erly. Open XMMS, right-click on the main

window, and go to Visualization > Visualiza-
tion plug-ins, or use the shortcut [Ctrl] + [V].
Click on the Audio I/O Plugins tab and
check if MPEG Layer 1/2/3 Player 1.2.7
[libmpeg123.so] is listed and enabled in
Input Plugins. 

As for playing .dat files, use mplayer,
which you can download from
www.mplayerhq.hu.

Here are the remedies for Knoppix headaches, faltering game frames, nasty bootups,
nastier errors and cellular annoyances…

➜

Open XMMS and right-click on the main
window to access Visualization.
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Fatal error with .exe
I developed a software application in

Visual Basic 6.0 with Oracle as a back-end
and Windows 2000 Server. I receive a fatal
error when I try to execute the .exe file of
the application in Windows 98 or 95. How-
ever, it runs fine in Windows XP. Can you
help me find a solution to this?
Silishi M

Check whether the program gener-
ates errors after installing Visual Basic
6.0 on a Windows 98 PC. If it does not,
then you need to install the Visual Basic
Runtime Setup, downloaded from
www.microsoft.com, on the Windows 98
and 95 machines that execute your
program. 

Setup goofups
I have a P4 1.6 GHz, nVidia Riva TNT2,

128 MB RAM and a 40 GB hard disk run-
ning Windows XP Home. DirectX 9.0b is
installed. I had initiated the setup for an
application that automatically downloads

files from the server. However, I cancelled
that and installed it later from an offline
setup pack. Now, whenever Windows starts
up, it prompts me to connect to the Inter-
net. On clicking Cancel, it indicates that the
auto setup failed and a complete setup icon
is placed on my desktop. 

Also, while playing The Hulk, I get
a DirectX error even before the main
menu loads.
Shitanshu

You have described the problem too
vaguely for us to determine the cause of
the Internet connection error message.
Assuming that the auto setup you’re
referring to is the Windows Update Web
site, you could try turning off Auto
Update to resolve it. To do this, go to
Control Panel > System and click on
‘Automatic Updates’, and uncheck the
‘Keep my computer up to date’ box.

Your system does not meet the mini-
mum requirements of The Hulk. You need
a graphics card such as the ones from

GeForce2 that supports hardware trans-
form and lightning, and 256 MB of RAM,
to play the game smoothly.

Deleting games
How do I delete the default games that

come with Windows 2000 Professional?
Vibhor Mangla

Use Notepad to open the Sysoc.inf
file that’s located in c:\winnt\inf\ sysoc.inf.
Remove ‘HIDE’ from the line
‘Games=ocgen.dll,OcEntry,games.inf,HIDE,7’
and ‘AccessUtil=ocgen.dll,OcEntry,accessor.inf,
HIDE,7’, and save the file.

Next, go to Add/Remove Programs > Win-
dows Setup > Accessories and Utilities, de-select
the Games option and click Apply. 

Not smooth with games
I have an AMD Athlon XP 2400+ on an

MSI KM266 chipset-based board with 256
MB DDR RAM and a GeForce2 MX graph-
ics card. My PC does not run smoothly
when playing Quake III Arena. It also takes
a lot more time to load Windows 98 SE
than my older PIII 1.0 GHz with 128 MB
SDRAM and an 810E chipset. Another
problem is that my processor heats up to
over 53 degrees and often crosses 56
degrees when playing games.
Dhananjay Kulkarni

Jerky game frames could be due to
various reasons—application conflicts,
dated drivers, etc. Close all background
applications, especially virus scanners,
while playing games. No other program

Bits or bytes?
I bought a data cable for my Nokia

7250 to connect to the Net, but it turned
out to be a serial cable. I cannot use the
Nokia software since it works either using
infra-red or the DKU 5 USB data cable.
Some third-party software allow for trans-
fer of files, but I cannot access the Internet.
Is there a way to make this serial cable
work? Are there any USB converters that I
can use? Will they work? And lastly, will
the Internet speed be better than dial-up?
It takes me 20 to 30 seconds to
download a ring tone of 7 KB
- 10 KB on my phone.
Ishaan

The cable you pur-
chased is a DKU-3 cable
that provides serial connec-
tivity, while the DKU-5
cable provides USB connec-
tivity. That is the only differ-
ence. Once the mobile is con-
nected to the PC, it appears as
a modem. You can then use
any dialer, including the Windows dial-
up connection, to connect to the
Internet. 

As for the speed of the GPRS, it is 
4.0 KBps. The difference between Kbps
and KBps is that b indicates kilo ‘bits’ per
second, while B indicates kilo ‘bytes’ per

second. A byte is made up of 8 bits and
requires a few error or parity bits. Hence,
a single byte of data uses at least 10 to 12
bits. Thus if the bandwidth is 43 Kbps,
then, in terms of bytes, it is 4 KBps. It
should provide 4 KBps bandwidth, but
as a general observation, speeds of more
than 2 KBps are not available. Hence the
Net speed is far inferior to the dial-up
speed.  The newer GSM phones support
Enhanced Data rates for Global Evolu-
tion (EDGE) that gives you download
rates of 21 KBps. 

Finally, you can use Nokia PC Suite
on your mobile since it does not depend
on the type of connectivity used. 
You may also like to try Oxygen 
manager software (www.oxygensoftware.
com) that has most of the features of
Nokia PC Suite.

ILLUSTRATOR: Mahesh Benkar

When you open the file in Notepad, it will look
as shown. To enable uninstall for a particular
program, just remove the word ‘HIDE’ without
disturbing the rest of the file
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should be running when you 
play Quake III.

Update your graphics drivers to pro-
vide a boost in performance.

Decrease the game resolution in Quake
III by going to Setup > System > Graphics.
Next, just leave the Simple items options
enabled in the Game Options menu and
turn off the rest.

Your OS could be taking a longer time
to load due to the presence of several
Startup items, a large number of fonts,
fragmented files, etc. Uninstall unneces-
sary applications, and run Scandisk and
Disk Defragmenter to speed up disk
access. As for the CPU temperature, 53 to
56 degrees is quite normal for the AMD.
Just make sure you have a good quality
fan to dissipate the heat.

Knoppix headaches 
I have a Compaq PC that has a Pentium

III 733 MHz and 64 MB RAM. I use a Knop-
pix CD to run my system. Booting from that
CD is very slow. Can I install Knoppix on the
hard disk and boot from it instead? If yes,
let me know the steps to do so.
Narender Kumar Kalra

Narender, don’t expect a Knoppix
CD to boot at the speed of lightning 
on a PC with 64 MB RAM! You 
need to have at least 128 MB for a 
speedy bootup. 

Here’s how you install it onto your
hard disk. Boot via the Knoppix CD and
wait till the OS is loaded completely.
Press [Ctrl]+[Alt]+[F1] to reach the console.
Type ‘knx-hdinstall’ and press [Enter].  Fol-
low the installation wizard till it reboots.

If the language is not set properly, go
to Control Center > Personliche Einstellungen
> Land und Sprache. Here, choose ‘locale
and language’ as ‘English’. Click
Andwenden and restart the Control Cen-
ter to get the change effected.

You may also refer to the exten-
sive documentation available at
http://www.freenet.org.nz/misc/knoppix-
install.html and http://librenix.com/?inode=
3250 to install Knoppix.

Too much memory is too less
I have a Pentium IV 1.8 GHz, a 40 GB

hard disk, 128 MB DDRAM and an nVidia
graphics card running Windows 98 and
Windows 2000 Server. I have VB.Net
installed in Windows 2000. I get a mes-
sage that says, “Your Computer Virtual
Memory is too low” when trying to load
VB.Net applications. The partitions on my
disk are as follows C: has 10 GB, D: has 20
GB, on which I installed VB.Net, E: has 5
GB and F: has 5 GB. The minimum paging
file size is shown as 192 MB, and maxi-
mum is shown as 384 MB under D:. The
other fields are kept vacant. Can I use this
option to increase the virtual memory set-
ting? What is the maximum level that I
can set it to? Will it affect the normal
working of the system? Will it load the
VB.Net project files without any problem?
Currently, the system slows down when
doing so. Help!

Another problem is the execution of
the project file in VB.Net. I created a short-
cut for the .exe file on the desktop and
executed the same without any problem
in Windows 2000. However, when I copy
it to Windows 98 and try executing it, I
get a message saying that mscoree.dll is
not found. Where can I get this file and
where do I copy it to? The .Net project
uses an MS Access database that is avail-
able under both OSes.
Venu Gopal S

You can increase the size of
virtual memory page file manually.
The maximum value that it can be
set to is the amount of free space
on the drive. You can even allot
space on more than one drive for
the page file. However, before you
look at increasing the size of the
page file, try to reduce the number
of running applications, and stop
all unnecessary services, including
IIS. Virtual memory page files are
very slow to access. Ideally, you need
to have at least 256 MB of RAM to
use VB.Net. 

Programs written in VB 5.0 or
VB 6.0 need the VB Runtime files
to be present on the computer that
they are running on. Similarly,
applications written in any .Net lan-
guage require the .Net Runtime to be
installed. The Runtime files are about 20
MB, and are present on the VB.Net
installer CDs.

Changing shut down message
I have a Pentium III 600 MHz, a 10.2

GB hard drive, 64 MB RAM and an ATi card
running Windows 98 SE. How do I change
the default shutdown message?
Gurpreet Singh

That’s simple! Open C:\Windows\
logos.sys in MSPaint, modify the message
in the .bmp file and save it. Shut down
the PC to see the new message. As a 
precautionary measure, back up the 
original file. You may also use any 
picture available in the .bmp format as 
a shutdown screen.

To reach Game Options, you need to click on
setup and then Game Options after starting
Quake III

An  incompatible chipset
I have an HCL BusyBee that

comprises a Pentium 4 1.7 GHz,
128 MB SDRAM, Intel 845G/GL
chipset and a 40 GB hard drive.
The sound card did not get con-
figured when I installed Linux
Red Hat 8.0. According to my
system administrator, the
845G/GL chipset does not sup-
port version 8.0. Do I upgrade
to a higher version? Also, can I
use Windows XP along with Red
Hat 9.0 without any hiccups? 
Dipti Ranjan Nayak

You can use Red Hat 9.0 along with
any version of Windows. Sound drivers

for 845G/GL motherboards are includ-
ed in Red Hat 9.0. However, if you
want to use Red Hat 8.0, download the
necessary drivers from www.linux-driv-
ers.org.



An error unknown...
I have a PC that comprises a Pentium

4 1.7 GHz, a VIA motherboard and a 120
GB hard drive running Windows XP SP1. I
installed a GeForce 4 440 MX graphics
card and 256 SD RAM to play Age of
Mythology. However, a message stating
that an unknown error has occurred
appears while playing Age of Mythology,
and the game quits. The error also comes

up while playing Command & Conquer.
Downloading drivers from the Internet did
not help. I even replaced the graphics card
with the GeForce 4 440 MX SE, but the
problem persisted. 
Prasanchandra Lakhani

The reasons for the error can be
many. There could be a problem with
your drivers, or with DirectX. Update all
the hardware drivers, and then update to
DirectX 9.0b. Visit www.viaarena.com to
download the latest 4-in-1 Hyperion
drivers for the VIA motherboard. Also,
update your sound drivers.

Reason number two can be insufficient
power. This can happen if you possess a
high-end video card, but a weak power
supply. A supply of 300W would eliminate
this problem.

Run a check on all the fans installed in
your system to make sure they’re running
at full speed. Play with the system case

open to ensure the best ventilation. Re-
install the games after updating the driv-
ers to replace any files that may have
been corrupted. 

Enter the BIOS by pressing [DEL] or
[F2] at bootup. Here, in the Advanced
Chipset Features menu, set the AGP aper-
ture size to the lowest value, typically 4
MB. Next, reduce the AGP bus speed to
2X. Also, disable the Enable 4X AGP set-
ting. AGP 4X needs more bandwidth and
hence, more resources than AGP 2X. As a
last resort, check for a BIOS update on the
manufacturer’s Web site. 
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sos@jasubhai.com
E-mail us your computing
problems, and we may

answer them here! Since we get more
mails per day than we can handle, it may
take some time for your query to be
answered. Rest assured, we are listening!

Boot failure
I have a Pentium III.  Using the steps

given in the magazine, I burnt the Red
Hat 9 ISO images present on the Linux
DVD, onto three CDs, and changed the
BIOS settings. However, I get a message
indicating boot failure at startup. Is there
any method to make these CDs
bootable? Also, is it necessary that they
be bootable?
Prasann Vyankatesh Nadgauda

The CDs have to be bootable. The
CD-Writer may not have burnt the
images properly. Open Nero and go to

File > Burn Image. Select the ISO file and
press Open. Next, click Write to burn
the image.  

Memory dilemmas
I own a PC with a Pentium 4 1.4 GHz,

an Intel 850 chipset and 128 MB of
RDRAM. I want to upgrade my memory
to 256 MB and make use of a graphics
card. A hardware vendor told me to pur-
chase a single 128 MB memory stick,

while another said that I need
two 64 MB sticks. I have two
free slots on my motherboard
and two 64 MB RAM sticks
already on the board. How do
I go about doing this?
Raj

RDRAM modules
need to be installed
in pairs. This means
that either you install
two 128 MB sticks, or
four 64 MB sticks.
Since you already
have two 64 MB mod-
ules, the cheapest
option would be to
buy and install
another two of the

same capacity. Ask the retailer
to fit the modules onto your 
motherboard. 

Backing up Norton
I have an Intel Celeron 1.10 GHz, 160

MB RAM and a 40 GB hard drive, run-
ning Windows XP. 

I updated the virus definitions for
Norton Anti-Virus, but lost them all when
I formatted the system. How do I 
backup virus definitions and restore
them after formatting and installing 
Windows afresh?
Giri Giri

All virus definitions reside in
C:\Program Files\Common Files\Symantec
Shared\VirusDefs. Copy them onto a CD
or a floppy disk before formatting, and
then copy them back to the same loca-
tion. Alternatively, download the
standalone .exe file from www.syman-

tec.com, and double-click it to update
the virus definitions.

FAQs

Once you start Nero, click on File, then on Burn Image
and finally the image to burn Take a backup of the virus definitons before you

format your hard drive

Modify the logo.sys file to change the
shutdown message
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Click those
cho-chweet moments,
scan that Swiss
landscape, and doll it
up...with aplomb!



2

insight ■
■ tips and tricks

124 JANUARY 2004

Focusing
You might face this problem
if you use an auto-focus cam-
era—the camera captures the
distant background and blurs
the subject. This is because
cameras are usually designed
to have a central focus. The
solution is quite simple. Point
the camera at the subject and
position it in the centre of the
frame.  Keep the shutter but-
ton pressed halfway down to
lock the focus on the subject
and re-position the camera so
the scene is framed to your
liking.  Finally, press the shut-
ter button down completely
to take a snapshot.  

The Rule of Thirds
One of the most popular rules
of photography, it applies to
both traditional, as well as
digital photography. Accord-
ing to this rule, if the frame
of the viewfinder were to be
divided into thirds, both hor-

izontally and vertically, then
the four intersections are the
best places to put your sub-
ject, instead of the centre of
the frame. This yields an

appealing image.
In case of a landscape

shoot that needs an empha-
sis on the sky, get the horizon
on the lower horizontal grid.

Foreground and back-
ground
Zoom in and choose a large
aperture setting for sharper
foregrounds and blurred
backgrounds. This setting is

appropriate for portrait pho-
tos. Zooming out and choos-
ing a small aperture results in
an equal focus on the back-
ground and foreground.

Shooting fireworks 
Snap up those beautiful fire-
works using a digital camera
with a shutter speed longer
than ½ a second. Ideally, opt
for a shutter speed between 2
to 10 seconds to capture all
the sparkle and razzmatazz.
You will also need a tripod to
avoid jerky, haphazard pho-
tos. Eliminate even the slight-
est possibility of vibration by
using a camera that comes
equipped with a remote shut-
ter release. 

Set ISO to the lowest set-
ting to reduce noise—the tiny
dots across such snaps.
Enable long exposure noise
reduction, if the camera
comes with it. 

Preview the shot on the
LCD screen, and accordingly
adjust the aperture so that it’s
just the right size to get bright
sharp photos. Keep spare bat-
teries with you. 

Warm tones
Normally, the default white
balance setting for most digi-
tal cameras is set to ‘Auto’.
Though this is fine in most
cases, sunny landscapes and
portraits taken in bright light
could turn out dull. Hence,
change its setting to ‘Cloudy’
to get warmer reds and yel-
lows that make the picture
look better.

Polarising filter
Polarising filter is used for
outdoor shoots since it

reduces glare and reflection,
and results in more saturated
colours, especially in the case
of sky. Use your sunglasses in
case your camera doesn’t
have support for one. Place
the glasses as close to the
camera as possible, check the
LCD to see that its frame does
not obstruct the view and
shoot. For better results, use
it when the light source and
the subject are at right angles,
i.e., when the sun is exactly
over your head. Further, set
the white balance to ‘Cloudy’
for warmer photos.

Flash modes
Normally, digital cameras
have three flash modes—
Auto Flash, Fill Flash and Red
Eye Reduction.

Auto Flash mode is used
for general photography. In
this mode, the flash deter-
mines whether it needs to be
fired or not, based 
on the amount of 
light present. This mode is
represented on the LCD by 
a lightning icon with a 
capital ‘A’.

In the case of Fill Flash,
the flash is always fired. This
is useful when the subject is
sitting in the shade with
bright sunlight around. If set
to Auto, the flash would not
have fired, resulting in dark
spots around the eyes. In the
Red-Eye Reduction mode, the
flash is fired several times
before the shutter actually
opens. Thus, the eye-pupils
are contracted and the red-
eye effect reduces. Use this
mode when there is very little
light and the photo depends
on the flash.

■ tips and tricks

Use these tips to breeze through a photo shoot
using a digital camera!

DIGITAL PHOTOGRAPHY

Follow the Rule of Thirds to click
appealing photos
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Snapping water 
A camera with a shutter speed
that’s slower than a second or
two can be used to shoot
flowing water and make it
look like a painting.  Set your
camera on a tripod. Adjust
the aperture either to f-8, f-
11, or f-16 for better depth of
field. Now, set the shutter
speed to 2 seconds, and
shoot. Since you are using
long exposures, make sure
that the subject is positioned
in the shade. Use polarising
filters to enhance the effect. 

Master the modes
Digital cameras have many
presets, called modes or
macros that let you click pho-
tos differently. Some of the
common modes are Auto,
Portrait, Landscape, Sports
and Night. Auto mode is the
general picture-taking mode.
When you use this mode, the
exposure, focus, and flash are
set automatically. When this
mode is active, there is usual-
ly a small camera icon on
your LCD to indicate it. Por-
trait mode, usually shown on
the LCD as a face, sharpens
the subject and leaves the
background out of focus.

Landscape mode is indi-
cated by mountains on the
LCD, and is suited for shoot-
ing subjects that are at a dis-
tance. Often, a slower shutter
speed is chosen and hence,
it’s better to use a tripod
while using this mode. The
Sports or Action mode pro-
vides a faster shutter speed
and is use to shoot fast mov-
ing objects. Night mode, as
the name suggests, is used to
shoot in poor light condi-

tions. Since this also means
longer exposures, use of a tri-
pod is recommended.

Taking silhouettes
Silhouettes make for appeal-
ing photographs. To shoot a
silhouette, first position your-
self with the sun somewhere
in front of you. Now, set the
exposure on the brighter part
of the scene. Use the expo-
sure lock button to secure the
exposure. Re-compose the
photo and shoot. If it doesn’t
have an exposure lock but-
ton, set the exposure com-
pensation to -2 or -3.

Slideshows and screen-
savers
To view your pictures as a
slide show in Windows XP,
open the images folder in
Windows Explorer and click

on ‘View as slide show’ under
Picture Tasks in the Common
Tasks area. Alternatively,
right-click any image, select
Open With > Windows Picture
and Fax Viewer’. Once the
image is opened, press [F11]
to start the slide show. You
can also view this slide show

as a screensaver. Right-click
the desktop, select Properties
and choose ‘My Picture
Slideshow’ in the Screen
Saver tab. Click on Settings
to specify the folder and
other settings. 

In case you use Windows
98, or intend to create a
screensaver file, use utilities
such as Irfanview (www.irfan-
view.com). In Irfanview, click
File > Slideshow, specify the
folder and other settings, and
click on ‘Save as .scr’. Save
this file in C:\Windows\System
in Windows 98, or C:\Win-
dows\System32, if you use
Windows XP.

Transferring pictures 
There are two ways to transfer
images from a digital camera
to a computer. One is tether-
ing, wherein the camera is
directly connected to a PC
using the cable provided with
it. This can be slow and cum-
bersome and drains the cam-
era’s batteries, unless it has an
AC adapter.  The other way is
to use a CardReader. Simply
insert the memory card of the
camera into the reader, and
connect the reader to the PC.
Most readers don’t require
separate drivers and support
all major card formats. 

Download pictures auto-
matically 
You can configure your digi-
cam in Windows XP to
download pictures automati-
cally when it’s plugged in.
However, the camera should
either have the Windows
Image Acquisition driver, or
support Picture Transfer Pro-
tocol (PTP). Right-click the

camera icon in My Comput-
er, and choose Properties. Go
to the Events tab, click ‘Save
all pictures to this folder’ and
specify the folder. Now,
whenever you connect your
camera, the pictures will be
automatically downloaded to
that folder.

Care and maintenance
Carry your camera and other
accessories such as memory
cards, batteries, cleaning kit
and tripod in a separate bag.
Keep your camera covered
with a plastic bag to protect
it from moisture. Also, place
some silica gel bags along
with it to absorb moisture. 

Never use paper tissue or
napkins to clean lenses. They
contain scratchy wood prod-
ucts and may damage the
coating on the lense. Use a
camera-cleaning  kit that
incudes special brushes and a
lens-cleaning solution. Keep
the bristles of the len-clean-
ing brush from coming in
contact with your hands as
body oil gets transferred onto
them. After cleaning with a
brush, put a drop of lens-
cleaning solution on a lens-
cleaning tissue, and clean the
lens in circular motions. 

Avoid high temperatures
as these affect the camera.
When in bright sunny light,
keep the camera covered in
a white towel when not in
use. Keep the camera away
from strong magnetic fields,
as it may damage its memo-
ry card. Finally, remove the
batteries and store them in a
dry cool place if you do not
plan to use the camera for a
few weeks.

Use WIndows XP’s ‘My Pictures
Screen Saver’ option to view
your photos as a screensaver
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SCANNING

buy a model which come
with these accessories, as
buying them separately is
expensive.

Calibrating the scanner
Calibrate your scanner every
one or two months for opti-
mum results. Calibration
involves scanning a known
colour and adjusting the
output to match that colour.
In case the scanner doesn’t
support calibration, get a
standard gray (RGB=128,

128, 128) reference colour
card from a photo lab, and
scan the image along with
it. Open it in Photoshop and
press [I] to activate the Eye-
dropper tool. The Info
Palette shows the RGB val-
ues as you move the mouse
pointer over the colour card.
If it matches with the actual
colour (RGB = 128, 128, 128
in this case), your image
colours are perfect. Other-
wise, change the colour bal-
ance and brightness of the

A scan lets you get that lovely little picture
onto your desktop. Using these nifty tricks

while you are at it!

Buying a scanner
Before buying a scanner, you
need to keep your budget in
mind and evaluate the scan-
ner on the following points:
Resolution, measured in
dots per inch (dpi), deter-
mines the sharpness of the
scan. Typical flatbed scan-
ners offer a resolution rang-
ing from 600 to 2400 dpi.
The second factor is Dynam-
ic Range. Scanners that
reproduce white perfectly
have a minimal optical den-
sity or Dmin of 0.0. On the
other hand, scanners that
output a perfect black have a
maximum optical density or
Dmax of 4.0. These two val-
ues constitute the dynamic
range of the scanner. Typical
values for these are 2.5 and
3.5.

Another factor is the Bit
Depth. This is concerned
with the analog to digital
conversion of images, dur-
ing scanning. Typically,
scanners have 48-bit con-
versions, with 16-bit each
for red, blue and green. The
next feature that you should
consider is the speed of
scanning. Though there is
no standard method of
measuring the speed, you
can compare the time taken
to scan the same image at
the same settings by differ-
ent scanners. 

Finally, look for trans-
parency adapters for scan-
ning slides and negatives,
Automated Document Feed-
ers (ADF), etc. If you are
looking for any of these fea-
tures, make sure that you

Use Descreen
filter when

scanning
printed

material

Calculating image size and PPI
Use this table to calculate the scan dpi, depending on the

print resolution and printed size desired: 

Printer Type

Print Resolution 

Scan Resoltion

Printed Size

2 x 3-inch

4 x 6-inch

5 x 7-inch

8 x 10-inch

Standard inkjet

printer

300 to 320 dpi

150 ppi

300 x 450

pixels

600 x 900

pixels

750 x 1,050 

pixels

1,200 x 1,500

pixels

High-quality

inkjet printer

600 to 720 dpi

150 to 240 ppi

400 x 600

pixels

800 x 1,200 

pixels

1,000 x 1,400

pixels

1,600 x 2,000

pixels

Photo-quality

inkjet printer

1,200 to 2,880 dpi 

240 to 360 ppi

600 x 900

pixels

1,200 x 1,800

pixels

1,500 x 2,100 

pixels

2,400 x 3,000 

pixels

Actual Pixel Dimensions (Average)
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image until you get the pre-
cise reference colour. Final-
ly, crop out the scanned
reference colour card.

Scanning magazines
Scans of magazines or news-
papers often result in dotted
image patterns, commonly
referred to as moiré. Min-
imise this effect by scan-
ning the image at 300 dpi
with the scanner software’s
Descreen filter on, and then
re-sizing it to 33 per cent of
its size using photo-editing
software such as Photoshop.
Finally, apply the Unsharp
Mask filter. 

Scanning line-art
Line-art is a clip art, drawing
or pencil sketch, consisting of
two colours. There are three
methods of scanning line-art.
The first is the Black and
White Mode, or 1-bit scan-
ning that just picks up the
black areas. This method
suits line-art that does not
have shades akin to that of
pencil sketches as it keeps the

image size to the
m i n i m u m .
Remember to re-
size and rotate at
the time of scan-
ning, to preserve
the final image
quality.

The other
method is the
grayscale mode,
or 8-bit scanning
that records
shades of grey.
This results in
much larger
files, but it’s suit-

able for line-art with shades.
The third method—
halftone—is a format that
prints black dots in a manner
that simulates shades of grey.

Scanning for fax
Scanning at 200 dpi in Line
Art mode, 100 per cent is
most suitable when the
image has to be faxed. The
easiest method would be to
print the image to the fax
driver directly from your
scanner program. Fax
always uses the Line Art
mode—even if you scan it
in some other
mode, the fax
software con-
verts it into
Line Art.

Scanning
oversized
images
If the image to
be scanned is
larger than
your scanner
glass, but its
longest side is

smaller than the double the
longest side of your scan-
ners glass, you can follow
this method: 

Make a mark after every
eight inches on the longest
side of the image from the
right to the left. Now, rotate
the image by 180 degrees
and mark it in the same
manner, on the opposite
longest side. Here, we
assume that the image has a
landscape orientation, i.e.,
its width is greater than its
height. Now, align the
upper-right corner of the
image with that of the scan-
ner glass. Choose the set-
tings at which you want to
scan the whole image and
start the scan. Save this file
as Image1.tif. Move the
image to the next mark and
scan without altering the
settings. Save this file as
image2.tif. Repeat the
process till you have
scanned the entire image.
To scan the lower half of the
image, turn the painting by
180O and repeat the above
process. This time use a dif-
ferent naming convention

like lower1.tif, lower2.tif.
This is necessary because we
will have to flip these lower
images before creating the
final image.

Open all the images in
Photoshop. Create layers for
each image by clicking Layer
> New > Layer from Background.
Rotate the canvas by click-
ing Image > Rotate Canvas >
180O for all the lower-half
images. Create a new blank
image, large enough to
accommodate all these
images. Put all the layers on
this image and align them
appropriately to get the final
picture. You can also use
Photoshop CS’s (Creative
Suite) Photomerge feature to
automate the last step.

Saving scanned images
Save images scanned to be
used on the Web or be sent
as e-mail attachments in the
.JPEG format. . GIF is a better
option for images such as
line arts that have less than
256 colours since it results in
smaller file sizes. 

If you plan to edit the
images later, save them in
an uncompressed format.
You may also save them in
the TIF format as it allows
compressing without caus-
ing loss of image quality. If
you are scanning images for
archival, it’s always recom-
mended that you save one
copy in your image editor’s
native format. For example,
if you use Photoshop, save
a copy in the PSD format.
You might want to save the
second copy in high quality
JPEG format.

Scan images larger than the scanning area by
dividing it into sections

Use the Lineart mode in the scanner software
to scan line-arts

Image 1 Image 2
O
V
E
R
L
A
P
P
E
D
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PROCESSING 

Reducing red-eye effect
Eye pupils dilate in the dark,
thus reflecting the flash light
in the eye’s blood vessels.
This gives the person a ‘red
eye’. Hence, avoid photo-
graphing in the dark. If it’s
absolutely necessary, use a
camera with red-eye reduc-
tion feature.

Tell the subject do not
look directly into the lens. If
possible, use a removable
flash that is placed at some
distance from the camera.
You may also use photo man-
agement software such as
Photoshop album, Picasa,
ULead Photo Explorer, JASC
to remove red eye.

Cropping
Cropping is used to edit
unwanted portions of a pho-
tograph. Maintain the aspect
ratio for prints when crop-
ping using software. For
example, if you need a 5 x 7
print, you will need to crop

the image precisely to that
size. Open Photoshop and
press [Ctrl] + [R] to enable
rulers. Right-click on the
ruler, and select Inches to
change the ruler unit. Now,
drag the horizontal guideline
to 5 inches, and position the
vertical guideline at 7 inch-
es. Press [C] to switch to the
Crop tool, and drag a rectan-
gle of 5 by 7 inches. Move it
to a suitable position, and
double-click to crop; trying
unusual shapes may be a
good idea. For example,
heart for a couple’s photo.
Cropping comes handy
while correcting horizon
lines or straightening your
photos.  

Automated features
Improve the quality of your
photographs by using the
automated functions in Pho-
toshop. Go to Image > Adjust-
ments > Auto Levels and then
apply Auto Contrast and

Auto Color. Finally, sharpen
them via Filter > Sharpen >
Sharpen.

Sharpening 
You can sharpen any image
using Photoshop’s Unsharp
Mask filter (Filter > Sharpen >
‘Unsharp Mask…’). This com-
pensates for the blurring
caused by the low-pass filter

that is found in almost all
digital cameras to improve
image quality. Apply it before
the image is re-sized, or
resampled, but after other
corrections have been done.
Its ideal settings would be a
radius value of 0.3 to 0.5,
threshold value of 0 to 2 and
amount between 200 to 500
per cent.

For compensating the
blurring done by output
process, it should be sharp-
ened after resize/ resample.
Generally, finer the print,
the lower will be the radius.
For example, you will need
a radius of 1.0 to 1.5 for
photos that are printed on
premium inkjet photo
paper.

Wipe off dust and
scratches 
Make use of dust and 
scratch removal software to
get clean scans. One such
plug-in is Kodak’s Digital
ICE (www.asf.com). Apply the
noise filter to the photo in
Photoshop by going to Filter
> Noise > ‘Dust and Scratch-
es…’. Next, despeckle the
image by going to Filter >
Noise >Despeckle. 

You may also use the
Clone Stamp Tool to clone a
cleaner area to the dusty one.
To use this Photoshop tool,
press [C] and click on an area
that resembles your target
area, while holding down
[Alt]. After defining the
source, release [Alt] and paint
in the normal way. Do
remember to zoom in and
keep the brush size smaller
for better results. 

Creating panoramas
The latest version of Photo-
shop CS comes with Pho-
tomerge—a feature that
allows you to create panora-
mas in just a few clicks. The
best part is that you don’t
even need to fix your camera
on a tripod while taking
images, as Photoshop adjusts
the level automatically. Open
Photoshop CS and click on
File > Automate > Photomerge.
Click on Use Files and use
the browse button to locate
all the images that want to
use for creating the panora-
ma. Make sure that the
‘Attempt to Automatically
Arrange Source Images’
check box is checked, and
click OK. A dialog box with

Snapped and scanned, but satisfied you are
not? Here’s how you add that touch of class to

them!

Use Photoshop’s Unsharp Mask
filter to sharpen your images
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your images identified and
adjusted comes up. Click OK
to accept and use the Crop
tool to crop out unnecessary
portions. 

Visit www.panoguide.com—
a Web site dedicated to cre-
ating panoramas, for more
tips and software. 

Distortion correction
Distortion in photographs
could be Barrel distortion—a
lens effect that leaves photos
with a spherical distortion at
the centre, or it could be Pin-
cushion distortion, which

results in images that are
pinched in the centre. 

An easy solution to cor-
rect this would be to use the
Panorama Tools plug-in for
Photoshop that can be
downloaded from http://
home.no.net/dmaurer/~dersch/In
dex.htm. Open the ZIP 

file, and
extract the
pano12.dll
file in the
folder where
Photoshop
is installed.
Now, extract
all the files
inside the
‘Photoshop
Plugin’ in
the ZIP file
to the Pho-

toshop Plug-Ins or Filters
directory. Restart Photoshop
and open the photo in need
of correction. First, go to Fil-
ter > Panorama Tools > Correct
to bring up the ‘Correct
Options’ dialog box. Select
Radial Shift, and click on
the option next to it to
bring up the ‘Set Polynomi-
al Coefficients for Radial
Correction’ dialog box. Set
‘a’ and ‘c’ to zero for all
colours, and choose a value
for ‘b’ and ‘d’ such that their
values add up to one. The
values for ‘b’ should be neg-

ative to correct barrel dis-
tortion, and positive to
rectify pincushion distor-
tions. Start with 0.015 for ‘b’
and 0.085 for ‘d’ to correct
pincushion, and -0.015 and
+1.015 for barrel distortion.
Increase or decrease the val-
ues gradually until the

images are corrected proper-
ly. Refer to the Readme.html
file inside the ZIP file for
further details. 

Warning!
There are two ways to rotate
images in Windows XP. You
can right-click on the
thumbnail view in Windows
Explorer and choose Rotate
Clockwise’ or ‘Rotate
Counter Clockwise’, or use
the rotate image button in
Windows Picture and Fax
Viewer. However, every time
an image is rotated, it’s
saved, which results in some
loss of quality. Thus, make it
a point to use specialised
photo-editing software that
save only the final image. If
you use Photoshop, it would
be best to keep saving the
image that is being worked
upon in the PSD format.
Save it in the JPEG format
only when you’re done with
all the editing. The use of the
rotate image function in
Windows XP should be the
last step of your editing
process.

Image resolution
Perhaps the most important

thing to keep in mind while
printing images is the reso-
lution. Ideally, a 4 x 6 inches
photo should be have a reso-
lution of at least 800 x 600.
For 5 x 7 prints, it should be
1024 x 768 and for 8 x 10
prints, it should be 1600 x
1200 pixels. Furthermore,
you need to have a dpi of
300 for sharper, clearer
prints. Use Photoshop to
change all these parameters.
Access them by going to
Image > Image Size.

Tinting black and white
photos
Using photo-editing applica-
tions, you can add colour to
black and white photos.
Open the image in Photo-
shop. Go to Image > Mode,
and ensure that the colour
mode is RGB or CMYK. Now,
press and hold down [Shift]
and use the Lasso tool to
select a certain area, say, the
skin of the photographed
person. That done, go to
Image > Adjustments > Varia-
tions and adjust the levels to
obtain the desired colour.
Now, select other elements
in the photograph and
adjust the colour variations

in the same
manner. Use the
Path tool for bet-
ter control over
selections.

Finally, create
a new layer with
‘soft light’ blend-
ing mode and 85
per cent opacity.
Now, use the
dodge and burn
tool to lighten
and darken theAdjust image resolution before printing

No
Distortion

Barrel
Distortion

Pincushion
Distortion

Create an impressive panorama in minutes using
Photomerge in Photoshop CS!
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specific areas to finalise the
image.

Print easy
The easiest way to print your
images is to use the Photo
Printing Wizard in Windows
XP. Open the image folder in
Windows Explorer, select the
images you need to print
while holding down [Ctrl]
and then click ‘Print the
selected pictures’ under Pic-

ture Tasks. Follow the
instructions to print your
images in Full Page, Contact
Sheet, 8 x 10, 5 x 7, 4 x 6, 3.5
x 5 or Wallet prints.

File naming 
By default, images down-
loaded from a digital camera
are named as DSCN0001,
DSCN0002, …  Use the batch
function in Windows XP to
rename them. Open the
image folder in Windows
Explorer, hold down [Ctrl],
select all the desired images
and press [F2]. Name them
appropriately and press
[Enter]. If you entered ‘birth-
day’, the last selected file will
be renamed ‘birthday’ and
the preceding files will be
renamed ‘birthday (1)’,
‘birthday (2)’, etc. 

Photos on the Web
Windows XP’s Web Publish-
ing Wizard stores photo-
graphs online, as private or
public albums. Open the
folder that contains your
photographs, hold down
[Ctrl] and select the pictures
you want to share. Next,

click ‘Publish
the selected
items to the
Web’ under ‘File
and Folder
Tasks’ to start
the Wizard.
After you have
confirmed the
photos you
want uploaded,
specify its loca-
tion to the Ser-
vice Providers
in the next
screen. Here,

we choose MSN Groups—the
standard option. The wizard
then gives you the option of
keeping your files public or
private. Accordingly, you are
asked the name of the group

and a few other details as
part of the registration
process. It then displays the
Web address of your group.
Finally, the Wizard uploads
the photos.    

E-mailing 
To e-mail photographs,
right-click the image in Win-
dows Explorer and choose
Send To > Mail Recipient. A dia-
log box in Windows XP pro-
vides you with three options
to re-size the image prior to
e-mailing it: 640 x 480 strict-
ly for computer viewing, 800
x 600 for 4 x 6 prints and
1024 x 768 for 5 x 7 prints.
Of course, you can always
send it as it is!

Histogram
Exposure is one important
factor that differentiates
good photos from shoddy
ones. A good photo has all its
elements illuminated prop-
erly. Use the histogram to
correct exposure. Though
many cameras show a his-
togram on their LCDs after
you take a picture, it’s better
to view the histogram in a
photo-editing tool and make
corrections there. Access the

histogram in Photo-
shop by going to
Image > Adjustments >
Levels. 

The right side
of the histogram
shows the lightest
portion or ‘high-
lights’ of the
images, the middle
section shows the
mid-tones and the
left most side shows
the darker portions

or ‘shadows’. The vertical
axis shows the pixels in each

level. An underexposed
image has many pixels con-
centrated in the shadows.
Move the sliders to improve
the distribution of brightness
levels. Alternatively, use the
Auto button to let Photo-
shop make the adjustments.
Further, you can also adjust
histogram of channels, i.e
red, blue and green, if their
distribution appears improp-
er. For example, adjust the
histogram for the blue chan-
nel if the sky looks dull in
your photograph 

Print your images easily with Windows XP’s
Photo Printing Wizard

Use Windows XP’s Web Publishing Wizard to
share your photos easily

Use Histogram to correct the
exposure in your photographs

Use Adjust Variations dialog to
colorize Black and White
Photos.
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Halo is often described as ‘the game
that sold the Xbox’. It is the name of
a ring-world that orbits an alien

planet. A ring-world is a huge planet-like
body that is shaped like a ring, and spins
like a giant Ferris-wheel. This makes Halo a
flat planet, and you can fall off the edge into
outer space. 

The fledgling human interstellar empire
is locked in battle with the Covenant—a
group of alien races determined to wipe out
human civilisation. You are one of a group
of survivors from a devastated colony that
is trying to lead the alien armada away from
Earth. Your ship is attacked by Covenant

forces and there’s only one place you can
run, to Halo of course. Once there, you are
sent off instead on mission after dangerous
mission to discover the secrets of Halo.

Be prepared for a tough fight—the AI is
superlative, making the game much
tougher; the scenery is superb; the game
saving features are good; the load times are
the fastest and smoothest ever.

The game isn’t well ported for the PC
though—the graphics start to stutter at
anything above 1024 x 768; the lack of sub-
titles makes the story a little difficult to fol-
low; the poor level designs are its biggest
flaw, but all this doesn’t take away from the
fact that you’re still having the best PC
gaming experience of your life. Be pre-
pared, if Halo 2 makes it to PC—it could
well be the perfect FPS.

Halo
Rings of action!

Genre: Racing ■■  Developer: Rockstar Games  ■■     Publisher: Take Two Interactive ■■     System Requirements: 800 MHz CPU, 128 MB RAM,
GeForce2/Radeon 8500, 1.4 GB hard disk space, DirectX 9.0 ■■     Price: NA ■■  Web site: www.midnightclub2.com 
Rating: ★★★★

Another Banshee comes screaming down

✩✩

Microsoft recently presented the net-
working community with its latest

network operating system—Windows
Server 2003, and as expected, updated the
Microsoft Certified Systems Engineer
(MCSE) certification to reflect the compa-
ny’s latest technologies. MCSE and its
younger cousin, Microsoft Certified Sys-
tem Administrator (MCSA), are certifica-
tions that helps network professionals
adjudge their competence in Microsoft’s
networking technologies. Soon to follow
up, Syngress Publishing has come out
with a book meant to be a study guide for
people aiming for the Exam 70-290—
Managing and Maintaining a Windows
Server 2003 Environment. 

It has 900-odd pages and comes with

a free DVD. The 10 chapters
meticulously cover all the
exam’s objectives—from
managing user groups and
disk quotas, to remote server
management and disaster
management. With a walk-
through of previous Mic-
rosoft operating systems and
their key points, the author
then sketches the lines that
make Windows Server 2003
different from previous servers
such as Windows 2000 Serv-
er and NT. Each chapter ends with a well
thought summary, a checklist of exam
objectives, some practical frequently
asked questions and a self-test quiz.

Though the book itself
leaves no stone unturned in
providing a comprehensive,
informative and easy-to-grasp
learning experience to the read-
er, the included DVD falls short
of expectations. The DVD is
essentially a video of an instruc-
tor flipping through the various
chapters and briefing them with

the aid of a PowerPoint presentation. It
could have been put to better use, per-
haps with quizzes, flash cards, adaptive
simulations and the self-test quizzes from
the book itself. 

All in all, the book is self-sufficient as
a study or preparation guide; though don’t
buy the book for the sake of the DVD.

Exam 70-290: Managing and Maintaining a 
Windows Server 2003 Environment
It’s all you need

Publisher: Syngress Publishing ■■  Author: Dr. Thomas W. Shinder ■■  Distributor: Shroff Publishers and Distributors Pvt Ltd ■■  Phone: 91-22-27634290
■■  Fax: 91-0 22-27634290 ■■  E-mail: spd@vsnl.com ■■  Web Site: www.syngress.com ■■  Price: Rs 750
Rating: ★★★★ ✩✩
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An issue to remember
Badri Narayan, whose expertise in

and passion for computer gaming
is matched only by Tiger Woods

for golf, is a thin man. So is Bhavesh our
marketing manager, who matches Badri
lost-kilo for lost-kilo. At the peak of
their form, both could have been idols
for the Rs 25,000-per-fashion-show
ramp models. And yet, these two can
gobble up food at a pace that would
make a 400-pound Sumo wrestler drop
his jaw. We would not have known this
aspect of their personality if not for
Reader Forums, a Digit exercise that,
apart from understanding the culinary
habits of our colleagues, also let us
understand what our readers across the
nation expect of us.

A Reader
Forum usually has us visiting var-

ious parts of the country where the Digit
marketing and editorial teams meet up
with 10 to 12 readers from each city.
Over the last few months, we met read-
ers from Ahmedabad and Bangalore,
apart from Mumbai.

Bhavesh, our marketing manager, is
a self-professed (stress on “self”) gour-
met, and claims to have unrivalled
knowledge about eating joints in vari-
ous cities. So in Ahmedabad, for break-
fast, he ordered a kilo of phaphda (a local
fried papad-like preparation) and jalebi
for four persons. Between the four of us,
a kilo of phaphda would have lasted
days, even if we ate non-stop. We did
not undertake this misadventure, and
settled for omelettes and bread instead.
Not discouraged by this, Bhavesh took

us to a place he claims serves the best
Gujarati thalis. Like every marketing
person making a client pitch, he is not
the one to give up.

If we thought Ahmedabad was an
adventure, our trip to Bangalore seemed
a trek of Himalayan proportions, where
he promised us a kabab and grilled
chicken treat. His sense of taste is
impeccable, but he is not exactly
equipped with a global positioning sys-
tem. Eight persons in three rickshaws,
and only the one that had Bhavesh as
navigator ended up at the wrong place!
A good kilometre away from the actual

destination!
Nevertheless,

this delay brought
to the fore the
gobbling skills of
Badri, who had
just about an
hour to go back
to the guest
house, pack his
stuff and catch
a late night
flight. Sweet
and noble-

intentioned as
he is, we have
vowed not to
c o n s u l t
Bhavesh in our
future endeav-
ours.

December
Mega Issue
A few years
ago, an ageing
Harrison Ford
and the now-I-
am-lesbian-now-I-am-bisexual-oops-
now-I-am-straight Anne Heche starred
in a B-grade adventure flick called Six
Days Seven Nights. We really don’t know
if our 200-odd temperory hands had
seen the movie (our guess is, they
haven’t), but these guys spent the same
amount as Ford and Heche, in an equal-

ly adventurous pursuit—packing the
mega December 2003 Digit issue.

Until now, we were proud of the
70,000 sq ft building that is Jasubhai
Digital Media, but the combined might
and space of the magazine, the six CDs
(these guys didn’t break even one!) and
the huge cardboard box, humbled us.
Every nook and cranny—the lobby, the
car park, the corridors, the gym—was
populated with temps who were metic-
ulously getting packages into place so to
send them all to you. Copies, all of
1,20,000 of them, were oozing out like
army ants in the South American rain
forests. And just in case we forgot the
traffic jam when we returned to our
desks, Kaizad, who some time ago
betrayed the Digit editorial team to join
the client marketing team, passed
around a wallpaper bearing the Decem-
ber issue ad.

We had Digit copies coming out of
our ears! 

Of course, Bollywood hottie Rani
Mukherjee’s smiling face staring at us from
cover helped us a bit. Only a bit, though.

But when the packs were despatched
and readers flocked to news-stands like

kids to a water fight, the entire Digit
team—editorial, test centre, marketing,
printing, logistics—went home to sleep a
deep sleep. The pain was forgotten, the
aching body parts ignored. With the new
year peeking around the corner, it was
time for smiles and much merry
making

The Digit magazine, CDs and VCD were packed with the efficiency
and precision of an assembly line

All good things come in big packages...
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a. The World 

b. AOL 

c. Compuserve 

d. MSN

Which company pioneered
Bluetooth?
a. Nokia 
b. Motorola 
c. Ericsson 
d. Intel  

Which organisation
was formed in response
to the first Internet
worm?
a. CERT 
b. IEEE 
c. ISO 
d. IETF

IRC was the first ever real-
time chat protocol. Whose
brain-child was it?
a. Jarkko Oikarinen 
b. Paul Allen 
c. Robert Kahn 
d. Steve Wozniak

Which company has the
dubious distinction of sending

the first spam e-mails?
a. Canter & Siegel, a lawfirm 
b. GE 
c. Red Hat 
d. Napster

In 1928, a Detroit police offi-
cer and an engineering student
unveiled a communication
device that is being used even
now. What are we talking about?
a. Telephone 
b. Facsimile 
c. One-way Radio 
d. None of the above

We bow to thee if you know
his personal e-mail address. But
do you know the President of
India’s official e-mail address? 
a. president@india.com
b. thepresident@india.com
c. president@nic.in
d. presidentofindia@rb.nic.in

This librarian coind the
phrase ‘Surfing the Internet’.
She is also called Net-Mom.
Who?
a. Hillary Clinton 
b. Rachel Jones 
c. Jean Armour Polly 

d. Lady Lovelace

What is the
name of the next
generation network
created by the
Internet2 consor-
tium?
a. Nextnet
b. Intranet

c. I2 network
d. Abilene network

Each network card has 
a unique MAC address. 
What is the length of this
address? 
a. 64 bits
b. 128 bits 
c. 48 bits 
d. 3 bytes

How many root DNS
servers are present on the
planet?
a. 100 
b. 405 
c. 13 
d. 456

Which was the first Web
server to go online?
a. nxoc01.cern.ch
b. internet.com
c. symbolics.com
d. altavista.com

Between which two 
countries was the first 
submarine cable laid in 1850? 
a. India and Singapore 
b. USA and England 
c. England and France 
d. Australia and New Zealand

Which was the first domain
name to be registered?

a. microsoft.com 
b. mit.edu 
c. ietf.com 
d. symbolics.com15
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Across
2. The first Web browser/

editor used by Tim Bern-
ers-Lee 

4. Establisher of India’s first
private Internet gateway 

7. January 1, 2003 is the
20th anniversary of...

9. The next version of IP
10. First Web server in Space 
11. IE originally used 

technology licensed
from...

Down
1. The launch of Sputnik

resulted in 
3. If French call it courriel, we

call it
5. The first Ethernet network

6. Catalyst Routers
8. Vinton Cerf and Robert Kahn

■ qubit

Who was the world’s first commercial 
provider of dial-up Internet access?
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A ‘Kasparov Vs The World’ chess
match was played on MSN.com
in 1999. The move that got the
highest vote by users was pre-
sented in the game. Four
experts offered their sugges-
tions for the world. Virtually the
entire world followed the sug-
gestions of Irina Krush, a 15-
year-old girl from the US.
Kasparov won the match.

Who sent ‘qwer-
tyuiop’ as the first 
e-mail in 1971? 

3

a. Tim Berners-Lee 
b. Ray Tomlinson 
c. Meltcalf 
d. Bill Gates

did you know

Got an interesting question? Send
it in with the correct answer to
quiz@thinkdigit.com

numberette

Powered by

The Earth Simulator employs

5,120 CPUs and 

10 TB of RAM, and has an

output of 40 Tera FLOPS.

1 to 5 Way to go...

6 to 10 Good, if you like
being mediocre 

11 to 15 Your next job could
be with us!

QUOTIENT

Quiz
1 a, 2 c, 3 b,
4 a, 5 a, 6 a,
7 c, 8 d, 9 c,
10 d, 11 c,
12 c, 13 a, 14
c, 15 d.

Crossword
Across: Down:
2. World Wide Web1. ARPA
4. Mantra

3. E-mail
7. Internet5.

AltoAloha
9. IPv66. Cisco

Answers
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